
QALoad 5.5 Help 

Getting Started, Running a Load Test, Analyzing Test Results, and 
Using the Conductor 
 

 





 

iii 

 
Technical support is available from our Customer Support Hot l ine or via our FrontLine Support Web site. 

Customer Support Hot l ine: 
1-800-538-7822 

FrontLine Support Web Site: 
 ht tp:/ / front l ine.compuware.com 

This document and the product referenced in it  are subject to the fol lowing legends: 

Access is l imited to authorized users. Use of this product is subject to the terms and condit ions of the user’s License 
Agreement with Compuware Corporat ion. 

© 1998-2006 Compuware Corporat ion. All rights reserved. Unpublished - rights reserved under the Copyright Laws of 
the United States.  

U.S. GOVERNMENT RIGHTS 

Use, duplicat ion, or disclosure by the U.S. Government is subject to restrict ions as set forth in Compuware Corporat ion 
l icense agreement and as provided in DFARS 227.7202-1(a) and 227.7202-3(a) (1995), DFARS 252.227-
7013(c)(1)(i i )(OCT 1988), FAR 12.212(a) (1995), FAR 52.227-19, or FAR 52.227-14 (ALT III), as applicable. Compuware 
Corporat ion. 

This product contains confident ial information and trade secrets of Compuware Corporat ion. Use, disclosure, or 
reproduct ion is prohibited without the prior express writ ten permission of Compuware Corporat ion. 

Compuware, Act iveAnalysis, Act iveData, Interval, QACenter, QADirector, QALoad, QARun, Reconcile, TestPartner, 
TrackRecord, and WebCheck  are trademarks or registered trademarks of Compuware Corporat ion. 

Acrobat® Reader copyright © 1987-2006 Adobe Systems Incorporated. All rights reserved. Adobe, Acrobat, and Acrobat 
Reader are trademarks of Adobe Systems Incorporated. 

ICU License - ICU 1.8.1 and later COPYRIGHT AND PERMISSION NOTICE Copyright (c) 1995-2003 Internat ional 
Business Machines Corporat ion and others All rights reserved. Permission is hereby granted, free of charge, to any 
person obtaining a copy of this software and associated documentat ion fi les (the "Software"), to deal in the Software 
without restrict ion, including without l imitat ion the rights to use, copy, modify, merge, publish, distribute, and/or sell 
copies of the Software, and to permit  persons to whom the Software is furnished to do so, provided that the above 
copyright not ice(s) and this permission not ice appear in al l  copies of the Software and that both the above copyright 
not ice(s) and this permission not ice appear in support ing documentat ion. THE SOFTWARE IS PROVIDED "AS IS", 
WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY 
RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR 
ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER 
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR 
OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORM ANCE OF THIS 
SOFTWARE. Except as contained in this not ice, the name of a copyright holder shall not be used in advert ising or 
otherwise to promote the sale, use or other dealings in this Software without prior written authorizat ion of the 
copyright holder. 

All t rademarks and registered trademarks mentioned herein are the property of their respect ive owners.  

All other company or product names are trademarks of their respect ive owners. 

US Patent Nos.: Not Applicable. 

 



QALoad 5.5 Help  

iv 

Table Of  Con ten ts 
QALoad Online Help ........................................................................................................................................ 1 

Welcome to QALoad ..................................................................................................................................... 2 

Gett ing started ............................................................................................................................................... 3 

The load test ing process............................................................................................................................. 3 

Developing scripts...................................................................................................................................... 4 

Validat ing scripts ....................................................................................................................................... 4 

Sett ing up the Conductor .......................................................................................................................... 4 

Start ing the Conductor .............................................................................................................................. 5 

Running a Load Test ...................................................................................................................................... 6 

Running a load test .................................................................................................................................... 6 

Preparing for a load test ............................................................................................................................. 6 

Start ing a load test ..................................................................................................................................... 6 

Monitoring a load test ............................................................................................................................... 6 

Running a batch test .................................................................................................................................. 7 

Stopping a load test .................................................................................................................................... 7 

Analyzing Test Results................................................................................................................................... 8 

Analyzing test results................................................................................................................................. 8 

Graphing data ............................................................................................................................................ 8 

In tegrat ing ServerVantage Agent Data .................................................................................................... 10 

Conductor.................................................................................................................................................... 11 

About the Conductor ............................................................................................................................... 11 

Sett ing Up a Test ...................................................................................................................................... 20 

Running a Test ......................................................................................................................................... 29 

Running a Series of Tests (Batch) ............................................................................................................. 33 

Monitoring a Running Test ..................................................................................................................... 33 

Recording and Playing a Test ................................................................................................................... 36 

Expert User ............................................................................................................................................... 37 

Analyzing Load Test Data ........................................................................................................................ 38 

In tegrat ion and Server M onitoring.......................................................................................................... 39 

Troubleshoot ing..................................................................................................................................... 279 

Index ............................................................................................................................................................. 283 



 

1 

QALoad  On l i n e Help  



QALoad 5.5  

2 

Welcom e t o QALoad   
With QALoad, you can simulate the load generated by thousands of users without the expense of actual 
end users or their equipment. QALoad enables you to quickly develop test scripts, control the condit ions 
for the test, create the virtual users that simulate the load, in i t iate and monitor the test, and report  the 
results. 

The fol lowing components of QALoad control di fferent aspects of the load test ing process: 

Script  Development Workbench 
Develop your scripts. Capture sessions and convert  the transact ions in to C, C++, or Java-based script . 

Conductor 
Control session act ivi ty. In i t iate and monitor the test. 

Player 
Simulate user act ivi ty based on commands given from the Conductor. 

Analyze 
View summary report  data and create other stat ist ical reports from the test. 

Before you begin using QALoad, review the Gett ing started sect ion of the onl ine help to famil iarize yourself 
with load test ing concepts. 
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Get t ing  st ar t ed  

The load test ing process 
You begin the test ing process by determin ing the types of appl icat ion transact ions you want to emulate. 
You then develop these transact ions in to QALoad scripts by creat ing the same types of requests that your 
appl icat ions invoke on the server. Each transact ion becomes i ts own script . The QALoad Script 
Development Workbench lets you easi ly create ful l-funct ion scripts. 

When you plan your test, you need to decide which  transact ions to run, the number of simulated cl ients 
that wi l l  run each transact ion script , and the frequency at which each script  wi l l  run. When you run the 
test on a workstat ion with the QALoad Player component, you can specify transact ion rates as well  as fixed 
and random delays to better emulate real-system act ivi ty. QALoad considers these factors a test scenario 
and stores them in a session ID fi le. 

While a test is running, the test operator can dynamical ly view overal l  run t imes as well  as individual 
t ransact ion performance. QALoad's Conductor component col lects th is data for analysis at the conclusion 
of the test. 

After execut ing the test, summary reports show the response t imes that the emulated cl ients experienced 
during the test. Individual and global checkpoints let  you view and ident i fy specific areas of system 
performance. You can export  al l  test output data to spreadsheet and stat ist ical  packages for further analysis 
or use QALoad's Analyze component to create presentat ion-qual i ty reports and graphs. 

As shown in the fol lowing image, a typical load test setup consists of a QALoad Conductor, one or more 
QALoad Players, and the system under test.  

QALoad Conductor 

QALoad's Conductor controls al l  test ing act ivi ty such as sett ing up the session descript ion fi les, in i t iat ing 
and monitoring the test, and report ing and analyzing test results. 

QALoad Player 

A QALoad Player creates virtual users that simulate mult iple cl ients sending middleware cal ls to a server 
under test. In  a typical test setup, one or more QALoad Player workstat ions run under any Windows 32-bit  
platform (Windows XP or 2000) or UNIX. For large tests (thousands of simulated cl ients), you can connect 
mult iple Players to QALoad's Conductor. The Conductor and Players communicate using TCP/IP. 

The hardware and software capabi l i t ies of the Player machine are the only factors that l im it  the capacity of 
an individual QALoad Player. The maximum number of virtual users per Player machine is dependent on 
the system under test, the characterist ics of the script , and the test scenario. You can specify how many 
threaded- and process-based virtual users to assign on a machine on the M ach ines tab of the Opt ions 
dialog box in  the Conductor. The Conductor calculates how many virtual users wi l l  be act ive per 64 MB of 
RAM, based on the values you provide in  these fields.  

System under test  

The servers you test are typical ly product ion systems or a dupl icate of a product ion system that is set up at 
a test faci l i ty. If you perform any kind of system select ion or performance stress test, the system under test 
must use the same hardware and software (including current versions) as the product ion environment. 
Compuware has found that even subt le changes have profound effects on performance. 
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Developing scripts 
 You use the QALoad Script Development Workbench to develop test scripts. It  contains faci l i t ies for 
capturing sessions, convert ing captured sessions in to scripts, and modifying and compil ing scripts. Once 
you compile your script , you can use QALoad's Conductor and Player components to test your system. 

Record Faci l i t y: QALoad's Record faci l i ty, which you can access through the QALoad Script Development 
Workbench, records the transact ions that your term inal, browser, or cl ient makes. It  stores these 
transact ions in  a capture f i le. 

Convert  Faci l i t y: QALoad's Convert  faci l i ty, which you can access through the QALoad Script 
Development Workbench, converts capture fi les in to scripts. It  generates a one-to-one correspondence of 
t ransact ions from the original session to your QALoad script . 

Visual  Navigator: Visual Navigator for WWW is QALoad's easy-to-use visual in terface to QALoad's 
powerful script  development tools. Visual Navigator for WWW renders your recorded C-based transact ion 
in  a tri -paned, browser-l ike environment similar to popular visual ly-oriented development tools, with icons 
represent ing al l  the elements of your script .  

Using QARun scripts for load test ing 

QALoad provides you with the funct ional i ty to perform load tests using your QARun scripts. By insert ing 
your QARun script  in to a QALoad script  template, you can t ime your GUI-driven business transact ions and 
include those t im ings in  QALoad post-test reports. 

Validat ing scripts 
Before you conduct an actual load test, you should individual ly val idate the script(s) you plan to use in  the 
load test by running i t  in  a simple test. If the script  runs to the end without any errors and runs mult iple 
t imes without errors, i t  is val id to use in  a load test. 

If the script  aborts on an error, debug the script  and run i t  through a simple test again. You can val idate 
scripts from the QALoad Script Development Workbench, the QALoad Player, or the QALoad Conductor:  

Val idate a script  from the Script Development Workbench 

Val idate a script  from the Player 

Val idate a script  from the Conductor 

Set t ing up the Conductor 
To prepare for running a load test, you must set up the Conductor:  

1. Start the Conductor.  

2. Configure the Conductor. After starting the Conductor, you may need to verify that the Conductor’s configuration 
parameters are set properly. 

3. Set up a session ID file. For every test you run, you must create a session ID file containing information the 
Conductor needs to run the test, such as which scripts to run, which Player machines to use, and whether to collect 
server or performance monitoring data. You use the Conductor to create and save session ID files in the 
\QAload\Session directory. 

Server and performance monitoring 

QALoad integrates several mechanisms for merging load test response t ime data with server ut i l izat ion data 
and performance metrics. Most methods produce data that is included in your load test t im ing results and 



QALoad Online Help 

5 

processed in QALoad Analyze. The only except ion is Appl icat ionVantage. Data captured from 
Applicat ionVantage can be opened in Appl icat ionVantage, but not in  QALoad.   

If you plan to col lect server and performance moni toring data, you must set the appropriate opt ions in  the 
Conductor before running the load test. The fol lowing methods of server and performance monitoring are 
avai lable: 

!  Remote Monitoring — allows you to monitor server utilization statistics from a remote machine without installing any 
software on the remote machine. 

!  Server Analysis Agents — must be installed on each applicable machine. 

!  ServerVantage — integrates with your existing ServerVantage installation. You must be licensed for and have 
installed and configured the appropriate product in order to integrate with QALoad . 

!  ApplicationVantage — collects test data that you can open in Application Vantage.  

Start ing the Conductor 
The fol lowing procedure describes how to start  the Conductor. 

To st ar t  t he QALoad Conduct or : 

1. From Windows: 

 Click Start>Program s>Com puw are>QALoad>Con ductor . 

From  a Com m and Prom pt : 

 Type  mpwin32 <session_file_name> /l /e /a /t  

The appl icable parameters are defined in the fol lowing table. 

Param eter Def in i t i on  

/l (Opt ional)  Creates a log fi le showing error messages 
and test status. 

/e (Opt ional)  Exits the Conductor when the test 
completes. 

/a (Optional) Launches Analyze when the test 
completes. 

/t (Opt ional)  Executes Conductor at a set t ime. Val id 
t ime formats are /txx:xx or 
/txx/xx/xx /txx:xx. 

 

2. When the Session Options dialog box opens, select the appropriate option to create a new session ID file or to 
open an existing one. Click OK. 

3. If you chose to open an existing session ID file, the Open dialog box appears. Navigate to the session ID file you 
wish to open, select it, and click Open. The selected session ID file opens in the Conductor Test Information Window. 

If you chose to set up a new session ID fi le, the Conductor opens displaying the Test In formation Window, 
and the configurat ion and setup toolbar. For in formation about the Conductor’s configurat ion and setup 
toolbar buttons, see Configurat ion and setup toolbar buttons. 
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Runn ing  a Load  Test  

Running a load test  
After val idat ing a script  using one of the methods described in Val idat ing scripts, i t  is safe to run a load test 
with that script . See the fol lowing topics for more in formation: 

!  Preparing for a Load Test 

!  Starting a Load Test  

!  Monitoring a Load Test 

!  Stopping a Load Test  

Preparing for a load test  
Before you run a load test, you must complete the fol lowing tasks: 

!  Prepare a datapool file: If you created a datapool file using the QALoad Script Development Workbench, QALoad 
stores the file where the Conductor can automatically access it. However, if you created a datapool file using a text 
editor (for example, Notepad), you must place the file in your appropriate 
\Middlewares\<middleware_name>\scripts directory (for example, 
\QAload\Middlewares\Oracle\Scripts) so the Conductor can access the file. 
 
For information about datapool files, see Simulating user-entered data. 

!  Set Up SSL Client Authentication for Virtual Users (SSL scripts only): If you are running a load test with a 
WWW script containing SSL requests, you should export a Client Certificate from your browser into QALoad or 
create a QALoad Client Certificate for each virtual user that runs the script. This setup facilitates a one-to-one ratio of 
Client Certificates to virtual users, which more realistically simulates your testing environment. 
 
To export Client Certificates from your browser and convert them for use in QALoad or to create QALoad Client 
Certificates, see Importing a client certificate from a Web browser. 
 
Once you export or create the necessary Client Certificates, you can insert them into your script using datapools.  

Start ing a load test  
While a load test is running, the Conductor’s toolbar changes from the Configurat ion and Setup Toolbar to 
the Runtime Toolbar. The Runtime Toolbar buttons let  you control the test and access detai led 
in formation about the test whi le i t  is running. 

For more in formation about what to expect from the QALoad Conductor whi le a test is running — 
including descript ions of the Runtime Toolbar buttons — see Monitoring a load test. 

To start  a load test, cl ick the Run  button on the configurat ion and setup toolbar or choose Start  Test  from 
the Conductor’s Run  menu. 

Note: While any window on the desktop is re-sizing or re-positioning, all Windows applications pause. Do 
not click and hold on a window caption or border for extended periods during a load test because it delays 
message handling and may impact the test results. 

Monitoring a load test  
When a test is started, the QALoad Conductor’s in terface changes to an in teract ive test control stat ion, 
referred to as the Runtime Window. The Runtime Window displays in formation about the scripts, 
machines, and virtual users that are execut ing the load test. From the Runtime Window, you can observe 
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the progress of individual scripts and Player machines, create and view real-t ime graphs, and start  or 
suspend scripts and Players from a running test to better simulate the unpredictabi l i ty of real users.  

In  addit ion to the test data shown by default  on the Runtime Window, you can access detai led test 
in formation using the QALoad Conductor’s Runtime toolbar buttons. You can: 

!  View statistics for a single virtual user 

!  View the activities of a virtual user in a browser-like window (WWW only) 

!  Step to the next request (WWW only) 

!  View the current datapool record 

!  Display the script running on a single virtual user 

!  Display messages sent from a Player workstation to the QALoad Conductor 

!  Display statistics about Conductor/Player communication 

!  Show/hide the Runtime Tree or Runtime Control Panel 

!  Synchronize all virtual users 

!  Exit, abort, or quit the test 

Running a batch test  
By sett ing the appropriate opt ions in  the Conductor, you can elect to run a series of tests as a batch, rather 
than one at a t ime. A batch test comprises mult iple session ID fi les that are executed sequential ly. 

You can create a batch test by adding a number of session ID fi les to a batch f i le. Before you can add a 
session ID to a batch fi le, the fol lowing condit ions must be true: 

!  The session must include a defined number of transactions. Sessions of unlimited transactions cannot be used in a 
batch test. 

!  All scripts to be included must exist before starting the batch test. This means the .c files referenced in the selected 
session ID files must be present in the scripts directory. 

Stopping a load test  
A load test is complete when al l  virtual users exit . A virtual user automatical ly exits when one of the 
fol lowing occurs: 

!  A script encounters an EXIT command. 

!  A script completes its transaction loop. 

To stop a load test, cl ick the Ex i t  button. 

Adding post -test  comments 

If you selected the Display Post  Test  Com m ents opt ion on the General  tab of the Options dialog box 
when you configured the Conductor, the Post  Test  Com m ents window opens when you cl ick the Qui t  
button. Type any comments, which are saved to the test ’s Summary Report, which can be viewed in 
QALoad Analyze. 
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Analyzing  Test  Resu l t s 

Analyzing test  results 
After you set up a load test and run i t , you can analyze the results from the test using QALoad Analyze. 

An important part  of the load test ing process is viewing and studying the results of a test. You can view 
load test results not only on a machine where QALoad is instal led, but also on any machine with a Web 
browser. 

When you run a test using a part icular session ID fi le (set up in  the Conductor), each Player compiles a 
local t im ing fi le comprised of a series of t im ing records for each checkpoint of each script  run on that 
Player. Each t im ing record in  the fi le consists of a response t ime/elapsed t ime pair of values specifying the 
amount of t ime i t  took a certain checkpoint to fin ish (response t ime) at a specific t ime in the test (elapsed 
t ime). 

At the end of a test, Player t im ing fi les are sent to the Conductor and are merged into a single t im ing fi le, 
cal led the Primary t im ing fi le, for analysis. If you set  up in tegrat ion with Compuware’s ServerVantage 
product, the Conductor col lects t im ing data from the ServerVantage central console and also merges that 
data in to the t im ing fi le. 

When you open a t im ing fi le, QALoad generates a working folder that contains al l  support ing fi les, reports, 
and images generated from that t im ing fi le. The folder is located in  the \Program 
Files\Compuware\QALoad\TimingFiles\xxx.xml.source directory, where <xxx> is the name of the 
t im ing fi le. 

Custom reports 

QALoad Analyze provides the abi l i ty to create custom reports using XML (Extensible Markup Language), 
XSL (Extensible Style Language), and HTM (Hypertext Markup) fi les. QALoad Analyze provides a set of fi les 
in  .htm, .xml, and .xsl formats in  addit ion to the .t im fi le. QALoad Analyze automatical ly generates a XML 
(*.xml), XSL (*.xsl), and HTM (*.htm) fi le when you open a t im ing fi le. 

Pre-defined reports 

QALoad Analyze provides pre-defined reports so you can receive immediate load test results without 
having to manipulate any data. Al l  the fi les necessary for those reports are located in  the directory 
\Program Files\Compuware\QALoad\Timing Files\Reports. 

Note: The pre-defined reports that are available depend on the data collected in the timing file, which is 
determined by the QALoad Conductor option you select at the time of running the load test. 
 

Graphing data 
Start ing with the Workspace, you can use QALoad Analyze’s chart ing features to graph t im ing data in  a 
number of formats and styles.  

Managing large amounts of data 

With a large number of virtual users, i t ’s possible to create a t im ing fi le contain ing hundreds of thousands 
of t im ing records for each checkpoint. Attempting to graph just a few of those checkpoints can slow 
QALoad Analyze down considerably. For example, i f a t im ing fi le contained 250,000 t iming records for 
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each data point, at tempting to graph even one checkpoint means that QALoad Analyze has to paint 
250,000 l ines on the graph. 

Since most monitors only have 1024 pixels across the screen, the 250,000 data points would most ly be 
plotted atop one another and the results would be unreadable. 

Now imagine attempting to graph the data of several data points of that size. The sheer amount of data 
could easi ly overwhelm a workstat ion. And every t ime you move the window, resize the window, right-
cl ick on the graph, or so on, QALoad Analyze has to re-draw the graph. You could conceivably spend 
enormous amounts of t ime simply attempting to graph data. 

To make large amounts of data manageable, QALoad Analyze provides an opt ion that al lows you to 
determine how to th in data. That is, how to determ ine how many data points to plot. 

QALoad Analyze graph types 

The fol lowing basic graph types are avai lable from QALoad Analyze. After generat ing one of the fol lowing 
graph types, you may further customize a graph in a number of ways.  

Line Graph 

A l ine graph plots response t imes versus elapsed t imes for the selected checkpoints. It  provides a 
good representat ion of how much fluctuat ion there is in  response t imes over the course of a test. 

Bar Graph 

A bar graph shows the median, mean, or percent i le response t imes for the selected checkpoints. 

Transaction Throughput Graph 

This type of graph shows the cumulat ive number of t ransact ions that occurred with in the user-
specified t ime range over the durat ion of the test. 

Response Time Distribution Graph 

This type of graph shows the percentage of checkpoint t im ings that fal l  with in a part icular response 
t ime range. A response t ime distribut ion graph shows i f response t imes tend to fal l  with in a range or 
are widely dispersed. A response t ime distribut ion graph only shows results for a single checkpoint, 
al though i t  can compare results from mult iple t im ing fi les. 

Cumulative Response Time Distribution Graph 

This type of graph shows the percentage of t ransact ions for a single checkpoint that have a response 
t ime equal to or less than a specified value. 

Customizing graphs 

You can also change the style and appearance of a graph using opt ions avai lable from the Graph toolbar. 
Display the Graph toolbar by right-cl icking in  an open area of a graph and choosing the Toolbar  opt ion 
from the shortcut menu. The Graph toolbar contains buttons for standard Windows operat ions as well  as 
for customizing the appearance of your graphs. 

The Graph toolbar includes the fol lowing features for customizat ion: 

!  Graph type (gallery type) 

!  Color 

!  Grid orientation (horizontal and vertical) 

!  Legend box 

!  Data display  

!  Dimension (3D or 2D) 
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!  Rotation 

!  Z-Cluster 

!  Color/pattern 

Integrat ing ServerVantage Agent  Data 
If you set opt ions to in tegrate ServerVantage resource ut i l izat ion data before running a test, that data is 
included in the result ing t im ing fi le. It  can be sorted and displayed in QALoad Analyze in  much the same 
way as QALoad t im ing data. ServerVantage data provides a summary of al l  the Agents that ServerVantage 
monitored during the load test and detai ls aggregate stat ist ics for Agent data points including min imum, 
maximum, and mean data values.  

Displaying ServerVantage Agent  data 

When you open a t im ing fi le contain ing ServerVantage Agent data, QALoad Analyze displays test data with 
QALoad t im ing data two ways: 

!  ServerVantage Agent workstations are listed in the Server Monitoring group in the Workspace tree-view, under the 
Resource Trends (ServerVantage) branch. From the Workspace, select Agent workstations to create detail or 
graphical views of the Agent data points. Specifically, you can: 

 Display Agent data point detai ls.  

 Graph Agent data point detai ls.  

!  Detailed data point information is displayed in the Data window. The ServerVantage detail view includes data such 
as the name of the machine where you ran the ServerVantage Agent; the Agent name; and the minimum, maximum, 
and mean data values for the Agent. 

Note: ServerVantage resource utilization data is available only if you set the ServerVantage integration 
options on the QALoad Conductor’s Test Information window before executing a load test.  
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Conduct or  

About  the Conductor 

Overview of the QALoad Conductor 

You use the QALoad Conductor to configure, run, and monitor a load test that ut i l izes the scripts you 
created in  the Script Development Workbench. The Conductor controls the QALoad Players and manages 
tests whi le they're running. 

Before running a test, you must set up a test by recording descript ive in format ion about the test, sett ing 
general test opt ions, configuring Player workstat ions, assigning compiled test scripts to Players, and sett ing 
up monitoring opt ions. Then, save the test setup in  a fi le cal led a session ID. Once you've configured and 
saved a test session ID, you can reuse i t  without re-entering any of your test in formation. 

While a test is running, the Conductor in terface changes to a tri -pane view cal led the Runtime window 
that faci l i tates monitoring of individual machines and Players, and displays real-t ime test results. You can 
view default  graphs of performance data that are created for you by the Conductor and create custom 
graphs based on the data being col lected during the test. Your custom graph layouts can be saved in the 
session ID fi le and reused in future tests. 

Taking a look at  the Conductor 

The Conductor's in terface is dynamic — i t  changes depending on where you are in  the test ing process: 
sett ing up a test, or running a test. Both in terfaces are described below. 

Test setup 

The Conductor's Main Window is divided into tabs on which you enter in formation about your test and 
set up the machines and scripts for the test. For more in formation about the test setup in terface, see Test 
setup in terface. 

Running a test 

While a test is running, the Main Window changes into the Runtime Window, which displays vital  
in formation about your running test and provides several controls to alter your test on-the-fly. For more 
in formation about the Runtime Window and how to use i t  whi le running a test, see Running a test. 

Test  Setup 

Test setup interface 

The Conductor's Main Window is divided into tabs on which you enter in formation about your test and 
set up the machines and scripts for the test. In  addit ion, the Conductor's toolbar provides access to 
standard Windows funct ional i ty such as Print and Copy, as well  as quick access to Conductor setup 
opt ions and to QALoad Analyze. Use the tabs on the Main Window to set up your test. For detai led 
in formation about the fields on these tabs, cl ick one of the l inks that fol low or press F1 from any 
Conductor tab. 
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Test Information 

Use th is tab to enter descript ive in formation about the test, view stat ist ics from the previous test, and set a 
maximum amount of t ime for the current test to run. Al l  descript ive in format ion about the test wi l l  be 
incorporated in to your test 's t im ing fi le, and can be viewed in Analyze with your test stat ist ics after the test 
has fin ished. 

Test  Descript i on : Enter a descript ion of the test, for example, i ts purpose. This field is wri t ten to your test 's 
t im ing fi le to describe the test. This field is opt ional. 

Cl ien t  System : Enter a descript ion of the cl ient workstat ions. This field is opt ional. 

Server System : Enter a descript ion of the server(s) under test. This field is opt ional. 

Database Size: Enter a descript ion of the database used in th is test. This field is opt ional. 

Com m ents: Enter any general comments about the test in  th is field. Note that th is field is overwrit ten at 
the end of a test i f the Post Test Remarks check box on the Options dialog box, General tab is enabled. In  
that case, notes you type in the Post Test Remarks dialog wil l  be saved to the test 's Summary Report. 

Session  Durat ion : Enter a value to specify the maximum amount of t ime for the test to run. Entering zero 
(the default) wi l l  execute the test indefin i tely. You can determine whether to stop the test immediately 
when the durat ion expires or to al low the virtual users to complete the running transact ions by using the 
opt ion Graceful ly exit  users when Session Durat ion expires on the Options dialog box, General tab.   

Enable Test  Recording: Select th is check box to record load tests for later review. 

Test  Tim e: This field displays the t ime the previous test started. 

Test  Date: This field displays the date the previous test started. 

Test  Durat ion : This field displays the length of t ime i t  took for the previous test to run. 
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Total  Vi rtual  Users: This field displays the number of virtual users assigned to the previous test. 

Total  Pass Transact ions: This field displays the number of t ransact ions that ran successful ly in  the 
previous test.  

Total  Fai l  Transact ions: This field displays the number of t ransact ions that fai led in  the previous test. 

 

Script Assignment 

Use th is tab to set up any scripts that have previously been recorded and compiled. Any scripts you add 
here is included in your load test, and one virtual user is automatical ly assigned to your script  on the 
M ach ine Assignm en t  tab. After sett ing up your scripts here, you must assign addit ional virtual users to 
your script  from the M ach ine Assignm en t  tab.   

Script : Select a script  from the drop-down l ist , or cl ick the New  button to add a script . Cl ick the brow se 
[...] button to open the Select Script  dialog box. 

New  but ton : Cl ick th is button to browse for a script  to add to the test. 

Delete but ton : Cl ick th is button to remove the selected script  from the load test. 

Delete Al l : Cl ick th is button to delete al l  scripts from th is test. 

Type: Lists the middleware type of the script . Cl ick the browse (...) button to set custom middleware 
opt ions. 

Transact ions: Type the number of t ransact ions that each virtual user running the designated script  should 
run. Once a workstat ion reaches the maximum number of t ransact ions, the script  cont inues execut ion 
with the l ine fol lowing the End_Transact ion command rather than return ing to the top of the transact ion 
loop. If you enter 0, the Conductor executes the script  indefin i tely. 

Debug Opt ions: Cl ick the browse button to access the Debug Options dialog box, where you can configure 
debug sett ings for the script . 

Error Handl ing: Choose how to respond when a non-cri t ical error occurs during execut ion of the 
transact ion. During large load tests, errors can sometimes indicate that the test is strain ing the l im its of the 
hardware/software in  the test ing environment. Options are: 

!  Continue Transaction — If an error occurs while a transaction is being executed, the Player should continue 
executing the transaction as if the error had not occurred. Select this option when errors are not critical to the 
performance of the load test and can be safely ignored. 

!  Abort Transaction — If an error occurs while a transaction is being executed, the Player should abort the current 
transaction and the virtual user who encountered the error should exit the test. Use this option when errors will make 
the virtual user invalid for executing more transactions. 

!  Restart Transaction (WWW, SAPGUI, and Citrix scripts only) — If an error occurs while a transaction is being 
executed, the Player should abort the current transaction entirely and restart a new transaction from the beginning. 
Note that the transaction count increases for each transaction that is restarted. 

QALoad uses two commands — DO_SetTransact ionStart() and DO_SetTransact ionCleanup() — to control 
error handl ing. These commands are inserted in to your script  by the conversion process.  

Sleep Factor %: QALoad records the actual delays between requests and inserts the DO_SLEEP command in 
the script  to mimic those delays when the script  is played back in  a test. You can maintain the exact length 
of the recorded delays at playback, or shorten them by entering a smaller percentage of the original ly 
recorded delay to play back. For example, i f you recorded a delay of 10 seconds, then DO_SLEEP (10); is 
wri t ten to your script . Then, i f a Sleep Factor of 50% is specified here, the Player wi l l  sleep for 5 seconds at 
that statement when the test is executed.   

Val id values for Sleep Factor % are 0-999,999% and also Random, which causes the Player to sleep for a 
randomly selected durat ion between 0 and the number of seconds specified in  the DO_SLEEP() statements. 
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When a load test is executed with a Sleep Factor of 100% the script  executes at exact ly the same speed at 
which i t  was recorded; therefore, you can simulate the performance of faster users by specifying a lower 
Sleep Factor % value.  

Hint : Enter a value of zero during unit testing to eliminate the actual sleeps from the script. After you unit 
test the script, you can restore the original recorded delays by changing the Sleep Factor to a higher 
percentage. 

Service Level  Th reshold : Enter a response t ime to use as the threshold for comparing other response 
t imes. When you run a test, a l ine represent ing the Service Level Threshold wi l l  appear in  the runt ime 
window. As the test progresses, you can compare incoming response t ime data to the Service Level 
Threshold. This is a prel im inary way of analyzing test results without wait ing to open the t im ing fi le at the 
end of the test, and can be used as an indicator to determine i f/when Dial-Up users should be added to the 
test. 

Pacing: Enter a value in  th is field for the rate of pacing. Pacing is the t ime interval between the start  of a 
transact ion and the beginning of the next transact ion on each workstat ion running the script . For 
example: i f a transact ion is designed to dupl icate the process of someone handl ing incoming telephone 
cal ls and those cal ls arrive at a rate of 40 per hour/per person, set the pacing rate at 90 seconds. 

The default  pacing value is one second. This al lows the Conductor to thrott le runaway virtual users. 

QALoad randomly schedules transact ions so that each transact ion executes on an average according to th is 
predetermined rate. When a transact ion completes faster than i ts pacing rate, QALoad delays the execut ion 
of the next transact ion for that workstat ion so that proper pacing is met. Since we do not normally t ime 
events according to th is predetermined rate, QALoad randomly accelerates or delays the pacing on a 
workstat ion-by-workstat ion basis. However, on the average, QALoad provides pacing according to the value 
that you assign. 

Tim ing Opt ions: Cl ick the browse button to open the Timing Options dialog box, where you can choose 
to include QALoad's automatic t im ings in  your test results or determine how much t im ing data to col lect.  

Extern al  Data: Cl ick the browse button to open the External Data dialog box where you can select any 
central datapool fi les, local datapool fi les, or addit ional external support fi les necessary for your test.  For 
addit ional in formation, see Using the certDB Fi le for OFS Replay. 

 

Monitoring Options 

Use the M on i toring Opt ions tab to specify opt ions for your monitoring task. You also can integrate 
ServerVantage into your load test. QALoad assumes that the appropriate ServerVantage software is 
instal led, configured, and running before you start  a load test. 

Enable Perform ance M on i toring at  Run t im e: Enables the monitoring of the counters specified in  a 
monitoring task you create. 

When you select a monitoring task, the fol lowing displays: 

M on i tors: Displays the l ist  of groups of monitors and associated machines selected for th is monitoring 
task. Use the select ion button to choose to display groups by machine name or by monitor type.  

M on i tors detai l : Displays detai ls of the monitoring task you selected including Machine name, 
Monitor Type, and the date i t  was last updated. 

Use the icon to choose how to view the monitors. You can choose: 

 Group by machine name 

 Group by monitor type 

When you select a monitoring template, the fol lowing displays: 

Tem plates: Displays the name of the template you selected. 
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Coun ters: Displays the groups and counters defined in the template.  

View  Propert i es: Displays the propert ies for the monitoring task. 

Set  up m on i toring: Displays the Set Up Monitoring dialog box, where you can choose to set up a new 
monitoring task or use an exist ing task stored as a template. 

 

Machine Assignment 

Use the M ach ine Assignm en t  tab to assign scripts to specific Player workstat ions. You can use the Edi t  
menu's Copy  and Paste commands to copy and paste machine entries (rows) as needed. 

Script : This field displays the script  name. To add a script , cl ick New . 

M iddlew are: Displays the middleware type the script  was created for. Use the brow se [...] button to open 
the Expert User Options dialog box.  

Start i ng VUs: Type number of virtual users to begin the test. 

VU Increm en t : Type the number of virtual users to be added, at in tervals, after the test begins. 

Tim e In terval : Displays the t ime interval at  which incremental virtual users wi l l  be added to a test. Change 
the t ime interval by typing a new value. 

Ending VUs: Displays the number of virtual users assigned to run unt i l  the end of the test. 

M ach ine: From the drop-down l ist , select Player machines to assign each script  to run on.  
For Appl icat ionVantage integrat ions, the Player and Conductor machines must be on the same LAN.  

M ode: Select the test mode for each Player machine: th read-based , process-based . 

New  but ton : Cl ick to access the Select Script  dialog box where you can select a script  to add to the test. 

Delete: Cl ick to delete the selected script . 

Delete Al l : Cl ick to delete al l  scripts. 

M an age Player M ach ines: Cl ick th is button to display the Manage Player M achines and Groups dialog 
box. 

Auto Con f igure: Cl ick th is button to have QALoad automatical ly assign scripts to virtual users. 

Run : Cl ick to start  a test run. This button is only enabled i f your test is completely set up.  

Running a Test  

Runtime window interface 

When you start  a test, the Conductor's in terface changes to an in teract ive test control stat ion cal led the 
Runtime Window. The Runtime Window displays in formation about the scripts, machines, and virtual  
users that are execut ing the load test.  The test data is divided into three views – Detai ls, Graphs, and 
Session – that are accessed from the Test Views workspace on the left  side of the in terface. 

From the Runtime Window, you can observe the progress of individual scripts and Player machines, view 
real-t ime graphs, and start  or suspend scripts and Players from a running test to better simulate the 
unpredictabi l i ty of real users. This window has three unique areas. Cl ick on a pane in the fol lowing graphic 
for a brief descript ion of that pane. Or, cl ick on the l inks below the graphic for detai led in formation. 
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Details view 

The Detai ls view of the Data window displays al l  your test data in  real-t ime in a series of in teract ive tabs. 
By cl icking on icons represent ing scripts, virtual users, and workstat ions, you can view different types of 
data. By default , each test displays test detai ls in  the right pane. You can also choose to view the script  a 
single virtual user is running, the Web page a WWW script is ut i l izing, or the RIP fi le generated by a fai led 
virtual user.  

Test  detai l s 

Test detai ls display automatical ly, and describe the object you select in  the tree view. You can view detai ls 
for al l  test scripts, individual test scripts, al l  player machines, and individual player machines. 

See Test detai ls for more in formation about the Tree i tems that can be displayed in the data window.  

Runt im e tabs 

The fol lowing runt ime tabs can be displayed for a running script . These tabs can be enabled from the 
Vi rtual  User  menu. 

Debug 
Monitor (Web User) 
RIP Fi le (WWW) 

Runt im e Con t rol  Panel  

The Runtime Control Panel is a dockable control stat ion that enables you to change virtual user opt ions 
and data transfer opt ions while the load test is running. For more in formation, see Runtime Control Panel. 

Graphs view 

The Graphs view displays graphs of data col lected during the test. By default , the Graphs view displays 
graphs for response t imes, test status, and player machine health.  



QALoad Online Help 

17 

Other graphs, such as user-defined checkpoints and Remote M onitoring counters, can also be plotted in  
the right pane of the Graphs view i f they were enabled for the session. 

To display graphs: 

1. Right-click on a counter or other data type in the tree view that you want to plot in a graph. 

2. Choose Add Graph or Add Plot To.  

You can also modify a graph's appearance by right-cl icking on the graph and choosing one of the 
formatt ing opt ions, such as colors and axes propert ies. To increase the visibi l i ty of a plot when you have 
mult iple plots on a graph, cl ick on a plot (or that plot 's number in  the legend) to h ighl ight i t . 

 

 

Session view 

The Session view provides summary in formation about the test session that is current ly running. The 
Session view can be printed as a report  by right-cl icking and choosing Prin t  from the shortcut menu. 

Note: The Session view below has been cropped to better fit this help topic, while still representing what a 
real Session view might look like.  
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Click on the sect ions in  the fol lowing graphic for more in formation about the Session view. 

 

 

QALoad Conductor menus and toolbar but tons 

The Conductor's menus and toolbar buttons are dynamic; their content depends on whether you are 
preparing a test setup or running a test.  

Test setup 

The Conductor Configurat ion and Setup Menus al low you to configure the Conductor and your specific 
test. Cl ick a menu or toolbar name below for detai ls: 

Fi le 
Edit  
View 
Run 
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Tools 
Help 
Configurat ion and Setup toolbar buttons 

Running a test 

The Conductor's Runt ime menus and toolbar al low you to control your running test and the data that is 
displayed at test t ime. Cl ick a menu name below for detai ls: 

Test Options 
View 
Runtime Windows 
Virtual User 
Graph 
Runtime toolbar buttons  

Monitoring CPU usage 

To help you monitor the impact of running a load test on a server, QALoad can col lect data from selected 
Players about CPU usage during a load test. The stat ist ics col lected during the test are merged into the test 's 
t im ing fi le so you can view them in Analyze after the test.  

When the Top Process M on i toring coun ter  is enabled for a Server Analysis Agent machine, in formation is 
col lected periodical ly during the load test about which processes are using the most CPU.  Counter data is 
wri t ten to your test 's t im ing fi le, which you can open in Analyze after your test. 

Note: During a load test, if the CPU idle time of your machine falls below 25%, check the individual 
processes on your machine. If the Players and virtual users are utilizing most of the active CPU time, you 
should use additional Player machines and fewer virtual users per Player to conduct your load test. 

To col lect  Top Processes dat a:  

1. In the Monitoring Options tab, click the Set up monitoring link. 

2. Select Set up a new monitoring task, and click OK. The New Monitoring Task Wizard opens. 

3.  In the Define Monitor dialog box, select Server Analysis Agents in the Monitor Type field. 

4. In the Choose Counters dialog box, click the Counters tab, then select Top Process Monitoring and add it to the 
Selected Items pane. 

5. Complete the steps in the wizard to save the monitoring task. 

When your test is fin ished, the Top Processes data col lected wil l  be included in your test 's t im ing fi le which 
you can open in QALoad Analyze. 

Dial-up virtual users 

QALoad's dial-up/dial-down feature al lows you to dynamical ly add or reduce virtual users to your test  at 
the script  or Player level whi le your test is running. This enables you to adjust your running test according 
to test behavior on-the-fly, rather than stopping to re-configure playback cri teria. 

To use the dial-up/dial-down feature, you must:  

!  be licensed for at least the number of virtual users requested 

!  configure a ramp-up session before running the test 

Note: Ramp-up is not supported for a machine assignment entry that is using a player group. 
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Set t ing Up a Test  

Overview of test  setup 

To set up a load test, you wil l  set opt ions related to general Conductor behavior as well  as in formation 
about your specific test environment. Before you can successful ly set up a load test, you must have 
recorded and compiled one or more test scripts. For in formation about recording a test script , see 
Developing scripts in  the Gett ing Started sect ion. 

Determining general Conductor behavior 

General Conductor opt ions you set wi l l  be appl icable for al l  tests run unt i l  you change them. Conductor 
opt ions are related to the fol lowing: 

!  Viewing options for real-time results 

!  Global Player options 

!  Player machine performance data 

!  Options for runtime reporting 

!  And more... 

All of the above information, and more, can be configured from the Conductor's Options dialog box. 

Setting up a specific test session 

To prepare the Conductor for a specific test, you wil l  save information and parameters specific to that test 
in to a reusable session ID fi le (.id). You wil l  need to enter the fol lowing types of in formation to set up a 
test 's session ID fi le: 

!  General information about the test such as a description, the size of the database, the length of the test, and any 
notes or comments 

!  Information about the test script(s) included in the test, including script name, middleware/protocol type, pacing, 
whether to include external data, and so on 

!  Information about the workstations where the QALoad Players reside, including which script is assigned to each 
workstation, how many virtual users are assigned to each workstation, the machine name, and so on 

!  (Optional) configuration for server monitoring 

!  (Optional) integration with other Compuware products. 

All of the above information can be entered and saved from the Conductor's main window, the Test 
In formation Window. 

 

Ant icipat ing error condit ions 

You know before beginning a load test that errors are a possibi l i ty, but you may not always want them to 
stop you cold.  

QALoad helps you ant icipate error condit ions and determine, before running your test, how your Players 
wi l l  react to non-fatal errors. By sett ing one opt ion, you can instruct a Player to cont inue as i f no error was 
encountered, stop running immediately, or restart  at  the beginning of the transact ion. 

To set the error handl ing opt ion, see the help topic for the Script Assignment tab. 

Configuring the Conductor 

There are several sett ings for the Conductor that you should review before beginning your load test. 
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To set  Conduct or  opt ions t hat  are not  speci f ic t o one t est : 

1. From the main menu, choose Tools>Options. 

2. On the Options dialog box, set options related to post-test activity, warnings and prompts, runtime grids, timing 
settings, interface refresh intervals, Conductor/Player communications, monitoring intervals, and more.  

3. When you are finished, click OK to save your changes. Any options you set will apply to all tests until you change 
them. 

For detai led descript ions of the opt ions that are avai lable, see Options dialog box.  

Managing large amounts of test  data 

Your load test probably includes a large number of checkpoints and virtual users in  order to adequately test 
your system. When your test is running and your Conductor is col lect ing t iming in formation from your 
Player machines, the sheer amount of data can take up more of your resources than you'd l ike to expend. 
Use QALoad's Timing Data Thinning opt ion to th in the amount of t im ing data being transferred back to 
the Conductor during the test so that your test can run longer without stressing your resources.  

To t h in t im ing dat a: 

1. With your test session ID file open, click the Script Assignment tab. 

2. For each script for which you would like to thin your test data, click the button in the Timing Options column. 

3. On the Timing Options dialog box, click the Enable Timing Data Thinning check box. 

4. In the Thin Every... field, type the number of transactions to average. The average will be sent to the Conductor for 
inclusion in the timing file, rather than every value. 

5. Click OK. 

6. Save your changes to your test session ID file by choosing File>Save from the Conductor menu. 

For more detai ls about the Timing Options dialog box, see Timing Options. 

Set t ing up a test  session 

You can enter al l  the in formation necessary for your session ID fi le right from the Conductor's main 
window, the Test In formation Window. 

Hint : The following procedures guide you through setting up a reusable test session ID using the 
Conductor's main window, the Test Information window. Follow each step in turn to configure your test, or 
revisit this help topic later to make changes to any specific part of the test setup. 

Step 1: Enter descriptive information about the test 

On the Test  In form at ion  tab: 

1. (Optional) Type descriptive information about the test in the Test Description, Client System, Server System, 
Database Size, and Comments fields. 

2. In the Session Duration field, type a time limit to specify the maximum duration for the test to run. Enter zero if you 
do not want to specify a maximum duration. 

Hint : For details about any field on the Test Information tab, see Test Information. 
 

Step 2: Assign compiled scripts to the test 

On the Script  Assignm en t  tab: 

1. Click New to open the Select Script dialog box. The Select Script dialog box lists the scripts available for your 
transaction type. If it does not, select your transaction type (middleware environment) from the Scripts of Type list. 
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Hint : To open the Select Script dialog box from the Script  column, click in the Script  column to 
enable the Browse (...) button. Then, click Browse. 

The Select  Script  dialog box l ists a status for each script  that indicates whether the script  is 
compiled. If i t  is not, you must compile the script  before attempting to use i t  in  a test. 

2. Select a script from the list and click Select to return to the Script Assignment tab. 

3. Continue selecting scripts until all scripts you wish to use in this test are listed. 

4. (Optional) Select ApplicationVantage Mode to enable AV timings. When you make this selection. you must also 
perform Step 5: Set up ApplicationVantage Options.  

Hint : For details about any field on the Script  Assignment  tab, see Script Assignment. 
 

Step 3: Set test options for each script 

For each assigned script  on the Script  Assignm en t  tab: 

1. In the Transactions column, type the number of transactions that each virtual user running this script should run. 
Once a workstation executes the number of transactions that you specify, script execution continues with the line 
following the End_Transaction command rather than jumping to the beginning of the transaction loop 

2. Click in the Debug Options column to enable the Browse button. Click Browse to open the Debug Options dialog 
box, and then set any options for Debug Trace and Logfile generation. For a description of the Debug Options 
dialog box, see Debug Options. 

3. In the Error Handling column, select the option that indicates how the Player running this script should behave 
when encountering non-fatal errors: Abort the transaction, Continue the transaction, or Restart the transaction. 

4. Enter a value in the Sleep Factor column to specify the percentage of any originally recorded delay to preserve in 
the script (for example, a value of 80 means preserve 80% of the original delay).  

5. In the Service Level Threshold column, type a maximum duration for this script. At runtime, the QALoad Conductor 
will display a runtime graph comparing the Service Level Threshold with the actual duration. 

6. In the Pacing column, type a value, in seconds, for pacing.  

7. Click in the Timing Options column to enable the Browse button. Then, click Browse to access the Timing Options 
dialog box and set options related to checkpoints and data thinning.  

8. (Optional) Click in the External Data column to enable the Browse button. Then, click Browse to open the External 
Data dialog box and associate any necessary external files with your selected script.  

Hint : For details about any field on the Script  Assignment  tab, see Script Assignment. 
 

Step 4: Set up Player machines 

From any tab: 

1. Select Tools>Manage Player Machines. The Manage Player Machines and Groups dialog box appears. 

2. Click File>Discover Player Machines to query your network for QALoad Player workstations. All workstations with 
QALoad Players installed are listed. If Player machines are discovered to have previous versions of QALoad 
installed, an error message informs you which machines need to be updated. 

3. Check the availability of all the Player machines on your network by clicking Verify All, or by selecting individual 
machines and clicking Verify. The QALoad Conductor requests each selected Player machine to ensure it is 
available.  

If a Player machine is available, system information for that machine appears in the Details area of the dialog box. 
View the Properties dialog box for that Player machine by double-click on the Player machine listing. If the Player 
machine is not available, you receive a message that the Player is not responding. 

4. (Optional) Use New to manually add a Player machine, or Delete or Delete All to remove machines. To save the 
current machine setup for re-use, create a new configuration file (.cfg). How? 

Hint : For details about any field on the Machine Configuration tab, see Monitoring Options. 
 



QALoad Online Help 

23 

Step 5: (Optional) Set up ApplicationVantage 

Note: You must have ApplicationVantage installed on the Player machine to activate these fields.  
This step is required if you selected ApplicationVantage Mode on the Select Script dialog box . Refer to Step 2: 
Assign Compiled Scripts to the Test for more information. 

From any tab: 

1. Select Tools>Manage Player Machines. The Manage Player Machines and Groups dialog box appears. 

2. Double-click on the Player machine listing. The Edit Player Machine dialog box displays. 

3. Click the ApplicationVantage Settings tab.  

4. In the NIC ServiceName field, select the Network Interface Card on which you will collect timings. 

5. Click Apply, then click OK. 

  

Step 6: (Optional) Set up Remote Monitor Machines 

On the M on i toring Opt ions tab: 

1. Click the Enable Performance Monitoring at Runtime check box to enable monitoring at test time. 

2. Create a monitoring task to specify which counters to monitor or apply an existing task and modify the counters as 
necessary: 

 Create a new monitoring task 

 Use an exist ing task 

  

Step 7: Assign scripts to Player machines 

On the M ach ine Assignm en t  tab, the scripts you assigned to the test on the Script  Assignm en t  tab are 
l isted in  the Script  column. Fi l l  in  the fol lowing columns: 

Note: Use Auto Configure to have QALoad automatically assign scripts to virtual users. 

1. In the Starting VUs column, type the number of virtual users to initially launch the script on this machine when a test 
begins. 

2. In the VU Increment column, type the number of virtual users that should be added, at intervals, if you want this 
machine to add incremental virtual users. You must also fill in the Time Interval and Ending VUs fields.  

3. In the Time Interval column, type the time interval at which incremental virtual users should be added to a test. (For 
example, to add virtual users every 5 minutes, type 00:05:00). You must also fill in the VU Increment and Ending 
VUs field. 

4. Type the number of virtual users assigned to run until the end of the test. 

5. In the Machine column for each script, select a Player machine from the drop-down list to assign it to that script. If 
no Player machines are available in the drop-down list, click the Manage Player Machines button to set up a 
Player. 

6. In the Mode column, select the test mode for each Player machine: thread-based or process-based. 

7. (Optional) Use New, Delete, and Delete All to add or remove scripts from this test.  

 

Step 8: (Optional - WWW only) Enable Expert User 

On the M ach ine Assignm en t  tab: 

1. Click in the Script column to enable the Browse button. Click Browse to open the Expert User Options dialog box. 

2. Select Enable Expert User timings. 

3. In the Virtual User field, type a virtual user number, if necessary. 

4. Click OK.  
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When al l  scripts have been successful ly assigned to Player machines and the test is ready to run, Run  on 
the M ach ine Assignm en t  tab wil l  become avai lable and you can run a test. 

 

Step 9: Save the test setup you just created as a reusable session ID file 

Save the test  setup 

To save the current test setup to a reusable test fi le cal led a session ID, cl ick Fi le>Save to name and save i t . 

Save the m ach ine con f igurat ions 

To save the Player Agent, Server Analysis Agent, Remote Monitoring Agent, Expert  User, and 
Appl icat ionVantage integrat ion configurat ions to a reusable fi le, cal led a configurat ion fi le (.cfg) see Saving 
machine configurat ions. 

Saving Machine Configurat ions 

After configuring the machines to use for a load test , you can save the machine configurat ion in formation 
in to a configurat ion fi le (.cfg) that can be reused in later tests, saving you significant t ime sett ing up later 
tests. A configurat ion fi le includes in formation about which machines on the network were used as Player 
machines. You can save mult iple configurat ions under different names. By default , when first  using 
QALoad, the Conductor uses a configurat ion fi le named Default.cfg. The Conductor saves any changes 
to your machine configurat ions to th is fi le unless you save your configurat ion to a new fi le with a different 
name.   

You can open or save .cfg fi les from the M anage Player M ach ines and Groups dialog box. The .cfg field 
always displays the act ive configurat ion. 

To creat e a new , em pt y .cf g f i le: 

1. On the Monitoring Options tab, click Tools>Player Machines. The Manage Player Machines and Groups dialog box 
displays. 

2. Click down arrow on the .cfg field at the bottom of the dialog box. 

3. Choose <New>. 

4. On the Save As dialog box, specify a name for the new file and click Save. 

5. Add the necessary Player and agent machines using the fields and buttons on the Manage Player Machines and 
Groups dialog box. The machines you configure are saved automatically to the file you just created. 

To renam e t he cur rent  .cf g f i le: 

1. On the Manage Player Machines and Groups dialog box, click the down arrow on the .cfg field at the bottom of the 
dialog box. 

2. Choose <Save As>. 

3. On the Save As dialog box, specify a name for the new file and click Save. 

4. Make any necessary changes to the configuration. Your changes are saved automatically to the file you just created. 

To open a previously creat ed .cf g  f i le: 

1. On the Manage Player Machines and Groups dialog box, click the down .cfg field at the bottom of the dialog box. 

2. Choose the .cfg file to open. 
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Note: The .cfg file only stores information about Player machines. It does not store information specific to a 
test, such as script names or settings. Test specific information is saved in the session ID file. A session ID file 
for a specific test saves the name of the .cfg file associated with that test, and opens it automatically when the 
session ID file is opened. You can change the .cfg file at any time without being concerned about the session 
ID file. 
 

 

Add a Player workstat ion to a test  session ID 

Follow these instruct ions to add a Player workstat ion to your pool of avai lable Players in  a test 's session ID 
fi le.  

To add a Player  w orkst at ion t o a t est  session ID: 

1. On the Conductor's Test Information window, click the Machine Configuration tab. 

2. Click the New button to open the New Entry dialog box. 

3. Type the host name and port number of the new Player in the Agent Machine Host Name and Agent Port fields. If 
you do not know a Player’s host name, check the Player’s window at startup. It displays the workstation’s Player 
name. 

4. Click the Request button to ensure the machine is available. If the Player is available, the number of thread- and 
process-based virtual users it supports are listed in the appropriate columns, and the button text changes to OK. 

If the Player does not respond, a message box appears indicat ing that the Player is not responding. If 
the Player is not responding, one of the fol lowing scenarios is l ikely: 

 The host name and/or port  number you entered may not be correct. Check your 
parameters and network connect ions, then try to send another request. 

 The Player is not running. Start  the Player and then try to send another request.  

Adding sessions to a batch test  

Before a session is added, the fol lowing condit ions must be true: 

!  The session must include a defined number of transactions. Sessions of unlimited transactions cannot be used in a 
batch test. 

!  All scripts must exist prior to starting the batch test. This means that the files referenced in the selected session ID 
files are present in the script directory. 

A session can be placed in  a batch mult iple t imes. This feature might be used to re-run a test or to perform 
housekeeping chores, such as logging users in  or out of a host or database. 

To add a session : 

1. From the Run menu, choose Batch Test. 

2. In the Session Files (.id) box, highlight the session you want to add, and click the Add button. 

If you want to run a previously defined batch, cl ick the Load  button to navigate to the directory 
where the batch fi le (.run) resides. Select i t , and cl ick OK. 

The session is added to the Batch List  on the right side of the dialog box.  
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Assigning scripts to Player workstat ions 

1. There are two ways to assign scripts to Player workstations from the Test Information Window, Machine Assignment 
tab: 

 M an ual  assignm en t  — In  the Machine column for the appropriate script , select a machine 
from the l ist  to assign i t  to that script . 

 Autom at i c assignm en t  — Type the total number of virtual users to assign to the test in  the 
Start ing VUs column, then cl ick the Auto Con f igure button. QALoad wil l  automatical ly assign 
scripts to each Player workstat ion. 

2. From the File menu, choose Save to save your changes to the current session ID file, or Save As to save them to a 
new session ID file.  

Changing the number of virtual users 

You can change the number of virtual users assigned to a script  from the Test In formation Window, 
Machine Assignment tab. 

To change t he num ber  of  vi r t ual  users: 

1. Enter a new value in the Starting VUs column for the selected script. 

2. If you have assigned incremental virtual users, change the values in the VU Increment and Ending VUs columns for 
the appropriate script to determine how many virtual users to add at the interval specified in the Time Interval 
column. 

3. From the File menu, choose Save to save your changes to the current session ID file, or Save As to save them to a 
new session ID file.  

Changing test  opt ions 

To change t est  op t ions: 

1. To change any of your test options, make your changes on the Test Information, Script Assignment, Monitoring 
Options, or Machine Assignment tabs. 

2. From the File menu, choose Save to save your changes to the current session ID file, or Save As to save them to a 
new session ID file.  

Removing a script  from a test  

Follow these steps to remove a script . 

To rem ove a scr ipt  f rom  a t est : 

1. On the Test Information tab, click on the selection box to the left of the script name to highlight the row. 

2. Click the Delete button to remove the script from the test. 

3. Select File>Save to save your changes to the current session ID file, or File>Save As to save them to a new 
session ID file.  
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Removing a session from a batch test  
1. Select Run>Batch Test. 

2. Highlight the session to remove in the Batch List and click Remove.  

Set t ing Auto Abort  
1. Select Run>Batch Test. 

2. Select Auto Abort After and use the slider to set the number of seconds to wait before aborting a test. 

Normally, each test runs for the durat ion set in  i ts respect ive session ID fi le. An individual test run is 
complete when al l  the virtual users have exited. If the Auto Abort After check box is selected and al l  the 
virtual users in  a test do not exit  with in the specified number of seconds, the Conductor automatical ly 
aborts the test.  

Remove used datapool records after a test  

You can remove used datapool records after a test by sett ing the Strip Datapool funct ion before you run the 
test. Use th is funct ion when running a test where you have data in  the external datapool which can only 
be used once by one virtual user at a t ime. (For example, when running transact ions that have unique data 
constraints.) When act ivated, the Strip Datapool funct ion wil l  mark each piece of data in  the datapool that 
is used during your test. When the test is over, the Strip Datapool funct ion prompts you to remove the 
ident i fied used data from the datapool. If you run the test again, only new data wi l l  be used for your 
subsequent test. 

To use t he St r ip  Dat apool  f unct ion: 

1. With the current test's session ID file open in the Conductor, select the Script Assignment tab. 

2. Click the External Data button. The External Data dialog box appears. 

3. In the Central Datapool area, select the Strip check box. Click OK. 

4. At the end of your test, a Strip Datapools prompt will appear asking if you wish to go to the Strip Datapools screen. 
Click Yes. 

5. The Strip Data Pool dialog box appears. Click the Strip button. 

6. When you are finished, click Done.  

Set t ing automat ic st ripping of datapools between batch tests 
1. Select Run>Batch Test. 

2. Add sessions to the Batch List, or load the batch file you wish to run. 

3. Select Automatic Datapool Stripping Between Tests. 

Datapool records used during the test wi l l  be removed before start ing the next test in  the batch.  

Note: Only those datapools marked as strippable on the External Data dialog box, accessible from the Test  
Informat ion Screen Script  Assignment  tab, will be removed. 

Set t ing delays between tests 

You can set a fixed delay or pause between tests by specifying a value in  the Delay Betw een  Tests field on 
the Batch Test dialog box. After each test is complete, the Conductor delays for the specified amount of 
t ime before start ing the next test.  
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Validat ing a script  

Before running a test, you should run your script  in  a simple test to ensure that i t  runs without errors. You 
can val idate UNIX or Win32 scripts from the Conductor. 

Debugging a script  

If you encountered errors whi le val idat ing or test ing a script , use QALoad's debugging opt ions to monitor 
the Player(s) that generated errors whi le they are running or after the test. Three debugging strategies are 
described below. 

Watch a virtual user execute a script on a Player workstation while it is running 

To monitor selected virtual users at runt ime, enable the Debug Trace opt ion before you run your test. 

To enable t he Debug Trace opt ion : 

1. On the Conductor's Script Assignment tab, highlight the script you want to monitor. 

2. In the Debug Options column, click the browse (...) button (note that the button may not be visible until you click in 
the Debug Options column). 

3. On the Debug Options dialog box, in the Debug Trace Virtual User Range area, choose which virtual users (if any) to 
monitor. You can choose None or All Virtual Users, or choose Virtual User(s) and then type the numbers assigned to 
the virtual users you want to monitor. You can monitor individual virtual users or ranges of virtual users.   

4. Click OK to save your changes. 

5. From the Conductor's main menu, click File>Save to save your test session ID. 

6. Run your test as usual. Each virtual user for which you enabled Debug Trace will display messages on its assigned 
Player workstation indicating which commands are being executed. 

Log details from selected virtual users while they are running (Citrix, DB2, ODBC, Oracle, Oracle Forms Server, 
SAP, Uniface, Winsock, or WWW only) 

You can instruct the Conductor to generate and save detai ls about the script  execut ion of selected virtual 
users by enabl ing Logfi le Generat ion before you run your test. 

To enable Logf i le Generat ion: 

1. On the Conductor's Script Assignment tab, highlight the script you want to monitor. 

2. In the Debug Options column, click the browse (...) button (note that it might not be visible until you click it). 

3. On the Debug Options dialog box, in the Logfile Generation Virtual User Range area, choose which virtual users (if 
any) to monitor. You can choose None or All Virtual Users, or choose Virtual User(s) and then type the numbers 
assigned to the virtual users you want to monitor. You can monitor individual virtual users or ranges of virtual users.   

4. Click OK to save your changes. 

5. From the Conductor's main menu, click File>Save to save your test session ID. 

6. Run your test as usual. Each virtual user for which you enabled Logfile Generation will create a file containing 
information about their performance. After the test is finished, the Conductor will request all log files from the Players 
and save them in the directory \Program Files\Compuware\QALoad\LogFiles on the workstation where the 
Conductor is installed. Log files are named <scriptname>_<middleware>_vu<AbsoluteVirtualUserNumber>.<ext>, 
where: 

!  <scriptname> is the name of the script the virtual user ran 

!  <middleware> is the name of your middleware application 

!  <AbsoluteVirtualUserNumber> is the identification number assigned to the virtual user 
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!  <.ext> is the file extension, dependent upon which middleware application you are testing. File extensions 
are listed in the following table: 

M iddlew are Fi l e Ex tension  

Uniface 
WWW 

.cap — A standard log fi le contain ing 
in formation about al l  statements executed 
during a test. 

Citrix 
DB2 
ODBC 
Oracle 
Forms Server 
SAP 
Winsock 
WWW 

.log — A standard log fi le contain ing 
in formation about al l  statements executed 
during a test. 

View automatically generated log files from failed virtual users (Oracle and WWW only) 

A Player that fai ls to execute a test script  automatical ly generates a log fi le (with .rip extension) that detai ls 
the requests that were played back by that Player. You can view a Player's .rip fi le from the Conductor's 
Runt ime Window while a test is running, or later in  QALoad Analyze. At the end of a test, al l  .rip fi les are 
sent from the Players to the \QALoad\LogFiles directory and added to the merged t im ing fi le, where you 
can view them in Analyze.  

To view  a .r ip  f i le w hi le t he t est  is running : 

1. In the Runtime Window's tree-view, right-click on a failed Player icon.  

2. From the context menu, choose Display RIP File. 

A new tab opens in the Runtime Window displaying detai ls about the script  the Player attempted to run, 
and which subsequently fai led. 

To view  a .r ip  f i le in  QALoad Analyze: 

At the end of your test, after al l  test results have been col lected, open your result ing t im ing fi le in  Analyze. 
Cl ick on the RIP Fi les group to see a l ist  of al l  .rip fi les that were col lected during the test.  

Running a Test  

Running a load test  

When you have a load test properly set up, you can start  the test by cl icking Run  from the toolbar or by 
choosing Run>Start  Test  from the menu. 

Tip: While a test is running, the Conductor's interface changes to provide you with real-time test options.  

Running a Series of Tests 

You can also run a series of tests — a batch test. A batch test is comprised of mult iple session ID fi les. 
When you run a batch test, the session fi les are executed sequential ly unt i l  al l  of them are executed. The 
Conductor al lows you to run mult iple batch tests without operator in tervent ion.  
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Checking out  virtual user licenses 

If you are l icensed to run mult iple copies of the Conductor, for example so different work groups have 
access to QALoad, you can check out virtual user l icenses before running a load test to ensure that enough 
are avai lable for your test run.  

If you do not choose to check out your l icenses before start ing a test, QALoad wil l  prompt you after you 
start  the test and wil l  at tempt to check out the appropriate number of l icenses. We recommend, though, 
that you check your l icenses out manually before start ing so you can be sure you have enough virtual users 
avai lable before beginning your test run. 

To check  out  vi r t ual  user  l icenses: 

1. From the Conductor menu, select Tools>Licensing. The License Information dialog box opens.  

 If you are l icensed for concurrent l icensing (mult iple Conductors) the Conductor wi l l  
query your l icense server to determine how many l icenses are current ly avai lable, and 
return the results to th is dialog box. Go to step 2. 

 If you have a node-locked l icense (a single Conductor), then most of the opt ions on 
th is dialog box wil l  be unavai lable, as you wil l  not need to, or be able to, check out 
virtual user l icenses. Al l  virtual users for which you are l icensed wil l  be avai lable to only 
th is Conductor. Cl ick Close to return to your test setup. 

2. In the Licensing Operations area, type how many virtual user licenses you want to check out in the Number of 
Licenses field. 

3. Click Check Out. The licenses will be checked out to your Conductor, and unavailable to any other Conductor 
workstations on the network. 

When you are done using your l icensed virtual users, check them back in  so they are once again avai lable 
to other Conductor workstat ions on your network. 

To check  in  vi r t ual  user  l icenses: 

1. From the Conductor menu, choose Tools>Licensing. The License Information dialog box opens.  

2. If you have licenses checked out, the Check in Virtual User License option is automatically selected for you. 

3. Click Check In. The licenses will be made available to other Conductor workstations on the network. 

Start ing a test  

Click Run  or choose Start  Test  from the Conductor’s Run menu. 

Note: While a test is running, the toolbar changes to display the Runtime Toolbar buttons.  

Start ing the Conductor from the command line 

To start  the Conductor from the command l ine, type: 

mpwin32 <sessionID_file_name> /l /e /a /t  

Note: You must have a complete session fi le before the test can start . For example, you must specify 
either a set number of t ransact ions or a test durat ion. A transact ion count or a test durat ion of 0 is not 
val id. 

Val id startup parameters are: 
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Param eter Descript i on  

/1 
(Opt ional) 

Creates a log fi le showing error messages and test status. 

/e 
(Opt ional) 

Exits the Conductor when the test completes. 

/a 
(Optional) 

Launches Analyze when the test completes. 

/t 
(Opt ional) 

Executes the Conductor at a set t ime or a set date and 
t ime. Time can be specified by either 12-hour or 24-hour 
format. The fol lowing examples of the /t parameter 
demonstrate each scenario. 

Com m and Resul t  

/t"03:30:00 pm" Starts the Conductor at 
3:30PM today. 

/t06:00:00 Starts the Conductor at 
6:00AM today. 

/t"12/01/04 03:30:00 
pm" 

Starts the Conductor on 
December 1, 2004 at 
3:30PM. 

/t"12/25/04 14:00:00" Starts the Conductor on 
December 25, 2004 at 
2:00PM. 

 

Dialing up/ down virtual users 
Notes:  

 If you haven't  configured a ramp-up session, you wi l l  not be al lowed to add or suspend virtual 
users while the test is running. For in formation about configuring a ramp-up session, see 
Configuring a ramp-up session. 

 Ramp-up is not supported for a machine assignment entry that is using a player group. 

When your test is running, the bottom of the Test In formation window turns in to the dockable Runtime 
Control Panel, a port ion of which is shown below: 

 

If you cl ick on a Player or script  icon in  the test 's tree-view, the Runtime Control Panel wi l l  indicate how 
many virtual users are current ly running on the selected Player machine or script . You can change the 
number of running virtual users per script  or per Player by select ing the appropriate script  or Player 
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machine in  the tree-view, and then typing a new number in  the Running field (or by using the dial 
control).  

To dial  up  or  dow n (add or  subt ract )  vi r t ual  users dur ing  a t est : 

1. When your test is running, click on the script or Player workstation in the Runtime Window's tree-view for which you 
want to add or subtract virtual users. The Running column in the top pane shows how many virtual users are 
currently running on that script or Player. 

2. In the Runtime Control Panel, type a new number in the Running field or drag the dial control to change the number. 

3. When you are done, click the Apply button. The Conductor will release or suspend the specified number of virtual 
users. 

Your change do not take effect unt i l  you cl ick the Apply  button. 

 

Increase/ decrease runt ime t iming updates 

While a test is running, you can change the frequency at which t im ing updates are sent from the Players to 
the Conductor. Decreasing the update in terval wi l l  reduce the amount of overhead incurred in  large load 
tests due to the communicat ions between the Conductor and large numbers of virtual users.  

On the Runtime Control Panel (bottom pane), choose from the fol lowing opt ions: 

No Updates: Choose th is opt ion to stop sending t im ing data while the test is running. Data wil l  st i l l  be 
col lected at the end of the test. 

Send Al l : Choose th is opt ion to send al l  t im ing data as i t  is compiled. 

Periodic Updates: Choose th is opt ion to specify a t ime interval for sending updates, then type the t ime 
interval (in  seconds) below. 

Any change takes effect immediately, and appl ies to al l  scripts in  the test.  

Manually Abort ing a Test  

To manually abort  a test (stop script  execut ion for al l  workstat ions), cl ick on the Abort  toolbar button .  

Remove used datapool records after a test  

You can remove used datapool records after a test by sett ing the Strip Datapool funct ion before you run the 
test. Use th is funct ion when running a test where you have data in  the external datapool which can only 
be used once by one virtual user at a t ime. (For example, when running transact ions that have unique data 
constraints.) When act ivated, the Strip Datapool funct ion wil l  mark each piece of data in  the datapool that 
is used during your test. When the test is over, the Strip Datapool funct ion prompts you to remove the 
ident i fied used data from the datapool. If you run the test again, only new data wi l l  be used for your 
subsequent test. 

To use t he St r ip  Dat apool  f unct ion: 

1. With the current test's session ID file open in the Conductor, select the Script Assignment tab. 

2. Click the External Data button. The External Data dialog box appears. 

3. In the Central Datapool area, select the Strip check box. Click OK. 
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4. At the end of your test, a Strip Datapools prompt will appear asking if you wish to go to the Strip Datapools screen. 
Click Yes. 

5. The Strip Data Pool dialog box appears. Click the Strip button. 

6. When you are finished, click Done.  

Running a Series of Tests (Batch) 

Running a batch test  
1. Select Run>Batch Test. 

2. Add the required session ID files to the Batch List using Add or Load. 

3. Click Start to initiate the batch. 

The Conductor then executes each of the session ID fi les in  sequence.  

Terminat ing a batch test  

You can stop a batch of tests the same way you would stop a single session test, by cl icking the Abort  or 

Ex i t  toolbar buttons.  

Monitoring a Running Test  

Watching a script  execute 

Use the Debug window in  the Detai ls view of the runt ime Conductor to view the execut ing script . Note 
that i t  is possible that you won't  see the execut ion of every statement, in  order to min imize network traffic 
between the Conductor and the Players. The QALOAD.INI fi le’s debug messages-per-sec parameter 
determines how frequent ly the Player sends i ts script  debug status to the Conductor. At i ts default  value of 
one message per second, the Player can execute several statements without sending a debug message to the 
Conductor. 

To open the Debug window, select a workstat ion in  the global control window and cl ick the Debug 
toolbar button.  

Note: The Conductor highlights the script line that it is currently executing.  

 

Viewing datapool usage 

Highl ight a script  in  the global control window and cl ick Datapool  to open the Datapool window. As 
the script  executes Get_Data commands, the Datapool window reflects the current datapool record being 
used by the script .  

 

Graphing checkpoints 

Use the Graphs view of the runt ime Conductor to create real-t ime graphs of checkpoint response t imes 
during script  execut ion. Similar graphs are also avai lable for post-test analysis in  QALoad Analyze. 
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Selecting checkpoints to graph 

Before you can review checkpoint response t imes in graph form, you must select the checkpoint counters 
to include. Checkpoints are l isted in  the tree view on the left  side of the Graphs view of the runt ime 
Conductor, as shown in the example below. Both automatic and user-defined checkpoints appear in  the 
Respon se Tim es folder of each running script . 

 

Creating a graph of checkpoint response times 

To choose a checkpoint that should appear in  a graph, h ighl ight the checkpoint name, right-cl ick and 
choose either Add Graph  to create a new graph or Add Plot  To to add a data plot to an exist ing graph.  

If you choose the Add Graph  opt ion, the Add Graph  dialog box appears. Select the opt ions for how the 
graph should appear and cl ick OK. 

To better ident i fy problem checkpoints, you can set thresholds on plots or graphs that indicate the number 
of t imes the data record for that checkpoint has gone above or below the number you set. Thresholds can 
be set from the Advanced tab of the Add Graph  dialog box or by right-cl icking on an exist ing graph and 
choosing Thresholds. 

Highlighting individual plots 

If you create several plots on a single graph, i t  may become difficult  to see individual plots. To increase a 
plot 's visibi l i ty, cl ick on a plot in  the graph or a plot 's number in  the graph's legend. When highl ighted, 
the plot appears th icker and darker on the graph. 

Saving checkpoint graphs to a session ID 

Checkpoint graphs that are created in  the Conductor are automatical ly saved to the current session ID fi le. 
To remove al l  graphs you added, cl ick Graph>Restore Defaul t  Graph  Layout . 

Graphing counter data 

Use the Graphs view of the runt ime Conductor to create real-t ime graphs of counter data during script  
execut ion. Similar graphs are also avai lable for post-test analysis in  QALoad Analyze.  

Selecting counters to graph 

All counter data that is avai lable for graphing is located in  the tree view on the left  side of the of the 
Graphs view Data window, as shown below.  
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Scripts of any middleware type col lect the fol lowing default  counter data, which is avai lable in  the 
Conductor for real-t ime graphing: 

!  Global counters: Running VU%, total running VUs, and errors 

!  Script counters: Running VUs, response times, and transactions 

!  Player machine health: % processor, % memory used, % disk space, %disk time, % paging file 

Addit ional middleware-based graphs are also generated by default  and vary by middleware. For example, 
for the WWW middleware, several performance-based counters are automatical ly col lected and avai lable 
for graphing, including server responses and WWW traffic. You can monitor th is data to determine the 
opt imum rate of performance of the appl icat ion that is running. 

Graphing counter statistics 

To choose a counter that should appear in  a graph, h ighl ight the checkpoint counter name or group of 
counters (folder), right-cl ick and choose either Add Graph  to create a new graph or Add Plot  To to add a 
data plot to an exist ing graph. 

If you choose the Add Graph  opt ion, the Add Graph  dialog box appears. Select the opt ions for how the 
graph should appear and cl ick OK. 

To better ident i fy problems in the test, you can set thresholds on plots or graphs that indicate the number 
of t imes the data record for that counter has gone above or below the number you set. Thresholds can be 
set from the Advanced tab of the Add Graph  dialog box or by right-cl icking on an exist ing graph and 
choosing Thresholds.  

Highlighting individual plots 

If you create several plots on a single graph, i t  may become difficult  to see individual plots. To increase a 
plot 's visibi l i ty, cl ick on a plot in  the graph or a plot 's number in  the graph's legend. When highl ighted, 
the plot appears th icker and darker on the graph. 

Saving counter data graphs to a session ID 

Counter data graphs that are created in  the Conductor are automatical ly saved to the current session ID 
fi le. To remove al l  graphs you added, cl ick Graph >Restore Defaul t  Graph  Layout . 
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Recording and Playing a Test  

Recording and replay overview 

As a load test is running, the Conductor records each event in  a .REC fi le. After the load test completes, 
you can open the .REC fi le to replay the load test and evaluate important events that occurred, such as a 
sudden increase in processor usage.    

When you replay the load test, the playback looks ident ical to the actual load test, with the except ion of 
the playback toolbar, which appears at the top of the screen.  When you open the .REC replay fi le in  the 
Conductor, you can replay, fast-forward, double fast-forward, or pause.  

Notes: The replay feature provides a visual re-enactment of the load test; it does not perform the actual 
test or connect to any servers. 
You can only play a .REC file created in the same version as the QALoad Conductor on which it will play. For 
example, a .REC file created in QALoad 5.02 can only be played using a QALoad Conductor from the 5.02 
release. 

 

Recording a test  

Load tests can be recorded by select ing the Record Load Test  opt ion from the Conductor. When th is 
opt ion is act ivated and the load test begins, a prompt appears for you to specify a fi le name for the 
recording. When the load test is completed, you can replay the test. 

To set  t he Conduct or  t o r ecord a load t est : 

1. On the Test Information tab of the Conductor's main window, select the Enable Test Recording check box.  

2. Start the load test. The Record dialog box appears. 

3. Type a name for the record file. Click OK. 

 

Replaying a test  

If you set the Conductor to record load tests, you can play them back after the test completes. Replaying a 
recorded load test does not perform the actual load test. A replay provides a visual re-enactment of the 
events that took place during the load test.  

To replay a r ecorded load t est : 

1. From the Conductor's Run menu, choose Test Recording>Replay a Load Test. The Open Record File dialog box 
appears. 

2. Browse for the recording file (filename.rec) that you saved when the load test started. Click Open. 

3. The test will play back in a viewer that contains a playback toolbar. Use the toolbar buttons described in the following 
table to control the playback. 

But ton  Act ion  

 
Restarts the test replay from the 
beginning 
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 Replays the test at normal  speed 

 
Replays the test twice as fast as 
normal 

 
Replays the test four t imes as fast as 
normal 

 
Pauses the replay at the current 
snapshot 

 
Exits test replay and opens the 
Conductor test setup window 

 

Note: Test control features such as dial-up/dial-down do not work during test replay, but the effects from 
these features can be observed in the replay. Also, virtual user error details on the Virtual User Info window are 
not available during replay. Detailed error information is available in the timing file and can be viewed with 
Analyze. 

 

Expert  User 

Overview of Expert  User 

Expert User provides an easy, logical guide for dri l l ing down to the root performance problems for 
appl icat ions. It  enables you to break web pages down into their individual components, providing more 
detai led response t ime data. Response t ime for each component is broken into network sand server t ime.  

More detai led in formation helps troubleshoot appl icat ion performance problems. The abi l i ty to see t im ing 
fi les on a component level can spot l ight where the majori ty of t ime is being spent. A breakdown of 
network and server t imes per component can ident i fy areas for improvement in  either the network or 
server hardware or configurat ion, or in  appl icat ion performance. 

The main funct ional i ty is provided by a special virtual user (VU). When you enable the Expert User, th is 
VU col lects more detai led in formation about requests that are made while the script  is running. Every 
main request and subrequest logs the amount of server and network t ime used. This helps diagnose why 
page loads may be taking longer than expected. For example, a part icular subrequest, such as css, gif, h tml, 
and so forth, may be taking more t ime to download from the server than other requests. Expert  User data 
can show you th is. It  also can help you determine whether the problem is a network or a server problem.   

You enable Expert  User from the Conductor, ei ther before or during a load test. Expert  User uses the 
exist ing custom counter support so Conductor can graph the custom counter in formation. 

Once the load test is complete, you can view the data in  Analyze. The Analyze Workspace includes an 
Expert User tab, from which you can access detai l  reports and graphs on server and network data. The pre-
defined reports include an Expert User report .  

Note: Currently, Expert User capability is provided only for the WWW middleware. 
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Enabling Expert  User   

You can enable or disable the Expert  User for each load test on a script , ei ther before or during the load 
test.  

To enable Exper t  User  bef ore t he load t est  begins: 

1. In Conductor, click the Machine Assignment tab.  

2. Click in the Middleware column to enable the Browse (...) button. Then, click Browse. The Expert User Options 
dialog box displays. 

3. Click Enable Expert User timings. 

4. Type the Virtual User (VU) number to represent the Expert User. The default VU number is zero (0). 

5. Click OK. 

To enable Exper t  User  dur ing t he load t est : 

1. Select the script and any options for the test. 

2. From the Machine Assignment tab, and click the Run button, or click Run>Start Test. The Test begins and the 
Test menus display. 

3. Click Test Options>Expert User Options. The Update Expert User Options dialog box displays listing all the 
scripts that support Expert User counters. 

4. Click the scripts in which you want to enable Expert User, then click OK. 

Analyzing Load Test  Data 

Analyzing load test  data 

By default , load test t im ing data is sent from the Conductor to Analyze at the end of a load test. Any 
appropriate server monitoring data is also sent to Analyze and merged into your t im ing fi le (.t im). 

You can set an opt ion in  the Conductor to automatical ly launch Analyze at the end of a load test (detai ls), 
or you can open Analyze manually from the Conductor toolbar or your QALoad program group. 

Creat ing a t iming file (.t im) 

Once al l  workstat ions stop execut ing, cl ick the Qui t  toolbar button  to complete the test and 
automatical ly create the t im ing fi le (.t im).  

Viewing test  stat ist ics 

Compute test stat ist ics by choosing Launch  An alyze from the Conductor’s Tools menu or by cl icking 
on the Analyze toolbar button.  
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Integrat ion and Server Monitoring 

Integrat ion and Monitoring Requirements 

 

Integration Requirements 

Appl i cat ionVan tage 

QALoad 5.5 supports in tegrat ion with Appl icat ionVantage version 9.8. 

ServerVan tage 

QALoad 5.5 supports in tegrat ion with ServerVantage 9.7 and 9.8. 

Monitoring Requirements 

In  addit ion to the in tegrat ion requirements, your system may need to meet specific requirements to 
support remote monitoring. 

Server An alysi s Agen t  Requi rem en ts 

TCP/IP communicat ions. 

The Server Analysis Agent must be instal led on the same Workstat ion/Server as the QALoad Player and 
therefore shares the same system requirements. 

JVM  Requi rem en ts 

SAP, WebLogic, WebSphere, and WebSphere MQ monitoring al l  require Java Virtual Machine (JVM ) 
instal led on the Conductor machine. 

!  For WebLogic monitoring version 7 and earlier versions, use JVM 1.3. For WebLogic version 8, you must use JVM 
1.4 or later. You may also use the JVM that is distributed with the WebLogic Application Server. 

!  For WebSphere monitoring, use the JVM provided with the WebSphere client or server. 

!  For WebSphere MQ monitoring, you must use JVM 1.4 or later. 

!  For SAP monitoring, you must use JVM 1.4 or later. 

Fi le Instal l at i on  Requi rem en ts 

SAP, WebLogic, WebSphere, and WebSphere MQ monitoring require the fol lowing fi les instal led on the 
Conductor machine. 

!  For SAP monitoring, the SAP files listed below must be placed on the Conductor machine: 

o l ibrfc32.dl l  

o sapjco.jar 

o sapjcorfc 

To obtain these fi les, instal l  the SAP Java Connector package (JCo) on the Conductor machine. The 
JCo package is avai lable from SAP. Add the locat ion of the fi les, to the Path System Variable of the 
Conductor machine. For more in formation, refer to the Requirements for SAP Remot e Moni toring 
topic in  the ServerVantage Reconfigure Agent Online Help. 

!  For WebLogic monitoring, the weblogic.jar file must be placed in the Conductor machine. Copy the jar file from the 
lib directory of the WebLogic application server to a separate directory in the Conductor machine. If you are 
monitoring WebLogic version 8.1, copy the webservices.jar file to the same directory. For more information, refer to 
Requirements for WebLogic Remote Monitoring in the ServerVantage Reconfigure Agent Online Help. 
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!  For WebSphere monitoring, the WebSphere client files must be installed on the Conductor machine. Installing the 
WebSphere Application Server Admin Server software on the Conductor machine provides the necessary client 
files. Note the directory path of the WebSphere\AppServer\Java files. For more information, refer to Requirements 
for WebSphere Remote Monitoring in the ServerVantage Reconfigure Agent Online Help. 

!  For WebSphere MQ monitoring, the WebSphere client files listed below must be placed in a directory in the 
Conductor machine.  

o com.ibm.mq.jar 

o com.ibm.mq.pcf.jar 

o connector.jar 

The fi les may be obtained from the instal lat ion of the W ebSphere Appl icat ion Server Admin Server 
software on the Conductor machine. If the instal lat ion does not include the com.ibm.mq.pcf.jar fi le, 
obtain the fi le from the IBM Support Pac MS0B. See "http:/ /www-
1.ibm.com/support/docview.wss?rs=171& uid=swg24000668& loc=en_US& cs=utf-8& lang=en".  

For more in formation, refer to Conf igur ing W ebSphere MQ for Remote M oni tor ing in  the 
ServerVantage Reconfigure Agent Online Help. 

!  For WMI monitoring, WMI security must be enabled on the monitored server machine and the WMI service must be 
started. For more information, refer to Configuring WMI for Remote Monitoring in the ServerVantage Reconfigure 
Agent Online Help. 

!  For Cold Fusion monitoring, Performance Monitoring must be enabled from the Cold Fusion Administrator Page – 
Debugging Settings of the monitored server machine. Cold Fusion is available under Windows Registry monitoring. 

Host  Veri f i cat ion  for QALoad M on i toring 

!  Ensure host accessibility. Add an entry for the monitored machine to the system hosts file of the Conductor 
machine. Consult the network administrator for more information. 

!  Test host availability. Type the following command at the Run command: ping <moni t or ed machi ne name>. 

Remote Monitoring 

Overview of Remote Monitoring 

Remote M onitoring enables you to extract data from Windows Registry, SAP, SNMP, WebLogic, 
WebSphere, WebSphere MQ, and WMI counters on the servers under stress without instal l ing any software 
on the servers.  

Note: Select counters for monitor types in the application. 

To use Remote M onitoring:  

!  You must have login access to the machines you want to monitor 

!  You must select the servers and counters to monitor on the machines you identify using the monitoring options on 
Conductor's Monitoring Options tab. 

!  To collect SNMP counters, SNMP must be enabled on the Remote Monitor machine. Refer to your operating system 
help for information about enabling SNMP. 

!  To collect Windows registry counters, you must have a valid sign-on for the servers under test.  

!  For requirements for SAP, WebLogic, WebSphere, WebSphere MQ, and WMI, see Integration and Monitoring 
Requirements. 

QALoad uses the default  ports 7790 and 7788 when i t  communicates with the ServerVantage agent and 
cl ient. You can override the default  ports i f your ServerVantage instal lat ion requires i t . 

While your test is running, QALoad col lects the appropriate counter data and writes i t  to your t im ing fi le 
where you can view i t  in  Analyze after the test. What counters are avai lable? 
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You can simpli fy the configurat ion process by creat ing or applying pre-defined monitoring templates. A 
monitoring template is a predefined group of counters not associated with a specific machine.  

To set up Remote Monitoring, see Sett ing up a test session. 

 

Using Counters and Templates 

About  Coun ters 

Using Counters  

Counters are the numeric data values that are col lected when monitoring servers. For Windows, a large 
number of performance counters are provided by the operat ing system registry and Windows server 
appl icat ions. Each resource represents i tems such as individual processes, sect ions of shared memory, or 
physical devices. 

Counters exists for components such as processor, memory, processes, hard disk, and cache, with a set  of 
counters that measure stat ist ical in formation. Registry counters can monitor external components of the 
environment such as databases, appl icat ions, and printers. 

Many of the counters that are col lected are points in  t ime data values, such as Process - Thread Count. 
Some are cumulat ive, such as Server - Errors Logon. Some are averages, such as Job Object Detai ls - Page 
Faults /  Sec.  

In  addit ion to the numeric value counters, a set of extended data counters is provided for a number of key 
performance indicators. These extended data counters can provide in tel l igent data points that have 
associated textual data for the numeric value. For example, the extended CPU usage counter's in tel l igent 
datapoint shows the top 10 processes consuming CPU at that t ime. 

QALoad's Remote Monitor Agents can monitor the fol lowing counter types: 

 Windows Registry counters 

SNMP counters 

SAP counters 

WebLogic counters 

WebSphere counters 

WebSphere MQ counters 

WMI counters 

Instances 

When you select a registry counter from the Avai lable Items l ist  in  the Choose Counters window, the 
avai lable instances for that counter appear. 

Counters can have none or several instances. For example, i f a system has mult iple processors, then the 
counter has mult iple instances as well . For counters with mult iple instances, a l ist  of the avai lable instances 
for that counter is presented. Many counters have a  _Total instance, which is an aggregate of the 
individual instances.  

For the processor counter object, instances are numbered beginning with 0, on a single processor mach ine 
has an instance of _Total and one for 0. If you had a dual-processor machine, you would see instances of 
_Total, 0, and 1. Other instances are based on what is current ly running on the server, and the instance l ist  
displays these for each process name or service name that is act ive. 

Some instances are instan taneous, and represent the most recent value for the resource, e.g., Processes, 
which is the number of processes in  the computer at the t ime of data col lect ion. Others are average values 
between the last two measurements.  
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Windows Server Registry Counters  

Remote M onitoring Agents can monitor the same Windows registry counters as PERFMON, the 
performance monitoring appl icat ion avai lable with  the Windows operat ing system. The Windows registry 
opt ion monitors machines that run Windows 2000 and XP. To retrieve Windows Registry Counters, you 
must have access, via a user name and password, to the remote machine. 

QALoad supports the fol lowing MS Windows counter categories: 

Coun ter Category Descript i on  

ACS/RSVP Service RSVP or ACS service performance counters. 

Act ive Server Pages This object type handles the Act ive Server Pages device on your 
system. 

Browser The Browser performance object consists of counters that measure the 
rates of announcements, enumerat ions, and other Browser 
transmissions. 

Cache The Cache performance object consists of counters that monitor the 
fi le system cache, an area of physical memory that stores recent ly used 
data as long as possible to permit  access to the data without reading 
from the disk. Because appl icat ions typical ly use the cache, the cache 
is monitored as an indicator of appl icat ion I/O operat ions. When 
memory is plent i ful , the cache can grow, but when memory is scarce, 
the cache can become too small  to be effect ive. 

IAS Account ing Clients IAS Account ing Clients 

IAS Account ing Server IAS Account ing Server 

IAS Authent icat ion Clients IAS Authent icat ion Clients 

IAS Authent icat ion Server IAS Authent icat ion Server 

ICMP The ICMP performance object consists of counters that measure the 
rates at which messages are sent and received by using ICMP 
protocols. It  also includes counters that monitor ICMP protocol errors. 

IP The IP performance object consists of counters that measure the rates 
at which IP datagrams are sent and received by using IP protocols. It  
also includes counters that monitor IP protocol errors. 

LogicalDisk The Logical Disk performance object consists of counters that monitor 
logical part i t ions of a hard or fixed disk drives. Performance M onitor 
ident i fies logical disks by their a drive let ter, such as C. 

Memory The Memory performance object consists of counters that describe the 
behavior of physical and virtual memory on the computer. Physical 
memory is the amount of random access memory on the computer.. 
Virtual memory consists of the space in physical memory and on disk. 
Many of the memory counters monitor paging, which is the 
movement of pages of code and data between disk and physical 
memory. Excessive paging, a symptom of a memory shortage, can 
cause delays which in terfere with al l  system processes. 

NBT Connect ion The NBT Connect ion performance object consists of counters that 
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measure the rates at which bytes are sent and received over the NBT 
connect ion between the local computer and a remote computer. The 
connect ion is ident i fied by the name of the remote computer. 

Network Interface The Network Interface performance object consists of counters that 
measure the rates at which bytes and packets are sent and received 
over a TCP/IP network connect ion. It  includes counters that monitor 
connect ion errors. 

Objects The Object performance object consists of counters that monitor 
logical objects in  the system, such as processes, threads, mutexes, and 
semaphores.. This in formation can be used to detect the unnecessary 
consumption of computer resources. Each object requires memory to 
store basic in formation about the object. 

Paging Fi le The Paging Fi le performance object consists of counters that monitor 
the paging fi le(s) on the computer. The paging fi le is a reserved space 
on disk that backs up committed physical memory on the computer. 

PhysicalDisk The Physical Disk performance object consists of counters that 
monitor hard or fixed disk drive on a computer. Disks are used to store 
fi le, program, and paging data and are read to retrieve these i tems, and 
writ ten to record changes to them. The values of physical disk 
counters are sums of the values of the logical disks (or part i t ions) in to 
which they are divided. 

Print  Queue Displays performance stat ist ics about a Print Queue. 

Process The Process performance object consists of counters that monitor 
running appl icat ion program and system processes. Al l  the threads in  
a process share the same address space and have access to the same 
data. 

Process Address Space The Process Address Space performance object consists of counters 
that monitor memory al locat ion and use for a selected process. 

Processor The Processor performance object consists of counters that measure 
aspects of processor act ivi ty The processor is the part  of the computer 
that performs ari thmetic and logical computat ions, in i t iates 
operat ions on peripherals, and runs the threads of processes. A 
computer can have mult iple processors. The processor object 
represents each processor as an instance of the object. 

Redirector The Redirector performance object consists of counter that monitor 
network connect ions originat ing at the local computer. 

Server The Server performance object consists of counters that measure 
communicat ion between the local computer and the network. 

Server Work Queues The Server Work Queues performance object consists of counters that 
monitor the length of the queues and objects in  the queues. 

SMTP NTFS Store Driver This object represents global counters for the Exchange NTFS Store 
driver. 

SMTP Server The counters specific to the SMTP Server. 
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System The System performance object consists of counters that apply to 
more than one instance of a component processors on the computer. 

TCP The TCP performance object consists of counters that measure the 
rates at which TCP Segments are sent and received by using the TCP 
protocol. It  includes counters that monitor the number of TCP 
connect ions in  each TCP connect ion state. 

Telephony The Telephony System. 

Thread The Thread performance object consists of counters that measure 
aspects of thread behavior. A thread is the basic object that executes 
instruct ions on a processor. Al l  running processes have at least one 
thread. 

UDP The UDP performance object consists of counters that measure the 
rates at which UDP datagrams are sent and received by using the UDP 
protocol. It  includes counters that monitor UDP protocol errors. 

 

ACS RSVP Service Counters 

QALoad supports the ACS RSVP Service category for Windows. This object type handles these registry 
counters: 

API not i ficat ions Interfaces 

API sockets Network sockets 

Bytes in  API not i fies PATH from API 

Fai led API requests RESV from API 

Fai led API sends RSVP msg buffers in  use 

GQOS sessions Timers 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Active Server Pages Counters 

QALoad supports the Act ive Server Pages category for Windows. This object type handles these registry 
counters: 

Debugging Requests Requests Succeeded 

Errors/Sec Requests Timed Out 

Errors During Script Runt ime Requests Total 
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Errors From ASP Preprocessor Script  Engines Cached 

Errors From Script Compilers Session Durat ion 

Request Bytes In Total Sessions Current 

Request Bytes Out Total Sessions Timed Out 

Request Execut ion Time Sessions Total 

Request Wait  Time Template Cache Hit  Rate 

Requests/Sec Template Noti ficat ions 

Requests Disconnected Templates Cached 

Requests Execut ing Transact ions/Sec 

Requests Fai led Total Transact ions Aborted 

Requests Not Authorized Transact ions Committed 

Requests Not Found Transact ions Pending 

Requests Queued Transact ions Total 

Requests Rejected  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Browser Counters 

QALoad supports the Browser category for Windows. This object type handles these registry counters: 

Announcements Domain/sec Mailslot  Al locat ions Fai led 

Announcements Server/sec Mailslot  Opens Fai led/sec 

Announcements Total/sec Mailslot  Receives Fai led 

Duplicate Master Announcements Mailslot  Writes/sec 

Elect ion Packets/sec Mailslot  Writes Fai led 

Enumerat ions Domain/sec M issed Mailslot  Datagrams 

Enumerat ions Other/sec M issed Server Announcements 

Enumerat ions Server/sec M issed Server List  Requests 

Enumerat ions Total/sec Server Announce Al locat ions Fai led/sec 
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Il legal Datagrams/sec Server List  Requests/sec 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Cache Win2K Counters  

QALoad supports the Cache category for Windows. This object type handles these registry counters: 

Async Copy Reads/sec Fast Reads/sec 

Async Data Maps/sec Lazy Write Flushes/sec 

Async Fast Reads/sec Lazy Write Pages/sec 

Async MDL Reads/sec MDL Read Hits % 

Async Pin Reads/sec MDL Reads/sec 

Copy Read Hits % Pin Read Hits % 

Copy Reads/sec Pin Reads/sec 

Data Flush Pages/sec Read Aheads/sec 

Data Flushes/sec Sync Copy Reads/sec 

Data M ap Hits % Sync Data Maps/sec 

Data M ap Pins/sec Sync Fast Reads/sec 

Data M aps/sec Sync MDL Reads/sec 

Fast Read Not Possibles/sec Sync Pin Reads/sec 

Fast Read Resource M isses/sec  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

IAS Accounting Clients Counters 

QALoad supports the IAS Account ing Clients category for Windows. This object type handles these registry 
counters: 

Account ing-Requests Malformed Packets 
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Accounting-Requests/sec Malformed Packets/sec 

Account ing-Responses No Record 

Account ing-Responses/sec No Record/sec 

Bad Authent icators Packets Received 

Bad Authent icators/sec Packets Received/sec 

Dropped Packets Packets Sent 

Dropped Packets/sec Packets Sent/sec 

Duplicate Account ing-Requests Unknown Type 

Duplicate Account ing-Requests/sec Unknown Type/sec 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

IAS Accounting Server Counters 

QALoad supports the IAS Account ing Server category for Windows. This object type handles these regist ry 
counters: 

Account ing-Requests Malformed Packets 

Account ing-Requests/sec Malformed Packets/sec 

Account ing-Responses No Record 

Account ing-Responses/sec No Record/sec 

Bad Authent icators Packets Received 

Bad Authent icators/sec Packets Received/sec 

Dropped Packets Packets Sent 

Dropped Packets/sec Packets Sent/sec 

Duplicate Account ing-Requests Server Reset Time 

Duplicate Account ing-Requests/sec Server Up Time 

Inval id Requests Unknown Type 

Inval id Requests/sec Unknown Type/sec 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  
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IAS Authentication Clients Win2K Counters  

QALoad supports the IAS Authent icat ion Clients category for Windows. This object type handles these 
registry counters: 

Access-Accepts Dropped Packets/sec 

Access-Accepts/sec Duplicate Access-Requests 

Access-Challenges Duplicate Access-Requests/sec 

Access-Challenges/sec Malformed Packets 

Access-Rejects Malformed Packets/sec 

Access-Rejects/sec Packets Received 

Access-Requests Packets Received/sec 

Access-Requests/sec Packets Sent 

Bad Authent icators Packets Sent/sec 

Bad Authent icators/sec Unknown Type 

Dropped Packets Unknown Type/sec 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

IAS Authentication Server Counters 

QALoad supports the IAS Authent icat ion Server category for Windows. This object type handles these 
registry counters: 

Access-Accepts Duplicate Access-Requests/sec 

Access-Accepts/sec Inval id Requests 

Access-Challenges Inval id Requests/sec 

Access-Challenges/sec Malformed Packets 

Access-Rejects Malformed Packets/sec 

Access-Rejects/sec Packets Received 

Access-Requests Packets Received/sec 

Access-Requests/sec Packets Sent 

Bad Authent icators Packets Sent/sec 
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Bad Authent icators/sec Server Reset Time 

Dropped Packets Server Up Time 

Dropped Packets/sec Unknown Type 

Duplicate Access-Requests Unknown Type/sec 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

ICMP Counters 

QALoad supports the ICM P category for Windows. This object type handles these registry counters: 

Messages/sec Received Timestamp/sec 

Messages Outbound Errors Received Timestamp Reply/sec 

Messages Received/sec Sent Address Mask 

Messages Received Errors Sent Address Mask Reply 

Messages Sent/sec Sent Dest inat ion Unreachable 

Received Address M ask Sent Echo/sec 

Received Address M ask Reply Sent Echo Reply/sec 

Received Dest. Unreachable Sent Parameter Problem 

Received Echo/sec Sent Redirect /sec 

Received Echo Reply/sec Sent Source Quench 

Received Parameter Problem Sent Time Exceeded 

Received Redirect/sec Sent Timestamp/sec 

Received Source Quench Sent Timestamp Reply/sec 

Received Time Exceeded  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

IP Counters 

QALoad supports the IP category for Windows. This object type handles these registry counters: 
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Datagrams/sec Datagrams Received Unknown Protocol 

Datagrams Forwarded/sec Datagrams Sent/sec 

Datagrams Outbound Discarded Fragment Re-assembly Fai lures 

Datagrams Outbound No Route Fragmentat ion Fai lures 

Datagrams Received/sec Fragmented Datagrams/sec 

Datagrams Received Address Errors Fragments Created/sec 

Datagrams Received Delivered/sec Fragments Re-assembled/sec 

Datagrams Received Discarded Fragments Received/sec 

Datagrams Received Header Errors  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

LogicalDisk Counters 

QALoad supports the LogicalDisk category for Windows. This object type handles these registry counters: 

% Disk Read Time Avg. Disk sec/Write 

% Disk Time Avg. Disk Write Queue Length 

% Disk Write Time Current Disk Queue Length 

% Free Space Disk Bytes/sec 

% Idle Time Disk Read Bytes/sec 

Avg. Disk Bytes/Read Disk Reads/sec 

Avg. Disk Bytes/Transfer Disk Transfers/sec 

Avg. Disk Bytes/Write Disk Write Bytes/sec 

Avg. Disk Queue Length Disk Writes/sec 

Avg. Disk Read Queue Length Free Megabytes 

Avg. Disk sec/Read Spl i t  IO/Sec 

Avg. Disk sec/Transfer  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  
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Memory Counters 

QALoad supports the Memory category for Windows. This object type handles these registry counters: 

% Committed Bytes In Use Pool Nonpaged Al locs 

Avai lable Bytes Pool Nonpaged Bytes 

Cache Bytes Pool Paged Al locs 

Cache Bytes Peak Pool Paged Bytes 

Cache Faults/sec Pool Paged Resident Bytes 

Commit Limit  System Cache Resident Bytes 

Committed Bytes System Code Resident Bytes 

Demand Zero Faults/sec System Code Total Bytes 

Free System Page Table Entries System Driver Resident Bytes 

Page Faults/sec System Driver Total Bytes 

Page Reads/sec System VLM Commit Charge 

Page Writes/sec System VLM Commit Charge Peak 

Pages/sec System VLM Shared Commit Charge 

Pages Input/sec Transit ion Faults/sec 

Pages Output/sec Write Copies/sec 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

NBT Connection Counters 

QALoad supports the NBT Connect ion category for Windows. This object type handles these registry 
counters: 

Bytes Received/sec Bytes Total/sec 

Bytes Sent/sec  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Network Interface Counters 
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QALoad supports the Network Interface category for Windows. This object type handles these registry 
counters: 

Bytes Received/sec Packets Received Discarded 

Bytes Sent/sec Packets Received Errors 

Bytes Total/sec Packets Received Non-Unicast/sec 

Current Bandwidth Packets Received Unicast/sec 

Output Queue Length Packets Received Unknown 

Packets/sec Packets Sent/sec 

Packets Outbound Discarded Packets Sent Non-Unicast/sec 

Packets Outbound Errors Packets Sent Unicast/sec 

Packets Received/sec  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Objects Counters 

QALoad supports the Objects category for Windows. This object type handles these registry counters: 

Events Sect ions 

Mutexes Semaphores 

Processes Threads 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Paging File Counters 

QALoad supports the Paging Fi le category for Windows. This object type handles these registry counters: 

% Usage % Usage Peak 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  
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PhysicalDisk Counters 

QALoad supports the PhysicalDisk category for Windows. This object type handles these registry counters: 

% Disk Read Time Avg. Disk sec/Write 

% Disk Time Avg. Disk Write Queue Length 

% Disk Write Time Current Disk Queue Length 

% Idle Time Disk Bytes/sec 

Avg. Disk Bytes/Read Disk Read Bytes/sec 

Avg. Disk Bytes/Transfer Disk Reads/sec 

Avg. Disk Bytes/Write Disk Transfers/sec 

Avg. Disk Queue Length Disk Write Bytes/sec 

Avg. Disk Read Queue Length Disk Writes/sec 

Avg. Disk sec/Read Spl i t  IO/Sec 

Avg. Disk sec/Transfer  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Print Queue Counters 

QALoad supports the Print Queue category for Windows. This object type handles these registry counters: 

Add Network Printer Cal ls Max References 

Bytes Printed/sec Not Ready Errors 

Enumerate Network Printer Cal ls Out of Paper Errors 

Job Errors References 

Jobs Total Jobs Printed 

Jobs Spooling  Total Pages Printed 

Max Jobs Spooling  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

Process Address Space Counters 
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QALoad supports the Process Address Space category for Windows. This object  type handles these registry 
counters: 

Bytes Free Mapped Space Read Only 

Bytes Image Free Mapped Space Write Copy 

Bytes Image Reserved Reserved Space Exec Read/Write 

Bytes Reserved Reserved Space Exec Read Only 

ID Process Reserved Space Exec Write Copy 

Image Space Exec Read/Write Reserved Space Executable 

Image Space Exec Read Only Reserved Space No Access 

Image Space Exec Write Copy Reserved Space Read/Write 

Image Space Executable Reserved Space Read Only 

Image Space No Access Reserved Space Write Copy 

Image Space Read/Write Unassigned Space Exec Read/Write 

Image Space Read Only Unassigned Space Exec Read Only 

Image Space Write Copy Unassigned Space Exec Write Copy 

Mapped Space Exec Read/Write Unassigned Space Executable 

Mapped Space Exec Read Only Unassigned Space No Access 

Mapped Space Exec Write Copy Unassigned Space Read/Write 

Mapped Space Executable Unassigned Space Read Only 

Mapped Space No Access Unassigned Space Write Copy 

Mapped Space Read/Write  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Process Counters 

QALoad supports the Process category for Windows. This object type handles these registry counters: 

% Privi leged Time IO Write Operat ions/sec 

% Processor Time   (See Note below.) Page Faults/sec 

% User Time Page Fi le Bytes 
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Creat ing Process ID Page Fi le Bytes Peak 

Elapsed Time Pool Nonpaged Bytes 

Handle Count Pool Paged Bytes 

ID Process Priori ty Base 

IO Data Bytes/sec Private Bytes 

IO Data Operat ions/sec Thread Count 

IO Other Bytes/sec Virtual Bytes 

IO Other Operat ions/sec Virtual Bytes Peak 

IO Read Bytes/sec Working Set 

IO Read Operat ions/sec Working Set Peak 

IO Write Bytes/sec  

Note:   If you use the % Processor Time counter in  an event rule, set the event  rule to trigger after two or 
more occurrences of the event. The CPU consumption for the first  datapoint sample  is art i ficial ly h igh 
because the agent is start ing the task. 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Processor Counters 

QALoad supports the Processor category for Windows. This object type handles these registry counters: 

% DPC Time APC Bypasses/sec 

% Interrupt Time DPC Bypasses/sec 

% Privi leged Time DPC Rate 

% Processor Time DPCs Queued/sec 

% User Time Interrupts/sec 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Redirector Counters 

QALoad supports the Redirector category for Windows. This object type handles these registry counters: 
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Bytes Received/sec Read Operat ions Random/sec 

Bytes Total/sec Read Packets/sec 

Bytes Transmitted/sec Read Packets Small /sec 

Connects Core Reads Denied/sec 

Connects Lan Manager 2.0 Reads Large/sec 

Connects Lan Manager 2.1 Server Disconnects 

Connects Windows NT Server Reconnects 

Current Commands Server Sessions 

Fi le Data Operat ions/sec Server Sessions Hung 

Fi le Read Operat ions/sec  Write Bytes Cache/sec 

Fi le Write Operat ions/sec Write Bytes Network/sec 

Network Errors/sec Write Bytes Non-Paging/sec 

Packets/sec  Write Bytes Paging/sec 

Packets Received/sec Write Operat ions Random/sec 

Packets Transmitted/sec Write Packets/sec 

Read Bytes Cache/sec Write Packets Small /sec 

Read Bytes Network/sec Writes Denied/sec 

Read Bytes Non-Paging/sec Writes Large/sec 

Read Bytes Paging/sec  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Server Counters 

QALoad supports the Server category for Windows. This object type handles these registry counters: 

Blocking Requests Rejected Logon Total 

Bytes Received/sec Pool Nonpaged Bytes 

Bytes Total/sec Pool Nonpaged Fai lures 

Bytes Transmitted/sec Pool Nonpaged Peak 

Context Blocks Queued/sec Pool Paged Bytes 
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Errors Access Permissions Pool Paged Fai lures 

Errors Granted Access Pool Paged Peak 

Errors Logon Server Sessions 

Errors System Sessions Errored Out 

Fi le Directory Searches Sessions Forced Off 

Fi les Open Sessions Logged Off 

Fi les Opened Total Sessions Timed Out 

Logon/sec Work Item Shortages 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.   

 

Server Work Queues Counters 

QALoad supports the Server Work Queues category for Windows. This object type handles these registry 
counters: 

Act ive Threads Queue Length 

Avai lable Threads Read Bytes/sec 

Avai lable Work Items Read Operat ions/sec 

Borrowed Work Items Total Bytes/sec 

Bytes Received/sec Total Operat ions/sec 

Bytes Sent/sec Work Item Shortages 

Bytes Transferred/sec Write Bytes/sec 

Context Blocks Queued/sec Write Operat ions/sec 

Current Cl ients  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

SMTP NTFS Store Drive Counters 

QALoad supports the SMTP NTFS Store Drive category for Windows. This object type handles these registry 
counters: 
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Messages al located Messages in the queue directory 

Messages deleted Open message bodies 

Messages enumerated Open message streams 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

SMTP Server Counters 

QALoad supports the SMTP Server category for Windows. This object type handles these registry counters: 

% Recipients Local Local Retry Queue Length 

% Recipients Remote Message Bytes Received/sec 

Avg Recipients/msg Received Message Bytes Received Total 

Avg Recipients/msg Sent Message Bytes Sent/sec 

Avg Retries/msg Delivered Message Bytes Sent Total 

Avg Retries/msg Sent Message Bytes Total 

Badmailed Messages (Bad Pickup Fi le) Message Bytes Total/sec 

Badmailed Messages (General Fai lure) Message Delivery Retries 

Badmailed Messages (Hop Count 
Exceeded) 

Message Received/sec 

Badmailed Messages (NDR of DSN) Message Send Retries 

Badmailed Messages (No Recipients) Messages Current ly Undel iverable 

Badmailed Messages (Triggered via Event) Messages Delivered/sec 

Base % Recipients Local Messages Delivered Total 

Base % Recipients Remote Messages Pending Routing 

Base Avg Recipients/msg Received Messages Received Total 

Base Avg Recipients/msg Sent Messages Refused for Address Objects 

Base Avg Retries/msg Delivered Messages Refused for M ail  Objects 

Base Avg Retries/msg Sent Messages Refused for Size 

Bytes Received/sec Messages Sent/sec 

Bytes Received Total Messages Sent Total 
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Bytes Sent Total NDRs Generated 

Bytes Sent/sec Number of MailFi les Open 

Bytes Total Number of QueueFiles Open 

Bytes Total/sec Outbound Connect ions Current 

Categorizer Queue Length Outbound Connect ions Refused 

Connect ion Errors/sec Outbound Connect ions Total 

Current Messages in Local  Del ivery Pickup Directory M essages Retrieved/sec 

Directory Drops/sec Pickup Directory M essages Retrieved Total 

Directory Drops Total Remote Queue Length 

DNS Queries/sec Remote Retry Queue Length 

DNS Queries Total Rout ing Table Lookups/sec 

ETRN Messages/sec Routing Table Lookups Total 

ETRN Messages Total Total Connect ion Errors 

Inbound Connect ions Current Total DSN Fai lures 

Inbound Connect ions Total Total messages submitted 

Local Queue Length  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

System Counters 

QALoad supports the System category for Windows. This object type handles these registry counters: 

% Registry Quota In Use Fi le Write Bytes/sec 

Al ignment Fixups/sec Fi le Write Operat ions/sec 

Context Switches/sec Float ing Emulat ions/sec 

Except ion Dispatches/sec Processes 

Fi le Control Bytes/sec Processor Queue Length 

Fi le Control Operat ions/sec System Calls/sec 

Fi le Data Operat ions/sec System Up Time 

Fi le Read Bytes/sec Threads 
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File Read Operat ions/sec  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

TCP Counters 

QALoad supports the TCP category for Windows. This object type handles these registry counters: 

Connect ion Fai lures Segments/sec 

Connect ions Act ive Segments Received/sec 

Connect ions Establ ished Segments Retransmitted/sec 

Connect ions Passive Segments Sent/sec 

Connect ions Reset  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Telephony Counters 

QALoad supports the Telephony category for Windows. This object type handles these registry counters: 

Act ive Lines Incoming Calls/sec 

Act ive Telephones Lines 

Client Apps Outgoing Calls/sec 

Current Incoming Calls Telephone Devices 

Current Outgoing Calls  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Thread Counters 

QALoad supports the Thread category for Windows. This object type handles th is registry counter: 

User PC  
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For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

UCP Counters 

QALoad supports the UCP category for Windows. This object type handles these registry counters: 

Datagrams/sec Datagrams Received Errors 

Datagrams No Port/sec Datagrams Sent/sec 

Datagrams Received/sec  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Windows NT Registry Counters 

Windows NT Registry Server Counters  

QALoad supports the fol lowing MS Windows NT Server counter categories: 

Coun ter Category Descript i on  

Active Server Pages This object type handles the Act ive Server Pages device on your 
system. 

Browser This object type displays Browser Stat ist ics. 

Cache The Cache object type manages memory for rapid access to fi les. Fi les 
on Windows NT are cached in main memory in  units of pages. Main 
memory not being used in the working sets of processes is avai lable to 
the Cache for th is purpose. The Cache preserves fi le pages in memory 
for as long as possible to permit  access to the data th rough the fi le 
system without accessing the disk. 

Context Index This object type handles the Content Index. 

Context Index Fi l ter This object type handles the Content Index Fi l ter. 

ICMP The ICMP object type includes the counters that describe the rates that 
ICMP Messages are received and sent by a certain ent i ty using the 
ICMP protocol. It  also describes various error counts for the ICMP 
protocol. 

IP This object type includes those counters that describe the rates that IP 
datagrams are received and sent by a certain computer using the IP 
protocol. It  also describes various error counts for the IP protocol. 

LogicalDisk A LogicalDisk object type is a part i t ion on a hard or fixed disk drive 
and assigned a drive let ter, such as C. Disks can be part i t ioned into 
dist inct sect ions where they can store fi le, program, and page data. The 
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disk is read to retrieve these i tems and writ ten to record changes to 
them. 

Memory The Memory object type includes those counters that describe the 
behavior of both real and virtual memory on the computer. Real 
memory is al located in  units of pages. Virtual memory can exceed real 
memory in  size, causing page traffic as virtual pages are moved 
between disk and real memory. 

Network Interface The Network Interface Object Type includes those counters that 
describe the rates that bytes and packets are received and sent over a 
Network TCP/IP connect ion. It  also describes various error counts for 
the same connect ion. 

Objects The Objects object type is a meta-object that contains in formation 
about the objects in  existence on the computer. This in formation can 
be used to detect the unnecessary consumption of computer resources. 
Each object requires memory to store basic in formation about the 
object. 

Paging Fi le This object displays in formation about the system's Page Fi le(s). 

PhysicalDisk A PhysicalDisk object type is a hard or fixed disk drive. It  contains 1 or 
more logical part i t ions. Disks are used to store fi le, program, and 
paging data. The disk is read to retrieve these i tems and writ ten to 
record changes to them. 

Process The Process object type is created when a program is run. Al l  the 
threads in  a process share the same address space and have access to 
the same data. 

Process Address Space Process Address Space object type displays detai ls about the virtual 
memory usage and al locat ion of the selected process. 

Processor The Processor object type includes as instances al l  processors on the 
computer. A processor is the part  in  the computer that performs 
ari thmetic and logical computat ions, and in i t iates operat ions on 
peripherals. It  executes (such as runs) programs on the computer. 

Redirector The Redirector is the object that manages network connect ions to 
other computers that originate from your own computer. 

Server The Server object type is the process that in terfaces the services from 
the local computer to the network services. 

Server Work Queues The Server Work Queues object type handles explain text performance 
data. 

SMTP Server This object type handles the counters specific to the SMTP Server. 

System This object type includes those counters that apply to al l  processors on 
the computer col lect ively. These counters represent the act ivi ty of al l  
processors on the computer. 

TCP The TCP object type includes the counters that describe the rates that 
TCP Segments are received and sent by a certain en t i ty using the TCP 
protocol. In  addit ion, i t  describes the number of TCP connect ions in  
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each possible TCP connect ion state. 

Telephony This object type handles the Telephony System. 

Thread The Thread object type is the basic object that executes instruct ions in  
a processor. Every running process has at least one thread. 

UDP The UDP object type includes the counters that describe the rates that 
UDP datagrams are received and sent by a certain ent i ty using the UDP 
protocol. It  also describes various error counts for the UDP protocol. 

 

Active Server Pages Counters 

QALoad supports the Act ive Server Pages category for Windows NT. This object type handles these registry 
counters: 

Debugging Requests Requests Rejected 

Errors During Script Runt ime Requests Succeeded 

Errors From ASP Preprocessor Requests Timed Out 

Errors From Script Compilers Requests Total 

Errors/Sec Script Engines Cached 

Memory Al located Session Durat ion 

Request Bytes In Total Sessions Current 

Request Bytes Out Total Sessions Timed Out 

Request Execut ion Time Sessions Total 

Request Wait  Time Template Cache Hit  Rate 

Requests/Sec Template Noti ficat ions 

Requests Disconnected Templates Cached 

Requests Execut ing Transact ions/Sec 

Requests Fai led Total Transact ions Aborted 

Requests Not Authorized Transact ions Committed 

Requests Not Found Transact ions Pending 

Requests Queued Transact ions Total 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  
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Browser Counters 

QALoad supports the Browser category for Windows NT. This object type handles these registry counters: 

Announcements Domain/sec Mailslot  Al locat ions Fai led 

Announcements Server/sec Mailslot  Opens Fai led/sec 

Announcements Total/sec Mailslot  Receives Fai led 

Duplicate Master Announcements Mailslot  Writes/sec 

Elect ion Packets/sec Mailslot  Writes Fai led 

Enumerat ions Domain/sec M issed Mailslot  Datagrams 

Enumerat ions Other/sec M issed Server Announcements 

Enumerat ions Server/sec M issed Server List  Requests 

Enumerat ions Total/sec Server Announce Al locat ions Fai led/sec 

Il legal Datagrams/sec Server List  Requests/sec 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Cache Counters 

QALoad supports the Cache category for Windows NT. This object type handles these registry counters: 

Async Copy Reads/sec  Fast Reads/sec 

Async Data Maps/sec Lazy Write Flushes/sec 

Async Fast Reads/sec Lazy Write Pages/sec 

Async MDL Reads/sec MDL Read Hits % 

Async Pin Reads/sec MDL Reads/sec 

Copy Read Hits % Pin Read Hits % 

Copy Reads/sec Pin Reads/sec 

Data Flush Pages/sec Read Aheads/sec 

Data Flushes/sec  Sync Copy Reads/sec 

Data M ap Hits % Sync Data Maps/sec 

Data M ap Pins/sec Sync Fast Reads/sec 

Data M aps/sec Sync MDL Reads/sec 
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Fast Read Not Possibles/sec Sync Pin Reads/sec 

Fast Read Resource M isses/sec  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp. 

 

Content Index Filter Counters 

QALoad supports the Content Index Fi l ter category for Windows NT. This object type handles these 
registry counters: 

Binding t ime (msec) Total fi l ter speed (MBytes/hr) 

Fi l ter speed (MBytes/hr)  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Content Index Counters 

QALoad supports the Content Index category for Windows NT. This object type handles these registry 
counters: 

# documents fi l tered Running queries 

Fi les to be fi l tered Total # documents 

Index size (MBytes) Unique keys 

Merge progress Wordl ists 

Persistent indexes  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

ICMP Counters 

QALoad supports the ICM P category for Windows NT. This object type handles these registry counters: 

Messages/sec Received Timestamp/sec 

Messages Outbound Errors Received Timestamp Reply/sec 

Messages Received/sec Sent Address Mask 
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Messages Received Errors Sent Address Mask Reply 

Messages Sent/sec Sent Dest inat ion Unreachable 

Received Address M ask Sent Echo/sec 

Received Address M ask Reply Sent Echo Reply/sec 

Received Dest. Unreachable Sent Parameter Problem 

Received Echo/sec Sent Redirect /sec 

Received Echo Reply/sec Sent Source Quench 

Received Parameter Problem Sent Time Exceeded 

Received Redirect/sec Sent Timestamp/sec 

Received Source Quench Sent Timestamp Reply/sec 

Received Time Exceeded  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

IP Counters 

QALoad supports the IP category for Windows NT. This object type handles these registry counters: 

Datagrams/sec Datagrams Received Unknown Protocol 

Datagrams Forwarded/sec Datagrams Sent/sec 

Datagrams Outbound Discarded Fragment Re-assembly Fai lures 

Datagrams Outbound No Route Fragmentat ion Fai lures 

Datagrams Received/sec Fragmented Datagrams/sec 

Datagrams Received Address Errors Fragments Created/sec 

Datagrams Received Delivered/sec Fragments Re-assembled/sec 

Datagrams Received Discarded Fragments Received/sec 

Datagrams Received Header Errors  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

LogicalDisk Counters 
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QALoad supports the LogicalDisk category for Windows NT. This object type handles these registry 
counters: 

% Disk Read Time Avg. Disk sec/Write 

% Disk Time Avg. Disk Write Queue Length 

% Disk Write Time Current Disk Queue Length 

% Free Space Disk Bytes/sec 

Avg. Disk Bytes/Read Disk Read Bytes/sec 

Avg. Disk Bytes/Transfer Disk Reads/sec 

Avg. Disk Bytes/Write Disk Transfers/sec 

Avg. Disk Queue Length Disk Write Bytes/sec 

Avg. Disk Read Queue Length Disk Writes/sec 

Avg. Disk sec/Read Free Megabytes 

Avg. Disk sec/Transfer  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Memory Counters 

QALoad supports the Memory category for Windows NT. This object type handles these registry counters: 

% Committed Bytes In Use Pages Output/sec 

Avai lable Bytes Pool Nonpaged Al locs 

Cache Bytes Pool Nonpaged Bytes 

Cache Bytes Peak Pool Paged Al locs 

Cache Faults/sec Pool Paged Bytes 

Commit Limit  Pool Paged Resident Bytes 

Committed Bytes System Cache Resident Bytes 

Demand Zero Faults/sec System Code Resident Bytes 

Free System Page Table Entries System Code Total Bytes 

Page Faults/sec System Driver Resident Bytes 

Page Reads/sec System Driver Total Bytes 
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Page Writes/sec Transit ion Faults/sec 

Pages/sec Write Copies/sec 

Pages Input/sec  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Network Interface Counters 

QALoad supports the Network Interface category for Windows NT. This object type handles these regist ry 
counters: 

Bytes Received/sec Packets Received Discarded 

Bytes Sent/sec Packets Received Errors 

Bytes Total/sec Packets Received Non-Unicast/sec 

Current Bandwidth Packets Received Unicast/sec 

Output Queue Length Packets Received Unknown 

Packets/sec Packets Sent/sec 

Packets Outbound Discarded Packets Sent Non-Unicast/sec 

Packets Outbound Errors Packets Sent Unicast/sec 

Packets Received/sec  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Object Counters 

QALoad supports the Objects category for Windows NT. This object type handles these registry counters: 

Events Sect ions 

Mutexes Semaphores 

Processes Threads 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  
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Paging File Counters 

QALoad supports the Paging Fi le category for Windows NT. This object type handles these registry 
counters: 

% Usage  % Usage Peak 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Physical Disk Counters 

QALoad supports the Physical Disk category for Windows NT. This object type handles these registry 
counters: 

% Disk Read Time Avg. Disk sec/Write 

% Disk Time Avg. Disk Write Queue Length 

% Disk Write Time Current Disk Queue Length 

Avg. Disk Bytes/Read Disk Bytes/sec 

Avg. Disk Bytes/Transfer Disk Read Bytes/sec 

Avg. Disk Bytes/Write Disk Reads/sec 

Avg. Disk Queue Length Disk Transfers/sec 

Avg. Disk Read Queue Length Disk Write Bytes/sec 

Avg. Disk sec/Read Disk Writes/sec 

Avg. Disk sec/Transfer  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Process Address Space Counters 

QALoad supports the Process Address category for Windows NT. This object type handles these registry 
counters: 

Bytes Free Mapped Space Read Only 

Bytes Image Free Mapped Space Write Copy 

Bytes Image Reserved Reserved Space Exec Read/Write 

Bytes Reserved Reserved Space Exec Read Only 
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ID Process Reserved Space Exec Write Copy 

Image Space Exec Read/Write Reserved Space Executable 

Image Space Exec Read Only Reserved Space No Access 

Image Space Exec Write Copy Reserved Space Read/Write 

Image Space Executable Reserved Space Read Only 

Image Space No Access Reserved Space Write Copy 

Image Space Read/Write Unassigned Space Exec Read/Write 

Image Space Read Only Unassigned Space Exec Read Only 

Image Space Write Copy Unassigned Space Exec Write Copy 

Mapped Space Exec Read/Write Unassigned Space Executable 

Mapped Space Exec Read Only Unassigned Space No Access 

Mapped Space Exec Write Copy Unassigned Space Read/Write 

Mapped Space Executable Unassigned Space Read Only 

Mapped Space No Access Unassigned Space Write Copy 

Mapped Space Read/Write  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Process Counters 

QALoad supports the Process category for Windows NT. This object type handles these registry counters: 

% Privi leged Time Pool Nonpaged Bytes 

% Processor Time  (See Note below) Pool Paged Bytes 

% User Time Priori ty Base 

Elapsed Time Private Bytes 

Handle Count Thread Count 

ID Process Virtual Bytes 

Page Faults/sec Virtual Bytes Peak 

Page Fi le Bytes Working Set 

Page Fi le Bytes Peak Working Set Peak 
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Note: :  If you use the % Processor Time counter in  an event rule, set the event rule to trigger after two 
or more occurrences of the event. The CPU consumption for the first  datapoint sample  is art i ficial ly h igh 
because the agent is start ing the task. 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Processor Counters 

QALoad supports the Processor category for Windows NT. This object type handles these registry counters: 

% DPC Time APC Bypasses/sec 

% Interrupt Time DPC Bypasses/sec 

% Privi leged Time DPC Rate 

% Processor Time DPCs Queued/sec 

% User Time Interrupts/sec 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Redirector Counters 

QALoad supports the Redirector category for Windows NT. This object type handles these registry counters: 

Bytes Received/sec Read Operat ions Random/sec 

Bytes Total/sec Read Packets/sec 

Bytes Transmitted/sec Read Packets Small /sec 

Connects Core Reads Denied/sec 

Connects Lan Manager 2.0 Reads Large/sec 

Connects Lan Manager 2.1 Server Disconnects 

Connects Windows NT Server Reconnects 

Current Commands Server Sessions 

Fi le Data Operat ions/sec Server Sessions Hung 

Fi le Read Operat ions/sec Write Bytes Cache/sec 

Fi le Write Operat ions/sec Write Bytes Network/sec 

Network Errors/sec Write Bytes Non-Paging/sec 
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Packets/sec Write Bytes Paging/sec 

Packets Received/sec Write Operat ions Random/sec 

Packets Transmitted/sec Write Packets/sec 

Read Bytes Cache/sec Write Packets Small /sec 

Read Bytes Network/sec Writes Denied/sec 

Read Bytes Non-Paging/sec Writes Large/sec 

Read Bytes Paging/sec  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Server Counters 

QALoad supports the Server category for Windows NT. This object type handles these registry counters: 

Blocking Requests Rejected Logon Total 

Bytes Received/sec Pool Nonpaged Bytes 

Bytes Total/sec Pool Nonpaged Fai lures 

Bytes Transmitted/sec Pool Nonpaged Peak 

Context Blocks Queued/sec Pool Paged Bytes 

Errors Access Permissions Pool Paged Fai lures 

Errors Granted Access Pool Paged Peak 

Errors Logon Server Sessions 

Errors System Sessions Errored Out 

Fi le Directory Searches Sessions Forced Off 

Fi les Open Sessions Logged Off 

Fi les Opened Total Sessions Timed Out 

Logon/sec Work Item Shortages 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Server Work Queues Counters 
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QALoad supports the Server Work Queues category for Windows NT. This object type handles these 
registry counters: 

Act ive Threads Queue Length 

Avai lable Threads Read Bytes/sec 

Avai lable Work Items Read Operat ions/sec 

Borrowed Work Items Total Bytes/sec 

Bytes Received/sec Total Operat ions/sec 

Bytes Sent/sec Work Item Shortages 

Bytes Transferred/sec Write Bytes/sec 

Context Blocks Queued/sec Write Operat ions/sec 

Current Cl ients  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

SMTP Server Counters 

QALoad supports the SMTP Server category for Windows NT. This object type handles these registry 
counters: 

% Recipients Local Message Bytes Received/sec 

% Recipients Remote Message Bytes Received Total 

Avg Recipients/msg Received Message Bytes Sent/sec 

Avg Recipients/msg Sent Message Bytes Sent Total 

Avg Retries/msg Delivered Message Bytes Total 

Avg Retries/msg Sent Message Bytes Total/sec 

Base % Recipients Local Message Delivery Retries 

Base % Recipients Remote Message Received/sec 

Base Avg Recipients/msg Received Message Send Retries 

Base Avg Recipients/msg Sent Messages Delivered/sec 

Base Avg Retries/msg Delivered Messages Delivered Total 

Base Avg Retries/msg Sent Messages Received Total 
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Bytes Received/sec Messages Refused for Address Objects 

Bytes Received Total Messages Refused for M ail  Objects 

Bytes Sent/sec Messages Refused for Size 

Bytes Sent Total Messages Retrieved/sec 

Bytes Total Messages Retrieved Total 

Bytes Total/sec Messages Sent/sec 

Connect ion Errors/sec Messages Sent Total 

Directory Drops/sec NDRs Generated 

Directory Drops Total Number of MailFi les Open 

Directory Pickup Queue Length Number of QueueFiles Open 

DNS Queries/sec Outbound Connect ions Current 

DNS Queries Total Outbound Connect ions Refused 

ETRN Messages/sec Outbound Connect ions Total 

ETRN Messages Total Remote Queue Length 

Inbound Connect ions Current Remote Retry Queue Length 

Inbound Connect ions Total Rout ing Table Lookups/sec 

Local Queue Length Routing Table Lookups Total 

Local Retry Queue Length Total Connect ion Errors 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

System Counters 

QALoad supports the System category for Windows NT. This object type handles these registry counters: 

% Registry Quota In Use Fi le Read Operat ions/sec 

% Total DPC Time Fi le Write Bytes/sec 

% Total In terrupt Time Fi le Write Operat ions/sec 

% Total Privi leged Time Float ing Emulat ions/sec 

% Total Processor Time Processor Queue Length 

% Total User Time System Calls/sec 
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Alignment Fixups/sec System Up Time 

Context Switches/sec Total APC Bypasses/sec 

Except ion Dispatches/sec Total DPC Bypasses/sec 

Fi le Control Bytes/sec Total DPC Rate 

Fi le Control Operat ions/sec Total DPCs Queued/sec 

Fi le Data Operat ions/sec Total In terrupts/sec 

Fi le Read Bytes/sec  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

TCP Counters 

QALoad supports the TCP category for Windows NT. This object type handles these registry counters: 

Connect ion Fai lures Segments/sec 

Connect ions Act ive Segments Received/sec 

Connect ions Establ ished Segments Retransmitted/sec 

Connect ions Passive Segments Sent/sec 

Connect ions Reset  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp. 

Telephony Counters 

QALoad supports the Telephony category for Windows NT. This object type handles these registry 
counters: 

Act ive Lines Incoming Calls/sec 

Act ive Telephones Lines 

Client Apps Outgoing Calls/sec 

Current Incoming Calls Telephone Devices 

Current Outgoing Calls  
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For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

Thread Counters 

QALoad supports the Thread category for Windows NT. This object type handles these registry counters: 

% Privi leged Time ID Thread 

% Processor Time Priori ty Base 

% User Time Priori ty Current 

Context Switches/sec Start  Address 

Elapsed Time Thread State 

ID Process Thread Wait  Reason 

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

UDP Counters 

QALoad supports the UDP category for Windows NT. This object type handles these registry counters: 

Datagrams/sec Datagrams Received Errors 

Datagrams No Port/sec Datagrams Sent/sec 

Datagrams Received/sec  

For in formation on the registry counters refer to the documentat ion or developer network for that product 
or the developer ki t  provided with the product. For M icrosoft  products, refer to 
http:/ /msdn.microsoft .com/ l ibrary/default .asp.  

 

 

SAP Counters 

SAP R/3 Remote Extended Counters 

The fol lowing extended SAP R/3 remote counters are provided. These counters extend the monitoring of 
your SAP R/3 system: 

Act ive Servers 

Act ive Users 

Alerts 

Page/Roll  Area  

Page/Roll  Area M ax 

Process Monitoring  
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Buffer Stat ist ics 

CCMS Monitoring 

Connect ion Test (SM59) 

CPU Consumption 

Itemized Act ive Users 

Itemized Job Status 

Itemized Spool Queue 

Job Status 

Memory Usage 

Number of Dumps  

Spool Queue 

System Log Entries 

Top CPU Uti l izat ion 

Top Load 

User Funct ion Call   

Workload Stat ist ic 

Work Processes 

 

 

SAP Active Servers 

This counter returns the act ive SAP appl icat ion servers for a specified SAP R/3 instance. 

Parameters 

SAP Instance 

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Server Count 

Maximum number of servers on which to report  data. The default  is 10. The value can range between 
00 and 100. 

Data Point 

Primary Data Point 

The primary data point (PDP) is the number of active SAP application servers in the specified SAP instance. 
If an error is encountered during data col lect ion, the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) displays the fol lowing in formation for each server: 

Nam e Full  appl icat ion server name. 

Hostnam e Name of appl icat ion server host. 

Type Service name. 

IP Applicat ion server host IP address. 

Num Services Service port  number. 

Interval 

Recommended minimum is 5 minutes. 
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SAP Active Users 

This counter returns al l  SAP users connected to either a specific SAP R/3 instance or system-wide. 

Parameters 

SAP Instance 

Composite name of the SAP R/3 instance you want to monitor. Enter an instance name as a string in  
the format: 

<System name>-<Application server name>-<R/3 system number>-<Client number> 

For example: 

C11-sapappserver-01-001 

SAP User Count 

Maximum number of servers on which to report  data. The default  is 10. The value can range between 
00 and 100. 

Level 

The monitoring level. This parameter is pre-defined and single-selectable. Possible values are: 

Selected instance on ly  (default) Only users in  the instance specified by the SAP 
Instance parameter are reported. 

Al l  i nstances in  the system   Al l  users of any instance avai lable through the 
specified instance are reported. 

Data Point 

Primary Data Point 

The primary data point (PDP) is the current queue depth as a percentage of the defined maximum. The 
Level parameter impacts the number of servers that wi l l  be scanned. If an error is encountered during 
data col lect ion, the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) displays the fol lowing in formation: 

Sysnam e Full  appl icat ion server name. 

Term inal ID Terminal ident i ficat ion. 

Cl ien t  User’s logon cl ient number. 

Usern am e Name of the user. 

Report / Tcode Name of tcode or report  current ly used by 
user.  

Term inal   Terminal name. 

Tim e Dialog t ime. 
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Sessions Number of user sessions. 

Interval 

Recommended minimum is 5 minutes. 

 

SAP Alerts 

This counter returns a descript ion of al l  the SAP alerts for the specified severi ty level.  

Parameters 

SAP Instance 

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Monitor Set 

Name of the monitor set. You can specify one or more sets. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Monitor 

Name of the monitor with in the selected monitor set. You can specify one or more monitors. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

Severity 

Alert  severi ty level you want to monitor. This parameter is pre-defined and mult i-selectable. Possible 
values are: 

Error - Red  (default)  

Warn ing - Yel low   

Pattern 

Pattern to search for in  result . The default  is al l  (* wi ldcard). You can either accept the default  or enter a 
string. Wildcard characters cannot be included in the string. 

Show Alert Text 

Specify whether to show the alert 's text.  This parameter is pre-defined and single-selectable. Possible 
values are: 

Yes  

No (defaul t )  

Alert Type 

Select whether data returned presents only current alert  act ivi ty or presents a h istory of act ivi ty. This 
parameter is pre-defined and mult i-selectable. Possible values are: 

Act i ve alerts (default)  
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Alert  h i story  

Show last minutes 

Number of minutes of data h istory to return. 

Data Point 

Primary Data Point 

A primary data point (PDP) is returned for each combinat ion of parameters. The value returned is the 
number of alerts of the specified type. If an error is encountered during data col lect ion, the counter 
returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) displays the fol lowing in formation: 

Color Red for errors and yel low for warnings 

Severi ty Severity of alert  

Date/ Tim e Alert  t imestamp 

Alert  Un ique ID Alert  ID 

Status Status (for example: act ive, cone, auto 
completed) 

System  MTE system name 

Contex t  MTE context 

Object  MTE object 

Short  Nam e MTE short  name 

Alert  Tex t  Alert  text, i f any. 

Interval 

Recommended minimum is 5 minutes. 

 

SAP Buffer Statistic 

This counter returns stat ist ics for the specified SAP R/3 buffers. 

The primary data point returns the buffer h it  rat io, which is an indicator of how efficient ly the buffer is 
being used. For a frequent ly accessed buffer, the h it  rat io should exceed 95%. 

Parameters 

SAP Instance 

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 
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Buffer Name 

Name of the SAP R/3 buffer you want to monitor. You can specify one or more buffers. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

Statistic Name 

The SAP R/3 buffer stat ist ic to be used for the primary data point. This parameter is predefined and 
single-selectable. Possible values are: 

% of  act i ve objects  

% of  f ree objects  

Free Size (%)  

Free Size (KB)  

Hi t  rate SAP buf fer (%) (default)  

M ax im um  no. of  objects  

No. of  act i ve objects  

No. of  database accesses  

No. of  f ree objects  

No. of  objects sw apped  

Size of  al l ocated address space (KB)  

Storage space avai lable (KB)  

Used si ze (%)  

Used si ze (KB)  

Data Point 

Primary Data Point 

A primary data point (PDP) is returned for each combinat ion of parameters. The primary data point is 
the value for the stat ist ic specified in  the Stat ist ic Name parameter. If an error is encountered during 
data col lect ion, the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) l ists the values returned for al l  stat ist ics. 

Interval 

Recommended minimum is 5 minutes. 

 

SAP CCMS Monitoring 

The Computer Center Management System (CCMS) Monitoring counter returns the value of the R/3 CCMS 
Monitoring Tree Element (MTE) as in  R/3 transact ion RZ20.  The performance, status and log attributes are 
dist inguished. Each MTE in CCMS is represented using four elements: system name, context, object and 
name. For example, CW2\ Database\ Tablespaces\ …\ PSAPTABD. 
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The counter ignores any relat ionships with in RZ20’s tree for the monitor set-monitor pair. Instead, i t  
al lows you to select each of these four elements using the parameter dependency feature. That is, after a 
monitor set is selected, the monitor l ist  has only monitors belonging to that monitor set. After the monitor 
is selected, the system name parameter only has values that belong to the combinat ion of monitor set-
monitor, etc. 

Performance attributes show a numeric value as the primary datapoint and any other messages as an 
extended datapoint.  

Status and log attributes show their status value – green, yel low, red and white (normal, warning, cri t ical 
and no data reported, respect ively). The primary datapoint is shown as 1, 2, 3 and 0 respect ively. The 
intel l igent datapoint is avai lable as explanat ion of returned status. 

This counter enables monitoring of any parts of R/3 of SAP modules, which supply data to CCMS. 

Parameters 

SAP Instance 

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Monitor Set 

Name of the monitor set. You can specify one or more sets. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Monitor 

Name of the monitor with in the selected monitor set. You can specify one or more monitors. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

System ID  

The system ID (or system name) of the monitoring system. You can specify one or more systems. In 
any combinat ion, select values from the discovered l ist , or enter values manually. 

Context  

The monitored context wi th in the system ID. You can specify one or more contexts. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

Object 

The monitored object with in the specified context. You can specify one or more objects. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

Name 

Name of MTE from R/3’s RZ20 transact ion. You can specify one or more names. In any combinat ion, 
select values from the discovered l ist , or enter values manually. 

Stat Type 

Select what type of data is returned.  This parameter is pre-defined and single-selectable. Possible values 
are: 

Act i ve alerts returns number of alerts 

Alert  h i story returns number of alerts 
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Value (default) returns MTE value 

Show last minutes 

Number of minutes of data h istory to return. 

Data Point 

Primary Data Point 

A primary data point (PDP) is returned for each combinat ion of parameters. The value returned is the 
MTE value or number of alerts, depending on the select ion in  the Stat type parameter. If an error is 
encountered during data col lect ion, the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) provides the fol lowing in formation: 

!  MTE status 

!  Timestamp 

!  MTE Name 

Interval 

Not appl icable. 

 

SAP Connection Test (SM59) 

This counter tests the connect ion to the selected remote system, as described in R/3. This is the same 
connect ion test as the R/3 transact ion SM59. 

Parameters 

SAP Instance  

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Connection Name 

Name of the connect ion described in SM59. Enter a string. There is no default  value. 

Data Point 

Primary Data Point 

The primary data point (PDP) is one of the fol lowing values: 

!  0 if the test fails 

!  1 if the test is successful 

!  999 if the counter experiences an error during data collection 

Intelligent Data Point 

The intel l igent data point (IDP) returns one of the fol lowing messages: 



QALoad 5.5  

84 

!  Failure reason if the test failed 

!  "Connection tested OK” message if the test succeeded 

!  Error message if the counter encounters an error during data collection 

Interval 

Recommended minimum is 5 minutes. 

 

SAP CPU Consumption  

This counter monitors CPU consumption for the specific users or transact ions. 

Parameters 

SAP Instance 

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

User Name 

The user name to monitor. The default  is al l  (* wi ldcard). You can either accept the default  or enter a 
specific name. Wildcard characters cannot be included in the name. 

TCode/Program 

The user transact ion code or report  code to monitor. The default  is al l  (* wi ldcard). You can either 
accept the default  or enter a specific name. Wildcard characters cannot be included in the name. 

Data Point 

Primary Data Point 

A primary data point (PDP) is returned for each combinat ion of parameters. The value returned is the 
percentage of SAP CPU consumption. If an error is encountered during data col lect ion,  the counter 
returns 999. 

If you do not specify values for the User Name or TCODE/Program parameters, the value returned is 
always 100%. 

Intelligent Data Point 

The intel l igent data point (IDP) provides the fol lowing in formation: 

Usern am e Name of the user. 

Tcode/ Program  Name of transact ion code or report .   

CPU (m s) Current CPU consumption in  mil l iseconds. 

CPU (%) Current CPU consumption in  percentage. 

WP-Type Number of user sessions. 

Interval 

Recommended minimum is 5 minutes. 
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SAP Itemized Active Users 

This counter returns the SAP users connected to the specified SAP instance and appl icat ion servers. It  is 
similar to the SAP act ive users counter, with the addit ion of the Appl icat ion Server Name parameter (mult i-
selectable and wildcard enabled). 

Parameters 

SAP Instance 

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Count 

Maximum number of servers on which to report  data. The default  is 10. The instance number can 
range between 00 and 100. 

Apply Operation 

The monitoring level. This parameter is pre-defined and single-selectable. Possible values are: 

None A primary data point is returned for each server specified in  the Appl icat ion 
Server parameter. 

Sum  The primary data point is a sum for al l  servers specif ied in  the Appl icat ion 
Server parameter. 

Application Server 

Name of the appl icat ion server you want to monitor. You can specify one or more names. In any 
combinat ion, select values from the discovered l ist , or enter values manually. 

Data Point 

Primary Data Point 

The primary data point (PDP) is the current queue depth as a percentage of the defined maximum. The 
Apply Operat ion parameter determines whether the counter returns a summary data point or 
individual data points. If an error is encountered during data col lect ion, the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) displays the fol lowing in formation: 

Sysnam e Full  appl icat ion server name. 

Term inal ID Terminal ident i ficat ion. 

Cl ien t  User’s logon cl ient number. 

Usern am e Name of the user. 

Report / Tcode Name of tcode or report  current ly used by 
user.  
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Term inal   Terminal name. 

Tim e Dialog t ime. 

Sessions Number of user sessions. 

Interval 

Recommended minimum is 5 minutes. 

 

SAP Itemized Job Status 

This counter reports the status of jobs that meet the specified cri teria. It  is similar to the SAP Job Status 
counter, with the addit ion of the Apply Operat ion parameter and the al l  (* wi ldcard) default  sett ing for the 
Job Status parameter. 

Parameters 

SAP Instance  

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Job Name 

The job name to monitor. The default  is al l . You can either accept the default  or enter a name.  

User Name 

The user name to monitor. The default  is al l . You can either accept the default  or enter a name.  

Job Status 

The statuses you want to monitor. This parameter is predefined and mult i-selectable. Possible values 
are: 

* (al l  - default)  

Act i ve  

Canceled  

Fin ished  

Ready  

Released  

Scheduled  

Event Name 

Name of a SAP job event. If you specify an event name for th is parameter, th is counter returns batch 
jobs related to that event only. The default  is to monitor al l  events. You can either accept the default  or 
enter a name.  

Start Time 
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Number of minutes back from the current t ime you want th is counter to monitor job entries. Specify a 
value from -999999 to 0 (in  minutes). The default  value is -60.   

End Time 

Number of minutes forward from the current t ime you want th is counter to monitor job entries. 
Specify a value from 0 to 999999 (in  minutes). The default  value is 60.   

Apply Operation 

The monitoring level. This parameter is predefined single-selectable. Possible values are: 

None A primary data point is returned for each status type specified in  the Job 
Status parameter. 

Sum  (default) The primary data point is a sum for al l  status types specified in  the Job 
Status parameter. 

Data Point 

Primary Data Point 

The primary data point (PDP) is the number of jobs. The Apply Operat ion parameter determines 
whether the counter returns a summary data point or individual data points. If an error is encountered 
during data collection, the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) l ists the fol lowing in formation for each job status: 

!  Total jobs found 

!  Scheduled 

!  Released  

!  Ready 

!  Active 

!  Finished 

!  Cancelled 

The IDP also includes a table with the fol lowing in formation, organized by job status: 

Jobnam e Name of the job. 

Job-coun t   In ternal job ID.   

Status Job status. 

Log Short log messages. 

Interval 

Recommended minimum is 5 minutes. 

 

SAP Itemized Spool Queue 
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This counter returns the current number of entries in  the SAP spool queue that match the specified cri teria. 
It  is similar to the SAP Spool Queue counter, with the addit ion of the Apply Operat ion parameter and the 
al l  default  sett ing for the Request Status parameter. 

Parameter 

SAP Instance 

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Request Status 

Request status that you want to monitor. This parameter is predefined and mult i-selectable. Possible 
values are: 

* (al l  - default)  

Problem   

Processing  

Succeeded  

Without   

Apply Operation 

The monitoring level. This parameter is predefined and single-selectable. Possible values are: 

None A primary data point is returned for each status type specified in  the 
Request Status parameter. 

Sum  (default) The primary data point is a sum for al l  status types specified in  the Request 
Status parameter. 

Data Point 

Primary Data Point 

The primary data point (PDP) is the number of current entries in  the SAP spool queue. The Apply 
Operat ion parameter determines whether the counter returns a summary data point or individual data 
points. If an error is encountered during data collection,  the counter returns 999. 

Intelligent Data Point 

The intelligent data point (IDP) is the number of entries in the spool queue for each request status. 

Interval 

Recommended minimum is 5 minutes. 

 

 

SAP Job Status 

This counter reports the number of jobs that are selected that meet the cri teria you specify. 
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Parameters 

SAP Instance  

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Job Name 

The job name to monitor. The default  is al l . You can either accept the default  or enter a name.  

User Name 

The user name to monitor. The default  is al l . You can either accept the default  or enter a name.  

Job Status 

The job status you want to monitor. This parameter is predefined and single-selectable. Possible values 
are: 

* (al l )  

Act i ve  

Canceled  

Fin ished  

Ready  

Released  

Scheduled  (default)  

Event Name 

Name of a SAP job event. If you specify an event name for th is parameter, th is counter returns batch 
jobs related to that event only. The default  is to monitor al l  events. You can either accept the default  or 
enter a name.  

Start Time  

Number of minutes back from the current t ime you want th is counter to monitor job entries. Specify a 
value from -999999 to 0 (in  minutes). The default  value is -60.   

End Time  

Number of minutes forward from the current t ime you want th is counter to monitor job entries. 
Specify a value from 0 to 999999 (in  minutes). The default  value is 60.   

Data Point 

Primary Data Point 

A primary data point (PDP) is returned for each combinat ion of parameters. The number returned is 
the number of jobs. If an error is encountered during data collection, the counter returns 999. 

Intelligent Data Point  

The intel l igent data point (IDP) l ists the fol lowing in formation: 
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!  Total jobs found 

!  Scheduled 

!  Released  

!  Ready 

!  Active 

!  Finished 

!  Cancelled 

The IDP also includes a table with the fol lowing in formation, organized by job status: 

Jobnam e Name of the job. 

Job-coun t   In ternal job ID.   

Status Job status. 

Log Short log messages. 

Interval 

Recommended minimum is 5 minutes. 

 

SAP Memory Usage 

This counter returns the total memory usage for the specified number of SAP users in  the SAP system. 

Parameters 

SAP Instance  

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Count 

Maximum number of users for which the counter is to report  memory ut i l izat ion values. Specify a 
value from 0 to 100. The default  is 10.  This number is the number rows of in formation that is reported 
in  the Intel l igent Data Point (IDP) table (described below). 

Metrics 

Units in  which you want memory usage returned. This parameter is predefined and single-selectable. 
Possible values are: 

bytes  

KB  

M B  

Data Point 

Primary Data Point 
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The primary data point (PDP) is the total memory ut i l izat ion.  If an error is encountered during data 
collection,  the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) is a table with the fol lowing in formation, organized by user: 

Cl ien t  Client number. 

User User name or owner of the job. 

TransCode Transact ion code name.  

Rol l  Area Size of rol l  area. 

Page Area Size of page area. 

Shared M em ory Size of shared memory. 

Heap M em ory Size of heap memory. 

Sum m ary M em ory Summary of al l  types of memory. 

Term inal ID Terminal ident i ficat ion number. 

Interval 

Recommended minimum is 5 minutes. 

 

SAP Number of Dumps 

This counter returns the number of dumps generated by the target system in the current day (since 
midnight on the SAP system). 

Parameters 

SAP Instance  

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Expression 

Pattern to use to match dump’s short  text. The default  is al l  

Data Point 

Primary Data Point 

The primary data point (PDP) is the number dumps. If an error is encountered during data collection, the 
counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) l ists the fol lowing in formation for each dump: 

Tim e Time dump was created. 
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Appl i cat ion  Host  Applicat ion host name.   

User  User name. 

Cl ien t  Client number. 

Short  Tex t  Dump descript ion. 

Interval 

Recommended minimum is 15 minutes. 

 

SAP Page/Roll Area  

This counter monitors the page or rol l  area stat ist ics. 

Parameters 

SAP Instance  

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Return Value Metrics 

The page and rol l  area metrics. This parameter is pre-defined and mult i-selectable. Possible values are: 

M ax im um  Paging Area Used (%)  

M ax im um  Paging Area Used (KB)  

M ax im um  Rol l  Area Used (%)  

M ax im um  Rol l  Area Used (KB)  

Size of  the Paging Area (KB)  

Size of  the Paging Area in  the Shared M em ory (KB)  

Size of  the Paging Fi l e (KB)  

Size of  the Rol l  Area (KB)  

Size of  the Rol l  Area in  the Shared M em ory (KB)  

Size of  the Rol l  Fi l e (KB)  

Size of  the Work  Process-Local  Paging Buf fer (KB) 
(default) 

 

Used Paging Area (%)  

Used Paging Area (KB)  

Used Rol l  Area (%)  

Used Rol l  Area (KB)  
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Data Point 

Primary Data Point 

A primary data point (PDP) is returned for each combinat ion of parameters. The value returned is the 
value of the specified metric (KB or %). The counter returns 999 i f i t  encounters an error during data 
col lect ion. 

Intelligent Data Point 

The intel l igent data point (IDP) l ists the stat ist ics for al l  page and rol l  metrics. 

Interval 

Recommended minimum is 5 minutes. 

 

SAP Page/Roll Area Max 

This counter returns the maximum page or rol l  area stat ist ics for the specified task in terval. 

Determining a statistic's maximum value 

A Remote Funct ion Call  (RFC) is made at each task in terval to get the data.  It  searches the in ternal cache 
for the previously stored value of the same metric wi th a t imestamp with in the t ime range specified with  
the “ Period in  min ”  parameter. 

If a value is found for the specified metric, i t  is compared with the current value. The SAP Page/Roll  Area 
Max counter returns the greater of the two values and stores i t  in  the cache with current t imestamp. 

If a stored value is not found for the specified metric, the cache is cleared and the current value is stored in  
i t . The counter returns th is value.  

Parameters 

SAP Instance  

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Return Value Metrics 

The page and rol l  area metrics. This parameter is predefined mult i-selectable. Possible values are: 

M ax im um  Paging Area Used (%)  

M ax im um  Paging Area Used (KB)  

M ax im um  Rol l  Area Used (%)  

M ax im um  Rol l  Area Used (KB)  

Size of  the Paging Area (KB)  

Size of  the Paging Area in  the Shared M em ory (KB)  

Size of  the Paging Fi l e (KB)  

Size of  the Rol l  Area (KB)  

Size of  the Rol l  Area in  the Shared M em ory (KB)  
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Size of  the Rol l  Fi l e (KB)  

Size of  the Work  Process-Local  Paging Buf fer (KB) 
(default) 

 

Used Paging Area (%)  

Used Paging Area (KB)  

Used Rol l  Area (%)  

Used Rol l  Area (KB)  

Period in min 

Specify a maximum durat ion of t ime in minutes. The default  is 60. 

Data Point 

Primary Data Point 

A primary data point (PDP) is returned for each combinat ion of parameters. The value returned is 
the maximum value of the specified metric (KB or %), determined by the method described in 
Determin ing a stat ist ic's maximum value. The counter returns 999 i f i t  encounters an error during 
data col lect ion. 

Intelligent Data Point 

The intel l igent data point (IDP) l ists, for the period, the maximum values for al l  stat ist ics. 

Interval 

Recommended minimum is 5 minutes. 

 

SAP Process Monitoring 

This counter returns CPU ut i l izat ion or memory usage for selected processes. These processes must be set 
up to be monitored by the SAP Operat ion System Collector. 

To gather th is data from the target R/3 instances, you must set up SAP OS Collector (saposcol) to gather 
in formation about system processes. Complete instruct ions are described in the document cal led 
“ Operat ion System Collector SAPOSCOL: Propert ied, Operat ion and Instal lat ion ” . It  is avai lable from the 
SAP web site. 

Parameters 

SAP Instance  

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable 
from the discovered l ist . 

Process Pattern or User Pattern 

Process or user to monitor. This parameter is single-selectable from the dynamical ly discovered l ist . 

Metrics 

Usage metrics for monitoring. This parameter is predefined and mult i-selectable. Possible values are:  
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CPU Ut i l i zat ion  (%)  

Process Coun t  (default)  

Residen t  Size (KB)  

VM  Size (KB)  

Data Point 

Primary Data Point 

A primary data point (PDP) is returned for each combinat ion of parameters. The returned value is the 
 value of the selected metric. If an error is encountered during data collection,  the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) displays the fol lowing in formation for each metric:  

Last  SapOsCol  sam ple w as taken  at : <date><time> 
SapOsCol  col l ect ion  in terval : <number_of_seconds> sec. 

Interval 

Recommended minimum is 5 minutes. 

 

SAP Spool Queue 

This counter returns the current number of SAP spool queue entries that match the specified cri teria. 

Parameter 

SAP Instance 

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Request Status 

Request status that you want to monitor. This parameter is predefined and single-selectable. Possible 
values are: 

Problem   

Processing (default)  

Succeeded  

Without   

Data Point 

Primary Data Point 

The primary data point (PDP) for th is counter is the number of current SAP spool queue entries that 
match the specified cri teria. If an error is encountered during data collection,  the counter returns 999. 

Intelligent Data Point 



QALoad 5.5  

96 

The intelligent data point (IDP) is the number of entries in the spool queue for each request status. 

Interval 

Recommended minimum is 5 minutes. 

 

SAP System Log Entries  

This counter returns, for the selected t ime period, the entries that match the specified expression. 

Parameters 

SAP Instance 

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Time Period (Minutes) 

Number of minutes back from the current t ime you want th is counter to monitor job entries. Specify a 
value from 5 to 180 (in  minutes). The default  value is 60.   

Expression 

Pattern to use to match the message text in  the SAP system log . The default  is al l . You can either 
accept the default  or enter a string.  

Data Point 

Primary Data Point 

The primary data point (PDP) is the number of entries in  the SAP system log that match the select ion 
cri teria. 

Intelligent Data Point 

The intel l igent data point (IDP) displays the fol lowing in formation for each message: 

Severi ty Message severi ty level: Error, Warning, or 
Normal. 

Tim e Message t ime. 

Type Work process type and number.  

PID System process ident i fier of the work 
process. 

Cl ien t   Client number. 

User  User name.  

Tcode Transact ion code. 

M no Message number. 

Tex t  Message text. 
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Interval 

Recommended minimum is 10 minutes. 

 

SAP Top CPU Util ization 

This counter returns the h ighest CPU uti l izat ion, by process, for the top 40 processes on the SAP R/3 
appl icat ion server. 

Parameters 

SAP Instance 

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Data Point 

Primary Data Point 

The primary data point (PDP) is the h ighest CPU util izat ion value.  If an error is encountered during data 
collection,  the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) displays the fol lowing in formation for the top 40 processes: 

PID System process ident i fier. 

Instan ce  Name of SAP R/3 instance. 

Com m and System process name. 

CPU Ut i l [%] CPU ut i l izat ion value. 

CPU Tim e[s]  CPU t ime value. 

Work ing Set [KB] Top physical memory that is assigned to the process. 

Private Pages[KB] Total of the ent ire memory (physical and virtual) 
that is assigned to the process (Windows systems 
only, th is value is 0 on UNIX). 

Prior Process priori ty. 

Interval 

Recommended minimum is 5 minutes. 

 

SAP Top Load 

This counter returns a maximum workload stat ist ic for the SAP system. 

Parameters 

SAP Instance 
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Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Count 

Maximum number of act ive servers monitored for workload information. Val id entries are from 0 to 
100. The default  is 10. 

Sorting Parameter 

Workload characterist ic you want to monitor. This parameter is predefined and mult i-selectable. 
Possible values are: 

CPU Tim e  

DB Tim e  

Respon se Tim e (defaul t )  

Transfer Size  

Wai t  Tim e  

Time Metrics  

Units for monitoring CPU Time, DB Time, and Response Time, and Wait  Time. This parameter is 
predefined and single-selectable. Possible values are: 

M i l l iSeconds (default)  

Seconds  

Size Metrics 

Unit  of space for monitoring Transfer Size. This parameter is predefined and single selectable. Possible 
values are: 

Bytes  

Ki loBytes (default)  

M egaBytes   

Data Point 

Primary Data Point 

A primary data point (PDP) is returned for each combinat ion of parameters. The returned value is the 
top workload, in  t ime or size.  If an error is encountered during data collection,  the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) displays the fol lowing in formation for each transact ion: 

User User name.  

Transact ion  Transact ion code name. 

Report  Report name. 
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Background Job Nam e Name of background job, i f val id.  

Task  Type Type of the task.  

Respon se Tim e Response name.  

CPU Tim e CPU t ime. 

Wai t  Tim e Wait t ime. 

DB Tim e Database t ime.  

Transfer Size Number of t ransferred bytes.  

Interval 

Recommended minimum is 10 minutes. 

 

SAP User Function Call 

This counter cal ls any R/3 RFC-enabled funct ion when i t  is designed according the fol lowing 
ServerVantage rules. This counter enables you to create and implement your own custom SAP R/3 counters. 

ServerVantage User Function Call Guidelines 

!  The function name can be any character string. 

!  The function should have 1 import, 1 export, and 1 table parameter. 

Im port  param eter : SV_PARAMETERS is a character string that serves for passing data from 
ServerVantage to R/3 funct ion. You define how th is string is parsed in R/3 funct ion. 

Export  param eter : SV_VALUE must be float type and serves for passing data point values from R/3 
funct ion to the Java Agent. 

Table param eter : SV_EXTENDED_DP is an opt ional  parameter that serves for passing in tel l igent 
(extended) data points from R/3 funct ion to Java Agent. It  can be any character string. To pass 
in tel l igent data points, you need to include the table header. 

!  Parameter names cannot be changed. 

Except ions: You can define any number of except ions. In  the case of an except ion with in RFM, the 
Monitoring tree displays –1 in the primary data Point (PDP) and an except ion message in Intel l igent 
Data Point (IDP). 

!  In  the body of the funct ion, you may use any manipulat ions to retrieve data from R/3 and set 
SV_VALUE and SV_EXTENDED_DP. 

!  The funct ion MUST NOT have any GUI or screen output statements, or any statements requiring 
dialog, in teract ion, or addit ional answers.  

See User Funct ion Call  Example.  

Parameters 

SAP Instance  

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 
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Function Name 

R/3 Remote Funct ion M odule (RFM) name. 

Parameters 

Parameters to pass to the funct ion.  

Data Point 

Primary Data Point 

The primary data point (PDP) is the value returned by the R/3 RFM.  If an error is encountered during data 
collection,  the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) is returned by the R/3 RFM. 

Interval 

Not appl icable. 

 

SAP W ork Processes 

This counter returns the number of work processes running on a SAP instance according to the specified 
cri teria. 

Parameters 

SAP Instance  

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Process Type 

Type of work process. This parameter is predefined and mult i-selectable. Possible values are: 

BDG Background 

DIA (default) Dialog 

ENQ Enqueue 

SPO Spool 

UP2 Update 2 

UPD Update 

Process State  

Process state to monitor. This counter is predefined and mult i-selectable. Possible values are: 

Com pleted  

Runn ing  
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Stopped  

Wai t ing (default)  

Data Point 

Primary Data Point 

A primary data point (PDP) is returned for each combinat ion of parameters. The value returned is the 
number of work processes. If an error is encountered during data collection,  the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) l ists the fol lowing process in formation: 

!  Total Work Processes 

!  Work Processes - Waiting State 

!  Work Processes - Running State 

!  Work Processes - Stopped State 

!  Work Processes - Completed State 

The IDP also includes a table with the fol lowing in formation, for each process: 

Num ber  Process sequential  number. 

Type Process type. 

Process ID Process system ID. 

Status Process status. 

Reason  Work process is wait ing. 

Sem aphore Semaphore for which the work process is wait ing. 

Restart  Restart  work process after dump. 

Dum ps Number of dumps. 

CPU CPU t ime. 

Elapsed Tim e Previous execut ion t ime of request (elapsed). 

Cl ien t  Client number. 

User User that is using the process. 

Report  Report or tcode name used by the process. 

Act ion  What the process is doing. 

Table Database table last accessed by the work process. 

Interval 

Recommended minimum is 10 minutes. 
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SAP W orkload Statistic 

This counter returns selected ST03 workload stat ist ics for selected task types. 

Parameters 

SAP Instance  

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable. 
Select an instance from the discovered l ist . 

Task Type 

The task type you want to monitor. This parameter is predefined and mult i-selectable. Possible values 
are: 

ALE  

AUTOABA (default)  

BCKGRD  

BUF.SYN  

DIALOG  

ENQUEUE  

FTP  

HTTP  

HTTPS  

NNTP  

RFC  

SM TP  

SPOOL  

UPDATE  

UPDATE2  

Statistic Name 

The workload stat ist ic. This parameter is predefined and mult i-selectable. Possible values are:  

CPU t im e avg (m s)  

CPU t im e total (s)  

Database cal l s  

Database requests  

Database requests: Chan ges  
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Database requests: Di rect  reads  

Database requests: Sequen t ial  reads  

DB t im e avg (m s)  

DB t im e total (s)  

Dialog Steps (default)  

Dialog steps/ s  

Fron tend net  t im e avg (m s)  

Fron tend net  t im e total (s)  

GUI t im e avg (m s)  

GUI t im e total (s)  

Requested kBytes  

Respon se t im e avg(m s)  

Respon se t im e total (s)  

Rol l  i n  t im e  

Rol l  i ns  

Rol l  out  t im e  

Rol l  outs  

Rol l  w ai t  t im e  

Tim e per DB request   

Tim e per DB request : Changes and com m i ts  

Tim e per DB request : Di rect  reads  

Tim e per DB request : Sequen t ial  reads  

Wai t  t im e avg (m s)  

Wai t  t im e total (s)  

Data Point 

Primary Data Point 

A primary data point (PDP) is returned for each combinat ion of parameters. The value returned is the 
selected workload stat ist ic. If an error is encountered during data collection,  the counter returns 999. 

Intelligent Data Point 

The intel l igent data point (IDP) displays a l ist  of the remain ing stat ist ics, for example: 
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Interval 

Recommended minimum is 60 minutes. 

 

SNMP Counters 

SNMP Counters  

SNMP Remote M onitoring uses the SNMP service to provide network and system counters. SNMP counters 
can be retrieved from any machine that is running an SNMP server. QALoad uses the default  SNMP port . 
Although SNMP does not require a user name and password, the SNMP agent must be configured to al low 
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read-only access from the Conductor machine. SNM P counters that are supported by QALoad Remote 
Monitoring are categorized below.  

ICMP 

i cm pIn M sgs/ sec: the rate at which ICMP messages are received 
i cm pIn Errors: the number of ICMP messages received having ICMP errors 
Icm pIn DestUnreachs: the number of ICMP Dest inat ion Unreachable messages received 
Icm pInTim eExcds: the number of ICMP Time Exceeded messages received 
Icm pIn Parm Probs: the number of ICMP Parameter Problem messages received 

Icm pInSrcQuenchs: the number of ICMP Source Quench messages received 
i cm pInRedi rects/ sec: the rate at which ICMP Redirect messages are received 
i cm pIn Echos/ sec: the rate at which ICMP Echo messages are received 
i cm pIn EchoReps/ sec: the rate at which ICMP Echo Reply messages are received 
i cm pInTim estam ps/ sec: the rate at which ICMP Timestamp messages are received 
i cm pInTim estam pReps/ sec: the rate at which ICM P Timestamp Reply messages are received 
i cm pIn AddrM asks: the number of ICMP Address Mask Request messages received 
i cm pIn AddrM askReps: the number of ICMP Address Mask Reply messages received 
i cm pOutM sgs/ sec: the rate at which ICMP messages are sent  
i cm pOutM sgs/ sec: the number of ICMP messages not sent due to ICMP errors 
i cm pOutDestUn reachs: the number of ICMP Dest inat ion Unreachable messages sent  
i cm pOutTim eExcds: the number of ICMP Time Exceeded messages sent  
i cm pOutParm Probs: the number of ICMP Parameter Problem messages sent  
i cm pOutSrcQuen chs: the number of ICMP Source Quench messages sent  
i cm pOutRedi rects/ sec: the number of ICMP Redirect messages sent  
i cm pOutEchos/ sec: the number of ICMP Echo messages sent  
i cm pOutEchoReps/ sec: the number of ICMP Echo Reply messages sent  
i cm pOutTim estam ps/ sec: the number of ICMP Timestamp messages sent  
i cm pOutTim estam pReps/ sec: the number of ICMP Timestamp Reply messages sent  
i cm pOutAddrM asks: the number of ICMP Address Mask Request messages sent  
i cm pOutAddrM askReps: the number of ICMP Address Mask Reply messages sent 

IP 

i pForw arding: the indicat ion of whether th is ent i ty is act ing as an IP router in  respect to the forwarding of 
datagrams received by, but not addressed to, th is ent i ty. 
i pDefaul tTTL: the default  value inserted in to the Time-To-Live field of the IP header of datagrams 
originated at th is ent i ty, whenever a TTL value is not suppl ied by the transport  layer protocol. 
i pInReceives/ sec: the rate of input datagrams received from interfaces, including those received in error. 
i pInHdrErrors: the number of input datagrams discarded due to errors in  their IP headers, including bad 
checksums, version number mismatch, other format errors, t ime-to-l ive exceeded, errors discovered in 
processing their IP opt ions, and so on. 
i pInAddrErrors: the number of input datagrams discarded because the IP address in  their IP header's 
dest inat ion field was not a val id address to be received at th is ent i ty. 
i pForw Datagram s/ sec: the rate of input datagrams for which th is ent i ty was not their final IP dest inat ion, 
as a result  of which an attempt was made to find a route to forward them to that final dest inat ion. 
i pInUn know n Protos: the number of local ly-addressed datagrams receive successful ly but discarded 
because of an unknown or unsupported protocol. 
i pIn Discards: the number of input IP datagrams for which no problems were encountered to prevent their 
cont inued processing, but which were discarded (for example, for lack of buffer space). 
i pIn Del i vers/ sec: the rate of input datagrams successful ly del ivered to IP user-protocols (including ICMP). 
i pOutRequests: the number of IP datagrams which local IP user-protocols (including ICMP) suppl ied to IP 
in  requests for transmission. 
i pOutDiscards: the number of output IP datagrams for which no problem was encountered to prevent 
their t ransmission to their dest inat ion, but which were discarded (for example, for lack of buffer space). 
i pOutNoRoutes: the number of IP datagrams discarded because no route could be found to transmit them 
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to their dest inat ion. 
i pReasm Tim eout : the maximum number of seconds which received fragments are held while they are 
await ing reassembling at th is ent i ty. 
i pReasm Reqds: the number of IP fragments received which needed to be reassembled at th is ent i ty. 
i pReasm OKs: the number of IP datagrams successful ly re-assembled. 
i pReasm Fai l s: the number of fai lures detected by the IP re-assembly algori thm (for whatever reason: t imed 
out, errors, etc). 
i pFragOKs: the number of IP datagrams that have been successful ly fragmented at th is ent i ty. 
i pFragFai l s: the number of IP datagrams that have been discarded because they needed to be fragmented at 
th is ent i ty but could not be, for example, because their Don't  Fragment flag was set. 
i pFragCreates/ sec: the rate of IP datagram fragments that have been generated as a result  of fragmentat ion 
at th is ent i ty. 
i pRout ingDiscards: the number of rout ing entries which were chosen to be discarded even though they 
are val id. 

SNMP 

snm pInPk ts/ sec: the rate of messages del ivered to the SNMP ent i ty from the transport  service. 
snm pOutPk ts/ sec: the rate at which SNMP Messages were passed from the SNMP protocol ent i ty to the 
transport  service. 
snm pInBadVersions: the number of SNMP messages which were del ivered to the SNMP ent i ty and were 
for an unsupported SNMP version. 
snm pInBadCom m un i tyNam es: the number of SNMP messages del ivered to the SNMP ent i ty which used a 
SNMP community name not known to said ent i ty. 
snm pInBadCom m un i tyUses: the number of SNM P messages del ivered to the SNMP ent i ty which 
represented an SNMP operat ion which was not al lowed by the SNMP community named in the message. 
snm pInASNParseErrs: the number of ASN.1 or BER errors encountered by the SNMP ent i ty when decoding 
received SNMP messages. 
snm pInTooBigs: the number of SNMP PDUs which were del ivered to the SNMP protocol ent i ty and for 
which the value of the error-status field is tooBig. 
snm pInNoSuchNam es: the number of SNMP PDUs which were del ivered to the SNMP protocol ent i ty and 
for which the value of the error-status field is noSuchName. 
snm pInBadVal ues: the number of SNMP PDUs which were del ivered to the SNMP protocol ent i ty and for 
which the value of the error-status field is badValue. 
snm pInReadOn lys: the number val id SNMP PDUs which were del ivered to the SNMP protocol ent i ty and 
for which the value of the error-status field is readOnly. 
snm pInGen Errs: the number of SNMP PDUs which were del ivered to the SNMP protocol ent i ty and for 
which the value of the error-status field is genErr. 
snm pInTotalReqVars/ sec: the rate of M IB objects which have been retrieved successful ly by the SNM P 
protocol ent i ty as the result  of receiving val id SNMP Get-Request and Get-Next PDUs. 
snm pInTotalSetVars/ sec: the rate of M IB objects which have been altered successful ly by the SNMP 
protocol ent i ty as the result  of receiving val id SNMP Set-Request PDUs. 
snm pInGetRequests/ sec: the rate of SNMP Get-Request PDUs which have been accepted and processed by 
the SNMP protocol ent i ty. 
snm pInGetNex ts/ sec: the rate of SNMP Get-Next PDUs which have been accepted and processed by the 
SNMP protocol ent i ty. 
snm pInSetRequests/ sec: the rate of SNMP Get-Response PDUs which have been accepted and processed 
by the SNMP protocol ent i ty. 
snm pInGetRespon ses/ sec: the rate of SNMP Set-Request PDUs which have been accepted and processed 
by the SNMP protocol ent i ty. 
snm pInTraps: the number of SNMP Trap PDUs which have been accepted and processed by the SNMP 
protocol ent i ty. 
snm pOutTooBigs: the number of SNMP PDUs which were generated by the SNMP protocol ent i ty and for 
which the value of the error-status field is tooBig. 
snm pOutNoSuchNam es: the number of SNMP PDUs which were generated by the SNMP protocol ent i ty 
and for which the value of the error-status is noSuchName. 
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snm pOutBadValues: the number of SNMP PDUs which were generated by the SNMP protocol ent i ty and 
for which the value of the error-status field is badValue. 
snm pOutGen Errs: the number of SNMP PDUs which were generated by the SNMP protocol ent i ty and for 
which the value of the error-status field is genErr. 
snm pOutGetRequests/ sec: the rate of SNMP Get-Request PDUs which have been generated by the SNMP 
protocol ent i ty. 
snm pOutGetNex ts/ sec: the rate of SNMP Get-Next PDUs which have been generated by the SNMP 
protocol ent i ty. 
snm pOutSetRequests/ sec: the rate of SNMP Set-Request PDUs which have been generated by the SNMP 
protocol ent i ty. 
snm pOutGetResponses/ sec: the rate of SNMP Get-Response PDUs which have been generated by the 
SNMP protocol ent i ty. 
snm pOutTraps: the number of SNMP Trap PDUs which have been generated by the SNMP protocol ent i ty. 
snm pOutTraps: indicates whether the SNMP ent i ty is permit ted to generate authent icat ionFailure traps. 

TCP 

t cpRtoAlgori thm : the algori thm used to determine the t imeout value used for retransmitt ing 
unacknowledged octets. 
t cpRtoM in : the min imum value permit ted by a TCP implementat ion for the retransmission t imeout. 
t cpRtoM ax : the maximum value permit ted by a TCP implementat ion for the retransmission t imeout. 
t cpM axConn : the l im it  on the total number of TCP connect ions the ent i ty can support. 
t cpAct i veOpens: the number of t imes TCP connect ions have made a direct t ransit ion to the SYN-SENT 
state from the CLOSED state. 
t cpAt tem ptFai l s: the number of t imes TCP connect ions have made a direct t ransit ion to the SYN-RCVD 
state from the LISTEN state. 
t cpEstabResets: the number of t imes TCP connect ions have made a direct t ransit ion to the CLOSED state 
from either the ESTABLISHED state or the CLOSE-WAIT state. 
t cpCurrEstab: the number of TCP connect ions for which the current state is either ESTABLISHED or 
CLOSE-WAIT. 
t cpInSegs/ sec: the rate at which segments are received, including those received in error. 
t cpOutSegs/ sec: the rate at which segments are sent, including those on current connect ions but 
excluding those contain ing only retransmitted octets. 
t cpRet ransSegs/ sec: the rate at which segments are retransmitted. 
t cpIn Errs/ sec: the rate at which segments are received in error. 
t cpOutRsts/ sec: the rate at which segments contain ing the RST flag are sent. 
t cpPassiveOpen s: the total number of t imes TCP connect ions have made a direct t ransit ion to the SYN-
RCVD state from the LISTEN state. 

UDP 

udpInDatagram s/ sec: the rate of UDP datagrams being del ivered to UDP users. 
udpNoPorts/ sec: the rate of received UDP datagrams for which there was no appl icat ion at the dest inat ion 
port . 
udpInErrors: the number of received UDP datagrams that could not be del ivered for reasons other than 
the lack of an appl icat ion at the dest inat ion port . 
udpOutDatagram s/ sec: the rate at which UDP datagrams are sent.  

Solaris: Sun System 

Col l i sions/ sec: the rate of output col l isions. 
CpuUser%: the percentage of non-idle processor t ime that is spent in  user mode. 
CpuNice%: the percentage of non-idle processor t ime that is spent in  n ice mode. 
CpuSys%: the percentage of non-idle processor t ime that is spent in  system mode. 
CpuIdle%: the percentage of idle processor t ime. 
I f InPackets/ sec: the rate of input packets. 
I fOutPackets/ sec: the rate of output packets. 
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I f InErrors: the total number of input errors. 
I fOutErrors: the total number of output errors. 
In terrupts/ sec: the rate of system interrupts. 
PagesIn  KBytes/ sec: the rate of pages read in from disk. 
PagesOut  KBytes/ sec: the rate of pages writ ten to disk. 
Sw apIn  KBytes/ sec: the rate at which pages are being swapped in. 
Sw apOut  KBytes/ sec: the rate at which pages are being swapped out. 

HP-UX: HP System 

AvgJobs1: the average number of jobs in  the last minute * 100. 
AvgJobs5: the average number of jobs in  the last 5 minutes * 100. 
AvgJobs15: the average number of jobs in  the last 15 minutes * 100. 
CpuUser%: the percentage of non-idle processor t ime that is spent in  user mode. 
CpuNice%: the percentage of non-idle processor t ime that is spent in  n ice mode. 
CpuSys%: the percentage of non-idle processor t ime that is spent in  system mode. 
CpuIdle%: the percentage of idle processor t ime. 
FreeM em ory KBytes: the amount of idle memory. 
FreeSw ap KBytes: the amount of free swap space on the system. 
M axProc: the maximum number of processes al lowed. 
M axUserM em  KBytes: the amount of maximum user memory on the system. 
PhysM em ory KBytes: the amount of physical memory on the system. 
Users: the number of users logged on to the machine. 

LINUX Memory 

Avai lableSw ap KBytes: the avai lable swap on the system. 
Buf fered KBytes: the amount of memory used as buffers. 
Cached KBytes: the amount of memory cached. 
FreeM em ory KBytes: the amount of idle memory. 
Shared KBytes: the amount of memory shared. 
TotalM em ory KBytes: the total amount of memory on the system. 
TotalSw ap KBytes: the total swap size for the system. 

LINUX System 

CpuUser%: the percentage of non-idle processor t ime that is spent in  user mode. 
CpuNice%: the percentage of non-idle processor t ime that is spent in  n ice mode. 
CpuSys%: the percentage of non-idle processor t ime that is spent in  system mode. 
CpuIdle%: the percentage of idle processor t ime. 

Windows HTTP Server 

h t tpTotalFi l esSen t : the total number of fi les sent by th is HTTP server.  
h t tpTotalFi l esReceived : the total number of fi les received by th is HTTP server.  
h t tpCurren tAnonym ousUsers: the number of anonymous users current ly connected to th is HTTP server.  
h t tpCurren tNonAnon ym ousUsers: the number of non-anonymous users current ly connected to th is 
HTTP server.  
h t tpTotalAnonym ousUsers: the total number of anonymous users that have ever connected to th is HTTP 
server.  
h t tpTotalNonAnonym ousUsers: the total number of non-anonymous users that have ever connected to 
th is HTTP server.  
h t tpM ax im um Anonym ousUsers: the maximum number of anonymous users simultaneously connected 
to th is HTTP server.  
h t tpM ax im um NonAnon ym ousUsers: the maximum number of non-anonymous users simultaneously 
connected to th is HTTP server.  
h t tpCurren tConnect ions: the current number of connect ions to the HTTP server.  
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h t tpM ax im um Connect ions: the maximum number of simultaneous connect ions to the HTTP server.  
h t tpConnect ionAt tem pts: the total number of connect ion attempts to the HTTP server.  
h t tpLogonAt tem pts: the total number of logon attempts to the HTTP server.  
h t tpTotalOpt ions: the total number of requests made to th is HTTP server using the OPTIONS method.  
h t tpTotalGets: the total number of requests made to th is HTTP server using the GET method.  
h t tpTotalPosts: the total number of requests made to th is HTTP server using the POST method.  
h t tpTotalHeads: the total  number of requests made to th is HTTP server using the HEAD method.  
h t tpTotalPuts: the total number of requests made to th is HTTP server using the PUT method.  
h t tpTotalDeletes: the total number of requests made to th is HTTP server using the DELETE method.  
h t tpTotalTraces: the total number of requests made to th is HTTP server using the TRACE method.  
h t tpTotalM ove: the total number of requests made to th is HTTP server using the MOVE method.  
h t tpTotalCopy : the total number of requests made to th is HTTP server using the COPY method.  
h t tpTotalM kcol : the total number of requests made to th is HTTP server using the MKCOL method.  
h t tpTotalPropf ind : the total number of requests made to th is HTTP server using the PROPFIND method.  
h t tpTotalProppatch : the total number of requests made to th is HTTP server using the PROPPATCH 
method.  
h t tpTotalSearch : the total number of requests made to th is HTTP server using the MS-SEARCH method.  
h t tpTotalLock : the total number of requests made to th is HTTP server using the LOCK method.  
h t tpTotalUn lock : the total number of requests made to th is HTTP server using the UNLOCK method.  
h t tpTotalOthers: the total number of requests made to th is HTTP server not using the OPTIONS, GET, 
HEAD, POST, PUT, DELETE, TRACE, MOVE, MKCOL, PROPFIND, PROPPATCH, MS-SEARCH, LOCK or 
UNLOCK methods.  
h t tpCurren tCGIRequests: the number of Common Gateway Interface requests current ly being serviced by 
th is HTTP server.  
h t tpCurren tBGIRequests: the number of Binary Gateway Interface requests current ly being serviced by 
th is HTTP server.  
h t tpTotalCGIRequests: the total number of Common Gateway Interface requests made to th is HTTP 
server.  
h t tpTotalBGIRequests: the total number Binary Gateway Interface requests made to th is HTTP server.  
h t tpM ax im um CGIRequests: the maximum number of Common Gateway In terface requests 
simultaneously processed by th is HTTP server.  
h t tpM ax im um BGIRequests: the maximum number of Binary Gateway Interface requests simultaneously 
processed by th is HTTP server.  
h t tpCurren tBlockedRequests: the current number of requests being temporari ly blocked by th is HTTP 
server.  
h t tpTotalBlockedRequests: the total number of requests that have been temporari ly blocked by th is HTTP 
server.  
h t tpTotalRejectedRequests: the total number of requests that have been rejected by th is HTTP server.  

Windows FTP Server 

f tpTotalFi l esSen t : the total number of fi les sent by th is FTP server. 
f tpTotalFi l esReceived : the total number of fi les received by th is FTP server. 
f tpCurren tAnon ym ousUsers: the number of anonymous users current ly connected to th is FTP server. 
f tpCurren tNonAnonym ousUsers: the number of non-anonymous users current ly connected to th is FTP 
server. 
f tpTotalAnonym ousUsers: the total number of anonymous users that have ever connected to th is FTP 
server. 
f tpTotalNonAnon ym ousUsers: the total number of non-anonymous users that have ever connected to 
th is FTP server. 
f tpM ax im um Anon ym ousUsers: the maximum number of anonymous users simultaneously connected to 
th is FTP server. 
f tpM ax im um NonAnonym ousUsers: the maximum number of non-anonymous users simultaneously 
connected to th is FTP server. 
f tpCurren tConnect ions: the current number of connect ions to the FTP server. 
f tpM ax im um Connect ions: the maximum number of simultaneous connect ions to the FTP server. 
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f tpConnect ionAt tem pts: the total number of connect ion attempts to the FTP server. 
f tpLogonAt tem pts: the total number of logon attempts to the FTP server. 

 

WebLogic Counters 

WebLogic Remote Extended Counters 

The fol lowing dynamical ly discovered WebLogic remote extended counter categories are provided in 
QALoad. Each category provides counters that extend the monitoring of your WebLogic system. The 
categories, counter names, and parameters are al l  dynamical ly discovered by processing the set of MBeans 
avai lable in  the WebLogic JMX Server. 

WebLogic Appl icat ion Runtime 

WebLogic Connector Service Runtime 

WebLogic Deployer Runtime 

WebLogic Domain Log Handler Runt ime 

WebLogic Domain Runtime 

WebLogic EJB Cache Runtime 

WebLogic EJB Component Runt ime 

WebLogic EJB Locking Runtime 

WebLogic EJB Pool Runt ime 

WebLogic EJB Transact ion Runtime 

WebLogic Ent i ty EJB Runtime 

WebLogic Execute Queue Runtime 

WebLogic JDBC Connect ion Pool Runt ime 

WebLogic JMS Connect ion Runtime 

WebLogic JMS Consumer Runtime 

WebLogic JMS Dest inat ion Runtime 

WebLogic JMS Runtime 

WebLogic JMS Server Runt ime 

WebLogic JMS Session Runtime 

WebLogic JTA Recovery Runtime 

WebLogic JTA Runtime   

WebLogic JVM Runtime 

WebLogic Log Broadcaster Runt ime 

WebLogic Message Driven EJB Runtime 

WebLogic M igratable Service Coordinator 
Runt ime 

WebLogic Server Life Cycle Runtime 

WebLogic Server Runt ime 

WebLogic Server Securi ty Runt ime 

WebLogic Servlet Runt ime 

WebLogic Stateful EJB Runtime 

WebLogic Stateless EJB Runtime 

WebLogic Time Service Runtime 

WebLogic Transact ion Resource Runtime 

WebLogic Web App Component Runt ime 

WebLogic Web Server Runt ime 

 

 

 

 

WebLogic Application Runtime 

The WebLogic Appl icat ion Runtime category includes the counters l isted in  the fol lowing table. Some of 
the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  
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CachingDisabled  
Private property that disables caching in  
proxies. 

Boolean No Yes Yes 

Registered 
Returns false i f the MBean represented by 
th is object has been unregistered 

Boolean No Yes Yes 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Application  

The appl icat ion name. You can specify one or more names for monitoring. In  any combinat ion, select 
values from the discovered l ist , or enter values manually. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values and wildcard patterns, a PDP and IDP are returned for each discovered 
combinat ion of parameters. 
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Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Connector Service Runtime 

The WebLogic Connector Service Runtime category includes the counters l isted in  the fol lowing table. 
Some of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled  
Private property that disables caching 
in  proxies. 

Boolean Yes Yes Yes 

Connect ionPoolCurrentCount 
Returns the number of current ly 
deployed connect ion pools.  

In teger Yes Yes Yes 

Connect ionPoolsTotalCount  
Returns the total number of deployed 
connect ion pools instant iated since 
the Server startup. 

In teger Yes Yes Yes 

Registered  
Returns false i f the MBean represented 
by th is object has been unregistered.  

Boolean Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Service  
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Name of the connector service runt ime MBean. You can specify one or more names for monitoring. In  
any combinat ion, select values from the discovered l ist , or enter values manually. 

StatType 

This parameter appl ies on ly to the counters that are return ing a count or total 
(Connect ionPoolCurrentCount is one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Deployer Runtime 

The WebLogic Deployer Runtime category includes the counters l isted in  the fol lowing table. Some of the 
counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables caching in  
proxies.  

Boolean No Yes Yes 
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Registered 
Returns false i f the MBean represented by 
th is object has been unregistered.  

Boolean No Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Deployer 

Name of the deployer run t ime MBean. You can specify one or more names for monitoring. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 
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Recommended minimum is 5 minutes. 

 

WebLogic Domain Log Handler Runtime 

The WebLogic Domain Log Handler Runt ime category includes the counters l isted in  the fol lowing table. 
Some of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables caching in  
proxies.  

Boolean 

 
Yes Yes Yes 

Registered 
Returns false i f the MBean represented by 
th is object has been unregistered.  

Boolean Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Name 

The name of the domain log handler to be monitored. You can specify one or more names for 
monitoring. In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 



QALoad 5.5  

116 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Domain Runtime 

The WebLogic Domain Runtime category includes the counters l isted in  the fol lowing table. Some of the 
counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables 
caching in  proxies. 

Boolean Yes Yes Yes 

CurrentClusterDeploymentTimeout  

Sets the t imeout value in  
mil l iseconds of the curren t 
deployment to a cluster. This is 
set at the beginning of the 
deployment to a cluster and is 
reset after the deployment .  

Long No No Yes 

Registered  
Returns false i f the MBean 
represented by th is object has 
been unregistered. 

Boolean Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 
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Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic EJB Cache Runtime 

The WebLogic EJB Cache Runtime category includes the counters l isted in  the fol lowing table. Some of the 
counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

Activat ionCount  
Returns the total number of t imes the 
EJB was act ivated.  

Long Yes Yes Yes 

CacheAccessCount  
Returns the total number of t imes EJB 
was accessed in the cache. 

Long Yes Yes Yes 

CachedBeansCurrentCount  Returns the current number of cached Integer Yes Yes Yes 
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EJBs.  

CacheHitCount 
Returns the total number of t imes the 
EJB was h it  in  the cache.  

Long Yes Yes Yes 

CacheMissCount 
Returns the total number of t imes an 
attempt to access a bean from the cache 
fai led. 

Long No No Yes 

CachingDisabled 
Private property that disables caching in  
proxies. 

Boolean Yes Yes Yes 

Passivat ionCount  
Returns the total number of t imes the 
EJB was passivated. 

Long Yes Yes Yes 

Registered 
Returns false i f the MBean represented 
by th is object has been unregistered. 

Boolean Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Application 

The appl icat ion prefix of the EJB ear. You can specify one or more appl icat ion  prefixes for monitoring. 
In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Component 

The EJB component prefix of the EJB ear. You can specify one or more component prefixes for 
monitoring. In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Name 

The remainder of the EJB name. You can specify one or more names for monitoring. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

StatType 
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This parameter is avai lable for counters that are return ing a count or total (Act ivat ionCount is one 
example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic EJB Component Runtime 

The WebLogic EJB Component Runt ime category includes the counters l isted in  the fol lowing table. Some 
of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables caching in  
proxies.  

Boolean Yes Yes Yes 

DeploymentState 
Returns current deployment state of the 
module. 

In teger No No  Yes 
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Registered 
Returns false i f the MBean represented by 
th is object has been unregistered. 

Boolean Yes Yes Yes 

Status 

Returns the deployment 's status. The set of 
status is defined in the EJB Deployment 
in terface (DEPLOYED, UNDEPLOYED, 
ERROR). 

In teger Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Application 

The appl icat ion prefix of the EJB ear. You can specify one or more appl icat ion  prefixes for monitoring. 
In  any combinat ion, select values from the discovered l ist , or enter values manually. 

EJBName 

The remainder of the EJB component name. You can specify one or more names for monitoring. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 
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Interval 

Recommended minimum is 5 minutes. 

 

WebLogic EJB Locking Runtime 

The WebLogic EJB Locking Runtime category includes the counters l isted in  the fol lowing table. Some of 
the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled  
Private property that disables caching in  
proxies. 

Boolean Yes Yes No 

LockEntriesCurrentCount 
Returns the number of current EJB lock 
entries.  

In teger Yes Yes No 

LockManagerAccessCount 
Returns the number of accesses to the 
lock manager.  

Long Yes Yes No 

Registered 
Returns false i f the MBean represented 
by th is object has been unregistered. 

Boolean Yes Yes No 

TimeoutTotalCount 
Returns the number of objects t imed 
out whi le wait ing on the lock. 

Long Yes Yes No 

WaiterTotalCount  
Returns the number of objects wait ing 
on the lock.  

Long Yes Yes No 

 

Parameters 
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The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Application 

The appl icat ion prefix of the EJB ear. You can specify one or more appl icat ion  prefixes for monitoring. 
In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Component 

The EJB component prefix of the EJB ear. You can specify one or more component prefixes for 
monitoring. In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Name 

The remainder of the EJB name. You can specify one or more names for monitoring. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total (LockEntriesCurrentCount is 
one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 
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Interval 

Recommended minimum is 5 minutes. 

 

WebLogic EJB Pool Runtime 

The WebLogic EJB Pool Runt ime category includes the counters l isted in  the fol lowing table. Some of the 
counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

AccessTotalCount 

Returns the total number of 
t imes an attempt was made to 
get an instance from the free 
pool. 

Long no No Yes 

BeansInUseCount 
Returns the number of beans 
current ly in  use. 

In teger  Yes  Yes Yes 

BeansInUseCurrentCount 
Returns the number of bean 
instances current ly in  use from 
the free pool. 

In teger No No Yes 

CachingDisabled  
Private property that disables 
caching in  proxies. 

Boolean Yes Yes Yes 

DestroyedTotalCount 

Returns the total number of 
t imes a bean instance from th is 
pool was destroyed due to a 
non-appl icat ion Except ion being 
thrown from it . 

Long No No Yes 

IdleBeansCount  
Returns the number of idle 
beans in th is EJB. 

Integer Yes Yes Yes 
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MissTotalCount 

Returns the total number of 
t imes a fai led attempt was made 
to get an instance from the free 
pool. An attempt to get a bean 
from the pool fai ls i f there are 
no avai lable instances in  the 
pool.  

Long No No Yes 

PooledBeansCurrentCount 
Returns the current number of 
avai lable bean instances in  the 
free pool.  

In teger No No Yes 

Registered 
Returns false i f the MBean 
represented by th is object has 
been unregistered. 

Boolean Yes Yes Yes 

TimeoutTotalCount  
Returns the total number of 
t imed out transact ions. 

Long Yes Yes Yes 

WaiterCurrentCount  
Returns the current number of 
avai lable bean instances in  the 
free pool.  

In teger No No Yes 

WaiterTotalCount  
Returns the number of EJBs 
current ly wait ing. 

Long Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Application 

The appl icat ion prefix of the EJB ear. You can specify one or more appl icat ion  prefixes for monitoring. 
In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Component 
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The EJB component prefix of the EJB ear. You can specify one or more component prefixes for 
monitoring. In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Name 

The remainder of the EJB name. You can specify one or more names for monitoring. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total (BeansInUseCount is one 
example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic EJB Transaction Runtime 

The WebLogic EJB Transact ion Runtime category includes the counters l isted in  the fol lowing table. Some 
of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 



QALoad 5.5  

126 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables 
caching in  proxies. 

Boolean Yes Yes Yes 

Registered 
Returns false i f the MBean 
represented by th is object has 
been unregistered. 

Boolean Yes Yes Yes 

Transact ionsCommittedTotalCount 
Returns the total number of EJB 
transact ions that were 
committed. 

Long Yes Yes Yes 

Transact ionsRolledBackTotalCount 
Returns the total number of EJB 
transact ions rol led back. 

Long Yes Yes Yes 

Transact ionsTimedOutTotalCount  
Returns the total number of EJB 
transact ions that t imed out.  

Long Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Application 

The appl icat ion prefix of the EJB ear. You can specify one or more appl icat ion  prefixes for monitoring. 
In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Component 

The EJB component prefix of the EJB ear. You can specify one or more component prefixes for 
monitoring. In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Name 

The remainder of the EJB name. You can specify one or more names for monitoring. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 
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StatType 

This parameter is avai lable for counters that are return ing a count or total 
(Transact ionsCommittedTotalCount is one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Entity EJB Runtime 

The WebLogic Ent i ty EJB Runtime category includes the counters l isted in  the fol lowing table. Some of the 
counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled  
Private property that disables caching in  
proxies.  

Boolean Yes Yes Yes 

Registered 
Returns false i f the MBean represented by 
th is object has been unregistered. 

Boolean Yes Yes Yes 
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Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Application 

The appl icat ion prefix of the EJB ear. You can specify one or more appl icat ion  prefixes for monitoring. 
In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Component 

The EJB component prefix of the EJB ear. You can specify one or more component prefixes for 
monitoring. In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Name 

The remainder of the EJB name. You can specify one or more names for monitoring. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 
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Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Execute Queue Runtime 

The WebLogic Execute Queue Runtime category includes the counters l isted in  the fol lowing table. Some 
of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables 
caching in  proxies. 

Boolean Yes Yes Yes 

ExecuteThreadCurrentIdleCount 
Returns the number of idle threads 
assigned to the queue. 

Integer Yes Yes Yes 

ExecuteThreadTotalCount  
Returns the total number of 
execute threads assigned to the 
queue. 

Integer No No Yes 

PendingRequestCurrentCount  
Returns the number of wait ing 
requests in  the queue. 

Integer Yes Yes Yes 

PendingRequestOldestTime 
Returns the t ime that the longest 
wait ing request was placed in the 
queue.  

Long Yes Yes Yes 

Registered 
Returns false i f the MBean 
represented by th is object has been 
unregistered. 

Boolean Yes Yes Yes 

ServicedRequestTotalCount 
Returns the number of requests 
that have been processed by th is 
queue. 

Integer Yes Yes Yes 
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Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Queue 

The execut ion queue name. You can specify one or more names for monitoring. In  any combinat ion, 
select values from the discovered l ist , or enter values manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total (ExecuteThreadTotalCount is 
one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 
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Interval 

Recommended minimum is 5 minutes. 

 

WebLogic JDBC Connection Pool Runtime 

The WebLogic JDBC Connect ion Pool Runt ime category includes the counters l isted in  the fol lowing table. 
Some of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

ActiveConnect ionsAverageCount  

Returns the running average 
of act ive connect ions in  the 
th is MBean. The count starts 
at zero each t ime the MBean is 
instant iated.  

In teger No No Yes 

Act iveConnect ionsCurrentCount  
Returns the current number of 
act ive connect ions. 

In teger Yes Yes Yes 

Act iveConnect ionsHighCount  

Returns the h ighest number of 
act ive current connect ions. 
The count starts at zero each 
t ime the 
JDBCConnect ionPoolRuntime 
MBean is instant iated. 

In teger Yes Yes Yes 

CachingDisabled 
Private property that disables 
caching in  proxies. 

Boolean Yes Yes Yes 

Connect ionDelayTime  

Returns the number of 
mil l iseconds i t  takes to get a 
physical connect ion from 
database. It  is calculated as 
summary t ime to connect , 

In teger Yes Yes Yes 
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divided by summary number 
of connect ions. 

Connect ionLeakProfi leCount  
Returns the current number of 
connect ion leak profi les in  the 
profi le storage. 

Integer Yes Yes Yes 

Connect ionsTotalCount 

Returns the total number of 
JDBC connect ions in  th is 
JDBCConnect ionPoolRuntime 
MBean since the pool was 
instant iated.  

In teger Yes Yes Yes 

Fai luresToReconnectCount  

Returns the count of at tempts 
to refresh a connect ion to a 
database that fai led. Fai lure 
may happen because of 
database unavai labi l i ty or a 
broken connect ion to the 
database.  

In teger Yes Yes Yes 

HighestNumAvailable 
Returns the h ighest number of 
avai lable connect ions in  th is 
pool. 

In teger No No Yes 

HighestNumUnavailable 
Returns the h ighest number of 
unavai lable connect ions in  
th is pool. 

In teger No No Yes 

LeakedConnect ionCount  

Returns the number of 
connect ions that were 
checked out from the 
connect ion pool but were not 
returned to the pool by cal l ing 
close ().  

In teger Yes Yes Yes 

MaxCapacity 
Returns the maximum 
capacity of th is connect ion 
pool. 

In teger Yes Yes Yes 

NumAvailable 
Returns the number of 
avai lable connect ions in  th is 
pool. 

In teger No No  Yes 

NumUnavailable 
Returns the number of 
unavai lable connect ions in  
th is pool. 

In teger No No Yes 

PoolState  
Returns true i f the pool is 
enabled, false i f the pool is 
disabled. 

Boolean Yes Yes Yes 

PreparedStatementCacheProfi leCount 

Returns the number of 
prepared statement cache 
profi l ing stores cache 
snapshots that are in  external 

In teger Yes Yes Yes 
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storage. 

PrepStmtCacheHitCount 
Returns the cumulat ive, 
running count of the use of 
each cached statement. 

In teger Yes Yes Yes 

PrepStmtCacheMissCount 

Returns a count of the cases 
when the cache does not have 
a cached statement to sat isfy a 
request. 

In teger Yes Yes Yes 

Registered 
Returns false i f the MBean 
represented by th is object has 
been unregistered.  

Boolean Yes Yes Yes 

StatementProfi leCount 
Returns the number of 
statement profi l ing stores in  
external storage. 

Integer Yes Yes Yes 

Wait ingForConnect ionCurrentCount  
Returns the current number of 
requests wait ing for a 
connect ion. 

In teger Yes Yes Yes 

Wait ingForConnect ionHighCount 

Returns the h ighest number of 
requests wait ing for a 
connect ion. The count starts 
at zero each t ime the 
JDBCConnect ionPoolRuntime 
MBean is instant iated.  

In teger Yes Yes Yes 

WaitSecondsHighCount 
Returns the h ighest number of 
seconds a connect ion wai ted.  

In teger Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 
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Pool 

The connect ion pool name. You can specify one or more names for monitoring. In  any combinat ion, 
select values from the discovered l ist , or enter values manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total (Connect ionsTotalCount is 
one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 
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WebLogic JMS Connection Runtime 

The WebLogic JMS Connect ion Runtime category includes the counters l isted in  the fol lowing table. Some 
of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled  
Private property that disables caching in  
proxies. 

Boolean No Yes Yes 

Registered 
Returns false i f the MBean represented by 
th is object has been unregistered. 

Boolean No Yes Yes 

SessionsCurrentCount 
Returns the current number of sessions 
for th is connect ion. 

Long  No Yes Yes 

SessionsHighCount 
Returns the peak number of sessions for 
th is connect ion since the last reset. 

Long  No Yes Yes 

SessionsTotalCount 
Returns the number of sessions on th is 
connect ion since the last reset. 

Long  No  Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Connection 

The JMS connect ion name. You can specify one or more names for monitoring. In  any combinat ion, 
select values from the discovered l ist , or enter values manually. 

StatType 
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This parameter is avai lable for counters that are return ing a count or total (SessionsTotalCount is one 
example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic JMS Consumer Runtime 

The WebLogic JMS Consumer Runtime category includes the counters l isted in  the fol lowing table. Some 
of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

Active 

Determines i f the consumer is act ive. 
Determines whether the consumer has a 
message l istener set up or a synchronous 
receive in  progress. 

Boolean No Yes Yes 
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BytesPendingCount 
Returns the number of bytes pending 
(uncommitted and unacknowledged) by 
th is consumer. 

Long No  Yes Yes 

BytesReceivedCount 
Returns the number of bytes received by 
th is consumer since the last reset. 

Long No Yes Yes 

CachingDisabled 
Private property that disables caching in  
proxies.  

Boolean No Yes Yes 

Durable 
Determines whether the consumer is 
durable.  

Boolean No Yes Yes 

MessagesPendingCount 
Returns the number of messages pending 
(uncommitted and unacknowledged) by 
th is consumer. 

Long No Yes Yes 

MessagesReceivedCount 
Returns the number of messages received 
by th is consumer since the last reset. 

Long No Yes Yes 

Registered  
Returns false i f the MBean represented 
by th is object has been unregistered. 

Boolean No Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Consumer 

The JMS consumer name. You can specify one or more names for monitoring. In  any combinat ion, 
select values from the discovered l ist , or enter values manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total (M essagesReceivedCount is 
one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 
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 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic JMS Destination Runtime 

The WebLogic JMS Dest inat ion Runtime category includes the counters l isted in  the fol lowing table. Some 
of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

BytesCurrentCount 
Returns the current number of bytes 
stored in  the dest inat ion. This does not 
include the pending bytes.  

Long No Yes Yes 

BytesHighCount  
Returns the peak number of bytes stored 
in  the dest inat ion since the last reset. 

Long No Yes Yes 
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BytesPendingCount 

Returns the number of pending bytes 
stored in  the dest inat ion. Pending bytes 
are over and above the current number 
of bytes.  

Long No Yes Yes 

BytesReceivedCount 
Returns the number of bytes received in 
th is dest inat ion since the last reset. 

Long No Yes Yes 

BytesThresholdTime 
Returns the amount of t ime in the 
threshold condit ion since the last reset.  

Long No Yes Yes 

CachingDisabled 
Private property that disables caching in  
proxies.  

Boolean No Yes Yes 

ConsumersCurrentCount 
Returns the current number of 
consumers accessing th is dest inat ion.  

Long No Yes Yes 

ConsumersHighCount 
Returns the peak number of consumers 
accessing th is dest inat ion since the last 
reset. 

Long No Yes Yes 

ConsumersTotalCount  
Returns the total number of consumers 
accessing th is dest inat ion since the last 
reset.  

Long No Yes Yes 

MessagesCurrentCount 
Returns the current number of messages 
in the dest inat ion. This does not include 
the pending messages.  

Long No Yes Yes 

MessagesHighCount 
Returns the peak number of messages in 
the dest inat ion since the last reset.  

Long No Yes Yes 

MessagesPendingCount 

Returns the number of pending messages 
in the dest inat ion. Pending messages are 
over and above the curren t number of 
messages. A pending message is one that 
has either been sent in  a transact ion and 
not committed, or that has been 
received and not committed or 
acknowledged.  

Long No Yes Yes 

MessagesReceivedCount 
Returns the number of messages received 
in th is dest inat ion since that reset. 

Long No Yes Yes 

MessagesThresholdTime  
Returns the amount of t ime in the 
threshold condit ion since the last reset.  

Long No Yes Yes 

Registered  
Returns false i f the MBean represented 
by th is object has been unregistered.  

Boolean No Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
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between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Destination 

The name of the JMS dest inat ion. You can specify one or more names for monitoring. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total (M essagesReceivedCount is 
one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 
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Interval 

Recommended minimum is 5 minutes. 

 

WebLogic JMS Runtime 

The WebLogic JMS Runtime category includes the counters l isted in  the fol lowing table. Some of the 
counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables caching in  
proxies. 

Boolean Yes Yes Yes 

Connect ionsCurrentCount 
Returns the current number of 
connect ions to th is WebLogic Server.  

Long Yes Yes Yes 

Connect ionsHighCount 
Returns the peak number of 
connect ions to th is WebLogic Server 
since the last reset.  

Long Yes Yes Yes 

Connect ionsTotalCount 
Returns the total number of 
connect ions made to th is WebLogic 
Server since the last reset.  

Long Yes Yes Yes 
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JMSServersCurrentCount 
Returns the current number of JMS 
servers that are deployed on th is 
WebLogic Server instance.  

Long Yes Yes Yes 

JMSServersHighCount 

Returns the peak number of JMS servers 
that were deployed on th is WebLogic 
Server instance since the server was 
started. 

Long Yes Yes Yes 

JMSServersTotalCount 
Returns the number of JMS servers that 
were deployed on th is WebLogic Server 
instance since the server was started.  

Long Yes Yes Yes 

Registered 
Returns false i f the MBean represented 
by th is object has been unregistered. 

Boolean Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

JMSServer 

The JMS server name. You can specify one or more names for monitoring. In  any combinat ion, select 
values from the discovered l ist , or enter values manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total (Connect ionsTotalCount is 
one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 
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For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic JMS Server Runtime 

The WebLogic JMS Server Runt ime category includes the counters l isted in  the fol lowing table. Some of the 
counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

BytesCurrentCount  
Returns the current number of bytes 
stored on th is JMS server. This does not 
include the pending bytes. 

Long No Yes Yes 

BytesHighCount 
Returns the peak number of bytes 
stored in  the JMS server since the last 
reset.  

Long No Yes Yes 
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BytesPendingCount 

Returns the current number of bytes 
pending (unacknowledged or 
uncommitted) stored on th is JMS 
server. Pending bytes are over and 
above the current number of bytes.  

Long No Yes Yes 

BytesReceivedCount 
Returns the number of bytes received 
on th is JMS server since the last reset. 

Long No Yes Yes 

BytesThresholdTime 
Returns the amount of t ime in the 
threshold condit ion since the last reset.  

Long No Yes Yes 

CachingDisabled 
Private property that disables caching in  
proxies. 

Boolean No Yes Yes 

Dest inat ionsCurrentCount 
Returns the current number of 
dest inat ions for th is JMS server.  

Long No Yes Yes 

Dest inat ionsHighCount  
Returns the peak number of 
dest inat ions on th is JMS server since 
the last reset.  

Long No Yes Yes 

Dest inat ionsTotalCount 
Returns the number of dest inat ions 
instant iated on th is JMS server since the 
last reset. 

Long No Yes Yes 

MessagesCurrentCount 
Returns the current number of messages 
stored on th is JMS server. This does not 
include the pending messages.  

Long No Yes Yes 

MessagesHighCount 
Returns the peak number of messages 
stored in  the JMS server since the last 
reset.  

Long No Yes  Yes 

MessagesPendingCount 

Returns the current number of messages 
pending (unacknowledged or 
uncommitted) stored on th is JMS 
server. Pending messages are over and 
above the current number of messages.  

Long No Yes  Yes 

MessagesReceivedCount  
Returns the number of messages 
received on th is dest inat ion since the 
last reset. 

Long No Yes  Yes 

MessagesThresholdTime 
Returns the amount of t ime in the 
threshold condit ion since the last reset. 

Long No Yes  Yes 

Registered 
Returns false i f the MBean represented 
by th is object has been unregistered. 

Boolean No Yes Yes 
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SessionPoolsCurrentCount 
Returns the current number of session 
pools instant iated on th is JMS server. 

Long No Yes  Yes 

SessionPoolsHighCount 
Returns the peak number of session 
pools instant iated on th is JMS server 
since the last reset.  

Long No Yes  Yes 

SessionPoolsTotalCount 
Returns the number of session pools 
instant iated on th is JMS server since the 
last reset. 

Long No Yes  Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

JMSServer 

The JMS server name. You can specify one or more names for monitoring. In  any combinat ion, select 
values from the discovered l ist , or enter values manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total (SessionPoolsTotalCount is 
one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 
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The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic JMS Session Runtime 

The WebLogic JMS Session Runtime category includes the counters l isted in  the fol lowing table. Some of 
the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

BytesPendingCount 
Returns the number of bytes pending 
(uncommitted and unacknowledged) for 
th is session. 

Long No Yes Yes 

BytesReceivedCount 
Returns the number of bytes received by 
th is session since the last reset. 

Long No Yes Yes 

BytesSentCount 
Returns the number of bytes sent by th is 
session since the last reset. 

Long No Yes Yes 
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CachingDisabled 
Private property that disables caching in  
proxies.  

Boolean No Yes Yes 

ConsumersCurrentCount 
Returns the current number of 
consumers for th is session.  

Long No Yes Yes 

ConsumersHighCount  
Returns the peak number of consumers 
for th is session since the last reset.  

Long No Yes Yes 

ConsumersTotalCount 
Returns the number of consumers 
instant iated by th is session since the last 
reset.  

Long No Yes Yes 

MessagesPendingCount 
Returns the number of messages pending 
(uncommitted and unacknowledged) for 
th is session.  

Long No Yes Yes 

MessagesReceivedCount 
Returns the number of messages sent by 
th is session since the last reset.  

Long No Yes Yes 

MessagesSentCount  
Returns the number of bytes sent by th is 
session since the last reset.  

Long No Yes Yes 

ProducersCurrentCount  
Returns the current number of producers 
for th is session. 

Long No Yes Yes 

ProducersHighCount  
Returns the peak number of producers 
for th is session since the last reset. 

Long No Yes Yes 

ProducersTotalCount  
Returns the number of producers for th is 
session since the last reset.  

Long No Yes Yes 

Registered 
Returns false i f the MBean represented 
by th is object has been unregistered. 

Boolean No Yes Yes 

Transacted  
Returns whether the session is 
transacted. 

Boolean No Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 
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WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Session 

The JMS session name. You can select a value from the discovered l ist . 

StatType 

This parameter is avai lable for counters that are return ing a count or total (ConsumersTotalCount is 
one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 
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WebLogic JTA Recovery Runtime 

The WebLogic JTA Recovery Runtime category includes the counters l isted in  the fol lowing table. Some of 
the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

Active  

Returns whether the 
Transact ion Recovery 
Service is current ly 
act ivated on th is server. 

Boolean No Yes Yes 

CachingDisabled  
Private property that 
disables caching in  
proxies. 

Boolean No Yes Yes 

In it ialRecoveredTransact ionTotalCount 

Returns the total number 
of t ransact ions that are 
recovered from the 
Transact ion Log in i t ial ly. 

In teger No Yes Yes 

RecoveredTransact ionComplet ionPercent  

Returns the percentage of 
the in i t ial ly recovered 
transact ions that are 
completed. 

In teger No  Yes Yes 

Registered 
Returns false i f the MBean 
represented by th is object 
has been unregistered. 

Boolean No Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 
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WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total 
(In i t ialRecoveredTransact ionTotalCount is one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic JTA Runtime 

The WebLogic JTA Runtime category includes the counters l isted in  the fol lowing table. Some of the 
counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  
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ActiveTransact ionsTotalCount 
Returns the number of 
act ive transact ions on 
the server.  

In teger Yes Yes Yes 

CachingDisabled 
Private property that 
disables caching in  
proxies.  

Boolean Yes Yes Yes 

Registered 

Returns false i f the 
MBean represented by 
th is object has been 
unregistered. 

Boolean Yes Yes Yes 

SecondsAct iveTotalCount   

Returns the total 
number of seconds for 
al l  committed 
transact ions 

Long Yes Yes Yes 

Transact ionAbandonedTotalCount 
Returns the number of 
t ransact ions that were 
abandoned. 

Long Yes Yes Yes 

Transact ionCommittedTotalCount 
Returns the number of 
committed 
transact ions. 

Long Yes Yes Yes 

Transact ionHeurist icsTotalCount  

Returns the number of 
t ransact ions that 
completed with a 
heurist ic status.  

Long Yes Yes Yes 

Transact ionRolledBackAppTotalCount 

Returns the number of 
t ransact ions that were 
rol led back due to an 
appl icat ion error. 

Long Yes Yes Yes 

Transact ionRolledBackResourceTotalCount  

Returns the number of 
t ransact ions that were 
rol led back due to a 
resource error.  

Long Yes Yes Yes 

Transact ionRolledBackSystemTotalCount 

Returns the number of 
t ransact ions that were 
rol led back due to an 
in ternal system error.  

Long Yes Yes Yes 

Transact ionRolledBackTimeoutTotalCount 

Returns the number of 
t ransact ions that were 
rol led back due to a 
t imeout expirat ion. 

Long Yes Yes Yes 

Transact ionRolledBackTotalCount 

Returns the number of 
t ransact ions that were 
rol led back.  

 

Long Yes Yes Yes 
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Transact ionTotalCount  

Returns the total 
number of t ransact ions 
processed. This total 
includes al l  committed, 
rol led back and 
heurist ic transact ion 
complet ions. 

Long Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

JTA 

The JTA MBean name. You can specify one or more names for monitoring. In  any combinat ion, select 
values from the discovered l ist , or enter values manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total (Transact ionTotalCount is 
one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 
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Interval 

Recommended minimum is 5 minutes.  

 

WebLogic JVM Runtime 

The WebLogic JVM Runtime category includes the counters l isted in  the fol lowing table. Some of the 
counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled  
Private property that disables caching in  
proxies.  

Boolean Yes Yes Yes 

HeapFreeCurrent 
Returns the current amount of free 
memory (in  bytes) in  the JVM heap. 

Long Yes Yes Yes 

HeapSizeCurrent 
Returns the current size (in  bytes) of the 
JVM heap. 

Long Yes Yes Yes 

Registered 
Returns false i f the MBean represented by 
th is object has been unregistered. 

Boolean Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
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parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Log Broadcaster Runtime 

The WebLogic Log Broadcaster Runt ime category includes the counters l isted in  the fol lowing table. Some 
of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
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WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables caching in  
proxies. 

Boolean Yes Yes Yes 

MessagesLogged 
Returns the total number of log messages 
generated by th is instance of the 
WebLogic server. 

Long Yes Yes Yes 

Registered 
Returns false i f the MBean represented by 
th is object has been unregistered. 

Boolean Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Name 

The name of the log broadcaster. You can specify one or more names for monitoring. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total (M essagesLogged in th is 
counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 
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For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Message Driven EJB Runtime 

The WebLogic Message Driven EJB Runtime category includes the counters l isted in  the fol lowing table. 
Some of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables caching in  
proxies.  

Boolean No Yes Yes 

JMSConnect ionAlive 
Returns the state of the EJB's JMS 
connect ion.  

Boolean No Yes Yes 

Registered  
Returns false i f the MBean represented by 
th is object has been unregistered 

Boolean No Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 
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Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Application 

The appl icat ion prefix of the EJB ear. You can specify one or more appl icat ion  prefixes for monitoring. 
In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Component 

The EJB component prefix of the EJB ear. You can specify one or more component prefixes for 
monitoring. In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Name 

The remainder of the EJB name. You can specify one or more names for monitoring. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 
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WebLogic Migratable Service Coordinator Runtime 

The WebLogic M igratable Service Coordinator Runt ime category includes the counters l isted in  the 
fol lowing table. Some of the counters l isted in  the table may not be avai lable on your system. WebLogic 
counter categories, counter names, and parameters are dynamical ly discovered by processing the set of 
MBeans in the WebLogic JMX Server. Which counters are discovered is determ ined by the WebLogic 
version you are running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables caching in  
proxies. 

Boolean No Yes Yes 

Registered 
Returns false i f the MBean represented by 
th is object has been unregistered. 

Boolean No Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Service 

The name of the migratable service coordinator. You can specify one or more names for monitoring. In  
any combinat ion, select values from the discovered l ist , or enter values manually. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 
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Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Server Life Cycle Runtime 

The WebLogic Server Life Cycle Runtime category includes the counters l isted in  the fol lowing table. Some 
of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables caching in  
proxies.  

Boolean No Yes Yes 

Registered 
Returns false i f the MBean represented by 
th is object has been unregistered. 

Boolean No Yes Yes 

StateVal 
Returns an in teger that ident i fies the 
current state of the server. Values range 
from 0 to 8.  

In teger No  Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 
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Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Name 

The appl icat ion server name. You can specify one or more names for monitoring. In  any combinat ion, 
select values from the discovered l ist , or enter values manually. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Server Runtime 

The WebLogic Server Runt ime category includes the counters l isted in  the fol lowing table. Some of the 
counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

Activat ionTime 
Returns the t ime when the server was 
started. 

Long Yes Yes Yes 
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Administrat ionPort 
Returns the administrat ion port  on 
which th is server is l istening for 
connect ions. 

In teger No Yes Yes 

Administrat ionPortEnabled  
Returns whether the 
Administrat ionPort is enabled on the 
server. 

Boolean No Yes Yes 

AdminServer 
Checks i f the server is an 
administrator server.  

Boolean No Yes Yes 

AdminServerListenPort 
Returns the port  on which admin 
server is l istening for connect ions. 

In teger Yes Yes Yes 

AdminServerListenPortSecure 
Returns the secureType on which 
admin server is l istening for 
connect ions. 

Boolean No Yes Yes 

CachingDisabled  
Private property that disables caching 
in  proxies.  

Boolean Yes Yes Yes 

ListenPort  
Returns the port  on which th is server 
is l istening for connect ions. 

In teger Yes Yes Yes 

ListenPortEnabled 
Returns whether the default  
ListenPort is enabled on the server. 

Boolean No Yes Yes 

OAMVersion 
Returns the OAM version in fo. 
Indicates release level of th is server. 

In teger No Yes Yes 

OpenSocketsCurrentCount  
Returns the current number sockets 
registered for socket muxing on th is 
server. 

In teger Yes Yes Yes 

Registered  
Returns false i f the MBean 
represented by th is object has been 
unregistered. 

Boolean Yes Yes Yes 

RestartsTotalCount 
Returns the total number of restarts 
for th is server since the cluster was 
last act ivated. 

In teger Yes Yes Yes 

SocketsOpenedTotalCount  
Returns the total number of 
registrat ions for socket muxing on 
th is server.  

Long Yes Yes Yes 

SSLListenPort 
Returns the port  on which th is server 
is l istening for SSL connect ions 

Integer No Yes Yes 

SSLListenPortEnabled 
Returns i f the default  lSSListenPort is 
enabled on the server. 

Boolean No Yes Yes 
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StateVal  Returns current state of the server.  
In teger 

 
No Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total (SocketsOpenedTotalCount 
is one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 
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Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Server Security Runtime 

The WebLogic Server Securi ty Runt ime category includes the counters l isted in  the fol lowing table. Some of 
the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that 
disables caching in  proxies. 

Boolean Yes Yes Yes 

Inval idLoginAttemptsTotalCount 
Returns the cumulat ive 
number of inval id logins 
attempted on th is server. 

Long Yes Yes Yes 

Inval idLoginUsersHighCount  
Returns the h ighest number 
of users with outstanding 
inval id login attempts for 

Long Yes Yes Yes 
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th is server. 

LockedUsersCurrentCount  
Returns the number of 
current ly locked users on 
th is server. 

Long Yes Yes Yes 

LoginAttemptsWhileLockedTotalCount 

Returns the cumulat ive 
number of inval id logins 
attempted on th is server 
whi le the user was locked. 

Long Yes Yes Yes 

Registered  
Returns false i f the MBean 
represented by th is object 
has been unregistered.  

Boolean Yes Yes Yes 

UnlockedUsersTotalCount 
Returns the number of 
t imes a user was unlocked 
on th is server. 

Long Yes Yes Yes 

UserLockoutTotalCount 
Returns the cumulat ive 
number of user lockouts 
done on th is server. 

Long Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total 
(Inval idLoginAttemptsTotalCount is one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 



QALoad Online Help 

165 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Servlet Runtime 

The WebLogic Appl icat ion Runtime category includes the counters l isted in  the fol lowing table. Some of 
the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables caching in  
proxies. 

Boolean Yes Yes Yes 

Execut ionTimeAverage 
Returns the average amount of t ime al l  
invocat ions of the servlet have executed 
since i t  was created.  

In teger Yes Yes Yes 

Execut ionTimeHigh 
Returns the amount of t ime the single 
longest invocat ion of the servlet has 
executed since i t  was created. 

In teger Yes Yes Yes 
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Execut ionTimeLow 

Returns the amount of t ime the single 
shortest invocat ion of the servlet has 
executed since i t  was created. Note: For 
the CounterMonitor, the difference 
opt ion must be used. 

Integer Yes Yes Yes 

Execut ionTimeTotal  
Returns the amount of t ime al l  
invocat ions of the servlet has executed 
since i t  was created. 

In teger Yes Yes Yes 

InternalServlet 
Returns whether th is is an Internal 
Servlet. 

Boolean No No  Yes 

Invocat ionTotalCount 
Returns the total number of t imes the 
servlet has been invoked. 

Integer Yes Yes Yes 

PoolMaxCapacity 
Returns the maximum capacity of th is 
servlet for single thread model servlets.  

In teger Yes Yes Yes 

Registered  
Returns false i f the MBean represented by 
th is object has been unregistered 

Boolean Yes Yes Yes 

ReloadTotalCount 
Returns the total number of t imes the 
servlet has been reloaded. 

Integer Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Application 

The appl icat ion name. You can specify one or more names for monitoring. In  any combinat ion, select 
values from the discovered l ist , or enter values manually. 

Servlet 

The servlet name. You can specify one or more names for monitoring. In  any combinat ion, select 
values from the discovered l ist , or enter values manually. 
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StatType 

This parameter is avai lable for counters that are return ing a count or total (Invocat ionTotalCount is 
one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Stateful EJB Runtime 

The WebLogic Stateful EJB Runtime category includes the counters l isted in  the fol lowing table. Some of 
the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 
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Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables caching in  
proxies. 

Boolean Yes Yes No 

Registered 
Returns false i f the MBean represented by 
th is object has been unregistered.  

Boolean Yes Yes No  

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Application 

The appl icat ion prefix of the EJB ear. You can specify one or more appl icat ion  prefixes for monitoring. 
In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Component 

The EJB component prefix of the EJB ear. You can specify one or more component prefixes for 
monitoring. In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Name 

The remainder of the EJB name. You can specify one or more names for monitoring. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 
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Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Stateless EJB Runtime 

 The WebLogic Stateless EJB Runtime category includes the counters l isted in  the fol lowing table. Some of 
the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that disables caching 
in  proxies. 

Boolean Yes Yes Yes 

Registered  
Returns false i f the MBean represented 
by th is object has been unregistered. 

Boolean Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 
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WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Application 

The appl icat ion prefix of the EJB ear. You can specify one or more appl icat ion  prefixes for monitoring. 
In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Component 

The EJB component prefix of the EJB ear. You can specify one or more component prefixes for 
monitoring. In  any combinat ion, select values from the discovered l ist , or enter values manually. 

Name 

The remainder of the EJB name. You can specify one or more names for monitoring. In  any 
combinat ion, select values from the discovered l ist , or enter values manually. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Time Service Runtime 

The WebLogic Time Service Runtime category includes the counters l isted in  the fol lowing table. Some of 
the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters Descript i on  Type WL WL WL 
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6.x  7.x  8.x  

CachingDisabled 
Private property that disables caching in  
proxies. 

Boolean Yes Yes Yes 

Except ionCount 
Returns the total number of except ions 
thrown while execut ing scheduled 
triggers. 

In teger Yes Yes Yes 

Execut ionCount 
Returns the total number of t riggers 
executed. 

In teger Yes Yes Yes 

Execut ionsPerM inute 
Returns the average number of t riggers 
executed per minute. 

In teger Yes Yes Yes 

Registered 
Returns false i f the MBean represented by 
th is object has been unregistered. 

Boolean Yes Yes Yes 

ScheduledTriggerCount 
Returns the number of current ly act ive 
scheduled triggers.  

In teger Yes Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Name 

The name of the t ime service. You can specify one or more names for monitoring. In  any combinat ion, 
select values from the discovered l ist , or enter values manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total (Execut ionCount is one 
example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
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task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Transaction Resource Runtime 

The WebLogic Transact ion Resource Runtime category includes the counters l isted in  the fol lowing table. 
Some of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled 
Private property that 
disables caching in  proxies.  

Boolean No Yes Yes 

Registered 
Returns false i f the MBean 
represented by th is object 
has been unregistered. 

Boolean No Yes Yes 

Transact ionCommittedTotalCount  
Returns the number of 
committed transact ions. 

Long No Yes Yes 
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Transact ionHeurist icCommitTotalCount 

Returns the number of 
t ransact ions for which th is 
resource has returned a 
heurist ic commit decision .  

Long No Yes Yes 

Transact ionHeurist icHazardTotalCount 

Returns the number of 
t ransact ions for which th is 
resource has reported a 
heurist ic hazard decision.  

Long No Yes Yes 

Transact ionHeurist icM ixedTotalCount 

Returns the number of 
t ransact ions for which th is 
resource has reported a 
heurist ic mixed decision. 

Long No Yes Yes 

Transact ionHeurist icRollbackTotalCount 

Returns the number of 
t ransact ions for which th is 
resource has returned a 
heurist ic rol lback decision.  

Long No Yes Yes 

Transact ionHeurist icsTotalCount 

Returns the number of 
t ransact ions that 
completed with a heurist ic 
status. 

Long No Yes Yes 

Transact ionRolledBackTotalCount 
Returns the number of 
t ransact ions that were 
rol led back. 

Long No Yes Yes 

Transact ionTotalCount 

Returns the total number 
of t ransact ions processed. 
This total includes al l  
committed, rol led back 
and heurist ic transact ion 
complet ions. 

Long No Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 
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WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Transaction Runtime 

The JTA runt ime name. You can specify one or more names for monitoring. In  any combinat ion, select  
values from the discovered l ist , or enter values manually. 

Component 

The JTA component name. You can specify one or more names for monitoring. In  any combinat ion, 
select values from the discovered l ist , or enter values manually. 

StatType 

This parameter is avai lable for counters that are return ing a count or total 
(Transact ionCommittedTotalCount is one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 



QALoad Online Help 

175 

Recommended minimum is 5 minutes. 

 

WebLogic Web App Component Runtime 

The WebLogic Web App Component Runt ime category includes the counters l isted in  the fol lowing table. 
Some of the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, 
counter names, and parameters are dynamical ly discovered by processing the set of MBeans in the 
WebLogic JMX Server. Which counters are discovered is determined by the WebLogic version you are 
running and how WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  

CachingDisabled  
Private property that disables 
caching in  proxies. 

Boolean Yes Yes Yes 

DeploymentState  
Returns the current deployment 
state of the module. 

In teger No No Yes 

IndexDirectoryDisabled  
Returns the directory indexing 
indicator configured in 
weblogic.xml. 

Boolean No No Yes 

JSPDebug  
Returns the JSP's debug/ l ine 
numbers parameter values 
configured in weblogic.xml. 

Boolean No No  Yes 

JSPKeepGenerated 
Returns the JSP's KeepGenerated 
parameter value configured in 
weblogic.xml. 

Boolean No No Yes 

JSPPageCheckSecs 
Returns the JSP's PageCheckSecs 
value configured in weblogic.xml. 

Long No No Yes 

JSPVerbose 
Returns the JSP's Verbose parameter 
value configured in weblogic.xml. 

Boolean No No Yes 

OpenSessionsCurrentCount 
Returns the current total number of 
open sessions in  th is component. 

In teger Yes Yes Yes 

OpenSessionsHighCount  

Returns the h ighest of the total 
number of open sessions in  th is 
server. The count starts at zero each 
t ime the server is act ivated. Note 
that th is is an opt imizat ion method 
for a h ighly useful stat ist ic that 
could be implemented less 
efficient ly using change 
not i ficat ion. 

In teger Yes Yes Yes 
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Registered  
Returns false i f the MBean 
represented by th is object has been 
unregistered. 

Boolean Yes Yes Yes 

ServletReloadCheckStatus  
Returns the servlet reload check 
seconds configured in weblogic.xml. 

In teger No No Yes 

SessionCookieMacAgentSecs 
Returns the session 's cookie max age 
configured for http sessions. 

In teger No No Yes 

SessionInval idat ionIntervalSecs 
Returns the inval idat ion check 
t imer in terval configured for http 
sessions. 

In teger No No Yes 

SessionMonitoringEnabled 
Returns the session monitoring 
indicator configured in 
weblogic.xml. 

Boolean No No Yes 

SessionsOpenedTotalCount 
Returns the total number of sessions 
opened in th is server. 

In teger Yes Yes Yes 

SessionTimeoutSecs  
Returns the t imeout configured for 
http sessions. 

In teger No No Yes 

SingleThreadServletPoolSize 
Returns the single threaded servlet 
pool size configured in 
weblogic.xml.  

In teger No No Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Application 

The appl icat ion name. You can specify one or more names for monitoring. In  any combinat ion, select 
values from the discovered l ist , or enter values manually. 
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StatType 

This parameter is avai lable for counters that are return ing a count or total (OpenSessionsCurrentCount 
is one example in  th is counter category). Possible values are: 

ACTUAL The counter returns the raw data value. 

 INTERVAL The counter returns the difference between the raw value of the counter in  the last 
task in terval and the raw data value of the counter in  the current task in terval. 

 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 

 

 

Interval 

Recommended minimum is 5 minutes. 

 

WebLogic Web Server Runtime 

The WebLogic Web Server Runt ime category includes the counters l isted in  the fol lowing table. Some of 
the counters l isted in  the table may not be avai lable on your system. WebLogic counter categories, counter 
names, and parameters are dynamical ly discovered by processing the set of MBeans in the WebLogic JM X 
Server. Which counters are discovered is determined by the WebLogic version you are running and how 
WebLogic is configured. 

Coun ters 
Descript i on  

Type 
WL 
6.x  

WL 
7.x  

WL 
8.x  
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CachingDisabled 
Private property that disables caching in  
proxies.  

Boolean No Yes Yes 

DefaultWebServer 
Returns whether i t  is the 
defaultWebServer or a VirtualHost.  

Boolean No No Yes 

Registered  
Returns false i f the MBean represented by 
th is object has been unregistered. 

Boolean No Yes Yes 

 

Parameters 

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values 
are analyzed and displayed according to their parameter dependency structure. This al lows you to select 
between the mult iple parameters and always end up with a val id combinat ion  of parameters. This 
parameter dependency in formation is enforced by the task creat ion wizard in  the VantageView Web 
Console Management funct ion. 

The fol lowing parameters are val id for th is counter category. 

Domain 

Domain in  which the WebLogic Appl icat ion Admin server and i ts managed servers reside. You can 
specify one or more domains for monitoring. In  any combinat ion, select values from the discovered 
l ist , or enter values manually. 

Location 

WebLogic Appl icat ion Server where the instance you want to monitor resides. You can specify one or 
more servers for monitoring. In  any combinat ion, select values from the discovered l ist , or enter values 
manually. 

Data Point 

For each counter that you have included in a task: 

!  The primary data point (PDP) is the value returned for that counter. 

!  The intelligent data point (IDP) is the set of values returned for all counters in the counter category. 

The PDP and IDP for a counter are displayed together in  the fol lowing example. When parameters are 
defined by mult iple values, a PDP and IDP are returned for each discovered combinat ion of parameters. 
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Interval 

Recommended minimum is 5 minutes. 

 

WebSphere Counters 

WebSphere Remote Extended Counters 

The fol lowing dynamical ly discovered WebSphere remote extended counter categories are provided in 
QALoad. Each category provides counters that extend the monitoring of your WebSphere  system. The 
categories, counter names, and parameters are al l  dynamical ly discovered by processing data avai lable from 
the WebSphere Performance Monitoring Infrastructure. 

Remote monitoring supports WebSphere versions: 4.0+, 5.0, and 6.0. The counters supported vary by 
version.  

WebSphere Bean Module   

WebSphere Cache Module   

WebSphere Connect ion Pool Module  

WebSphere J2C Module   

WebSphere JVM Runtime Module  

WebSphere ORB Perf Module  

WebSphere Scheduler Module 

WebSphere Servlet Sessions Module  

WebSphere System Module  

WebSphere Thread Pool Module 

WebSphere Transact ion Module  

WebSphere Web App M odule  

Web Services Counters 

 

WebSphere Alarm Manager Counters  

The counters discovered for the WebSphere Alarm Manger category are determined by the level of metrics 
you set in  WebSphere. The WebSphere Alarm M anager data counters may include the fol lowing counters: 

Coun ter Nam e (6.0 
and greater) 

Coun ter Nam e 
 (5.0 or earl i er)  

Descript i on   
WebSphere 

Version   

Level  
of  
M et ri cs 

Data 
Poin t  
Type  

AlarmsCreatedCount  

Total number of 
alarms created by al l  
asynchronous 
scopes for th is 
.WorkManager. 

5.0 and 
above 

High Long 

AlarmsCancel ledCount  
Number of alarms 
cancel led by the 
appl icat ion. 

5.0 and 
above 

High Long 

AlarmsFiredCount  
Number of alarms 
fired. 

5.0 and 
above 

High Long 
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AlarmLatencyDurat ion  
Latency of alarms 
fired in  
mil l iseconds. 

5.0 and 
above 

High Load 

AlarmsPendingSize  
Number of alarms 
wait ing to fi re. 

5.0 and 
above 

High Load 

AlarmRate  
Number of alarms 
firing per second. 

5.0 and 
above 

High Load 

Parameters 

The fol lowing parameters are val id for th is counter category: 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more servers for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Instance Name 

Instance name to monitor. Select the Instance name that you want to monitor from the l ist  of 
avai lable instances. The default  value is the first  instance in the l ist .   

You can specify one or more instances for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long. 

Interval 

Recommended minimum is 5 minutes. 

 

WebSphere Bean Module Counters 

The counters discovered for the WebSphere Bean category are determined by the level of metrics you set in  
WebSphere. The WebSphere Bean data counters may include the fol lowing counters: 
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Coun ter Nam e (6.0 and 
greater) 

Coun ter Nam e  (5.0 
or earl i er)  

Descript i on   
WebSphere 

Version   
Level  of  
M et ri cs 

Data 
Poin t  
Type  

CreateCount creates 
Number of 
t imes beans 
were created. 

3.5.5 and 
above 

Low Long 

RemoveCount removes 

Number of 
t imes beans 
were 
removed.  

3.5.5 and 
above 

Low Long 

PassivateCount passivates 

Number of 
t imes beans 
were 
passivated 
(ent i ty and 
stateful). 

3.5.5 and 
above 

Low Long 

Act ivateCount act ivates 

Number of 
t imes beans 
were 
act ivated 
(ent i ty and 
stateful). 

3.5.5 and 
above 

Low Long 

LoadCount persistence loads 

Number of 
t imes bean 
data was 
loaded from 
persistent 
storage 
(ent i ty). 

3.5.5 and 
above 

Low Long 

StoreCount persistence stores 

Number of 
t imes bean 
data was 
stored in  
persistent 
storage 
(ent i ty). 

3.5.5 and 
above 

Low Long 

Instant iateCount instant iat ions 

Number of 
t imes bean 
objects were 
instant iated. 

3.5.5 and 
above 

Low Long 

FreedCount destroys 

Number of 
t imes bean 
objects were 
freed. 

3.5.5 and 
above 

Low Long 
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Ready Count Num Ready Beans 

Number of 
concurrent ly 
ready beans 
(ent i ty and 
session). This 
counter was 
cal led 
concurrent 
act ive in  
Versions 
3.5.5+ and 
4.0. 

3.5.5 and 
above 

High Load 

LiveCount concurrent l ive 
Number of 
concurrent ly 
l ive beans.  

3.5.5 and 
above 

High Load 

MethodResponseTime avg method rsp t ime 

Average 
response 
t ime in 
mil l iseconds 
on the bean 
methods 
(home, 
remote, 
local). 

3.5.5 and 
above 

High Long 

CreateTime 
avg method rsp t ime 
for create 

Average t ime 
in 
mil l iseconds 
a bean create 
cal l  takes, 
including the 
t ime for the 
load, i f any. 

5.0 Medium Long 

LoadTime 
avg method rsp t ime 
for load 

Average t ime 
in 
mil l iseconds 
for loading 
the bean data 
from 
persistent 
storage 
(ent i ty). 

5.0 Medium Long 

StoreTime 
avg method rsp t ime 
for store 

Average t ime 
in 
mil l iseconds 
for storing 
the bean data 
to persistent 
storage 
(ent i ty). 

5.0 Medium Long 
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RemoveTime 
avg method rsp t ime 
for remove 

Average t ime 
in 
mil l iseconds 
a bean entry 
cal l  takes, 
including the 
t ime at the 
database, i f 
any. 

5.0 Medium Long 

MethodCallCount total method cal ls 
Total number 
of method 
cal ls. 

3.5.5 and 
above 

High Long 

Act ivat ionTime 
avg method rsp t ime 
for act ivat ion 

Average t ime 
in 
mil l iseconds 
a 
beanActivate 
cal l  takes, 
including the 
t ime at the 
database, i f 
any. 

5.0 Medium Long 

Passivat ionTime 
avg method rsp t ime 
for passivat ion 

Average t ime 
in 
mil l iseconds 
a 
beanPassivate 
cal l  takes, 
including the 
t ime at the 
database, i f 
any. 

5.0 Medium Long 

Act iveMethodCount act ive methods 

Number of 
concurrent ly 
act ive 
methods - 
number of 
methods 
cal led at the 
same t ime. 

3.5.5 and 
above 

High Long 

RetrieveFromPoolCount 
Per method 
invocat ions 

Number of 
cal ls to the 
bean 
methods 
(home, 
remote, 
local). 

3.5.5 and 
above 

Max Long 
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RetrieveFromPoolSuccessCount Per method rsp t ime 

Average 
response 
t ime in 
mil l iseconds 
on the bean 
methods 
(home, 
remote, 
local). 

3.5.5 and 
above 

Max Long 

ReturnsToPoolCount 
Per method 
concurrent 
invocat ions 

Number of 
concurrent 
invocat ions 
to cal l  a 
method. 

5.0 Max Load 

RetrieveFromPoolCount getsFromPool 

Number of 
cal ls 
retrieving an 
object from 
the pool 
(ent i ty and 
stateless). 

3.5.5 and 
above 

Low Long 

RetrieveFromPoolSuccessCount getsFound 

Number of 
t imes a 
retrieve 
found an 
object 
avai lable in  
the pool 
(ent i ty and 
stateless). 

3.5.5 and 
above 

Low Long 

ReturnsToPoolCount returnsToPool 

Number of 
cal ls 
return ing an 
object to the 
pool (ent i ty 
and 
stateless). 

3.5.5 and 
above 

Low Long 

ReturnsDiscardCount returnsDiscarded 

Number of 
t imes the 
return ing 
object was 
discarded 
because the 
pool was ful l  
(ent i ty and 
stateless). 

3.5.5 and 
above 

Low Long 
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DrainsFromPoolCount drainsFromPool 

Number of 
t imes the 
daemon 
found the 
pool was idle 
and 
attempted to 
clean i t  
(ent i ty and 
stateless). 

3.5.5 and 
above 

Low Long 

DrainSize avgDrainSize 

Average 
number of 
objects 
discarded in 
each drain 
(ent i ty and 
stateless). 

3.5.5 and 
above 

Medium Long 

PooledCount avgPoolSize 

Number of 
objects in  the 
pool (ent i ty 
and 
stateless). 

3.5.5 and 
above 

High Load 

MessageCount messageCount 

Number of 
messages 
del ivered to 
the bean on 
Message 
method 
(message 
driven 
beans). 

5.0 Low Long 

MessageBackoutCount messageBackoutCount 

Number of 
messages 
fai led to be 
del ivered to 
the bean on 
Message 
method 
(message 
driven 
beans). 

5.0 Low Long 

WaitTime serverSessionWait  

Average t ime 
to obtain a 
Server 
Session from 
the pool 
(message 
drive bean). 

5.0 Medium Long 
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ServerSessionPoolUsage serverSessionUsage 

Percentage of 
Server 
Session pool 
in  use 
(message 
driven). 

5.0 High Load 

Parameters 

The fol lowing parameters are val id for th is counter category: 

Enterprise Beans (WebSphere Versions 3 and 4) 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes.  

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more servers for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Container 

Name of bean container to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Bean 

Name of Enterprise JavaBeans (EJB) to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Enterprise Beans  (WebSphere Version 5) 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more servers for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 
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Application 

Name of appl icat ion to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Jar File 

Name of jar fi le to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

EJB Type 

Type of Enterprise JavaBeans (EJB) to monitor. 

You can specify one or more types for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Bean 

Name of Enterprise JavaBeans (EJB) to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long or Load. 

Interval 

Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.  

 

WebSphere Cache Module Counters 

The counters discovered for the Cache category are determined by the level of metrics you set in  
WebSphere. The Cache data counters may include the fol lowing counters: 

Coun ter Nam e (6.0 and 
greater) 

Coun ter Nam e 
(5.0 or earl i er) 

Descript i on  
WebSphere 

Version   
Level  of  
M et ri cs 

Data 
Poin t  
Type  

MaxInMemoryCacheEntry
Count 

maxInMemoryCac
heSize 

Maximum 
number of 
in-memory 
cache 
entries.  

5.0 and 
above 

Low Long 

InMemoryCacheEntryCoun
t 

inMemoryCacheSi
ze 

Current 
number of 
in-memory 
cache 

5.0 and 
above 

Low Long 
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entries. 

TimeoutInval idat ionCount 
totalTimeoutInval i
dat ion 

Aggregate of 
template 
t imeouts and 
disk 
t imeouts. 

5.0 and 
above 

Low Long 

HitsInMemoryCount h itsInMemory 

Requests for 
th is 
cacheable 
object served 
from 
memory. 

5.0 and 
above 

Low Long 

HitsOnDiskCount h itsOnDisk 

Requests for 
th is 
cacheable 
object served 
from disk. 

5.0 and 
above 

Low Long 

Expl ici t Inval idat ionCount  
expl ici t Inval idat io
ns 

Total expl ici t  
inval idat ion 
issued for 
th is 
template. 

5.0 and 
above 

Low Long 

LruInval idat ionCount lruInval idat ions 

Cache 
entries 
evicted from 
memory by a 
Least 
Recent ly 
Used 
algori thm. 
These entries 
are 
passivated to 
disk i f disk 
overflow is 
enabled. 

5.0 and 
above 

Low Long 

TimeoutInval idat ionCount
?????? 

t imeoutInval idat io
ns 

Cache 
entries 
evicted from 
memory 
and/or disk 
because their 
t imeout has 
expired. 

5.0 and 
above 

Low Long 

 

InMemoryAndDiskCacheEn
tryCount  

Entries 

Current 
number of 
cache entries 
created from 

5.0 and 
above 

Low Long 
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th is 
template. 
Refers to the 
per-template 
equivalent of 
totalCacheSi
ze. 

M issCount M isses 

Requests for 
th is 
cacheable 
object that 
were not 
found in the 
cache. 

5.0 and 
above 

Low Long 

ClientRequestCount 
RequestFromClien
t 

Requests for 
th is 
cacheable 
object 
generated by 
appl icat ions 
running on 
the 
appl icat ion 
server. 

5.0 and 
above 

Low Long 

DistributedRequestCount requestsFromJVM 

Requests for 
th is 
cacheable 
object 
generated by 
cooperat ing 
caches in 
th is cluster. 

5.0 and 
above 

Low Long 

Expl ici tMemoryInval idat io
nCount 

expl ici t Inval idat io
nsFromMemory 

Expl ici t  
inval idat ions 
result ing in  
an entry 
being 
removed 
from 
memory. 

5.0 and 
above 

Low Long 

Expl ici tDiskInval idat ionCo
unt 

 

expl ici t Inval idat io
nsFromDisk 

Expl ici t  
inval idat ions 
result ing in  
an entry 
being 
removed 
from disk. 

5.0 and 
above 

Low Long 

Expl ici t Inval idat ionCount  
expl ici t Inval idat io
nsNoOp 

Expl ici t  
inval idat ions 
received for 

5.0 and 
above 

Low Long 
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th is template 
where no 
correspondin
g entry 
exists. 

LocalExpl ici t Inval idat ionC
ount 

expl ici t Inval idat io
nsLocal 

Expl ici t  
inval idat ions 
generated 
local ly, 
ei ther 
programmati
cal ly or by a 
cache pol icy. 

5.0 and 
above 

Low Long 

RemoteExpl ici t Inval idat ion
Count 

expl ici t Inval idat io
nsRemote 

Expl ici t  
inval idat ions 
received 
from a 
cooperat ing 
JVM in th is 
cluster. 

5.0 and 
above 

Low Long 

RemoteCreat ionCount remoteCreat ions 

Entries 
received 
from 
cooperat ing 
dynamic 
caches. 

5.0 and 
above 

Low Long 

Parameters 

The fol lowing parameters are val id for th is counter category: 

Dynamic Cache  (WebSphere Version 5) 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more servers for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Instance Name 

Instance name to monitor. Select the instance name that you want to monitor from the l ist  of 
avai lable instances. The default  value is the first  instance in the l ist .   
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You can specify one or more instances for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long. 

Interval 

Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.  

 

WebSphere Connection Pool Module Counters 

The counters discovered for the JDBC Connect ion Pool category are determined by the level of metrics you 
set in  WebSphere. The JDBC Connect ion Pool data counters may include the fol lowing l isted counters. 

Performance Monitoring Infrastructure (PMI) col lects performance data for 4.0 and 5.0 JDBC data sources. 
For a 4.0 data source, the data source name is used. For a 5.0 data source, the Java Naming and Directory 
Interface (JNDI) name is used. 

Coun ter Nam e (6.0 and 
greater) 

Coun ter 
Nam e  (5.0 
or earl i er) 

Descript i on   
WebSphere 

Version   
Level  of  
M et ri cs 

Data 
Poin t  
Type  

CreateCount Creates 
Total number 
of connect ions 
created. 

3.5.5 and 
above 

Low Long 

PoolSize Avg Pool Size 
Average pool 
size. 

3.5.5 and 
above 

High 
Bounded 
Range 
Stat ist ic 

FreePoolSize Free Pool Size 
Average free 
pool size. 

5.0 High 
Bounded 
Range 
Stat ist ic 

Al locateCount Al locates 
Total number 
of connect ions 
al located. 

3.5.5 and 
above 

Low Long 

ReturnCount Returns 
Total number 
of connect ions 
returned. 

4.0 and 
above 

Low Long 

Wait ingThreadCount 
Avg Wait ing 
Threads 

Number of 
threads that 
are current ly 
wait ing for a 
connect ion. 

3.5.5 and 
above 

High Stat 
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FaultCount 
Connect ion 
Pool Faults 

Total number 
of faults, such 
as, t imeouts, in  
connect ion 
pool. 

3.5.5 and 
above 

Low Long 

CloseCount Destroys 

Number of 
t imes bean 
objects were 
freed. 

3.5.5 and 
above 

Low Long 

WaitTime 
Avg Wait  
Time 

Average 
wait ing t ime in 
mil l iseconds 
unt i l  a 
connect ion is 
granted. 

5.0 Medium Long 

UseTime 
Avg Time in 
Use 

Average t ime a 
connect ion is 
used.  

5.0 Medium Long 

PercentUsed Percent Used 

Average 
percent of the 
pool that is in  
use. 

3.5.5 and 
above 

High Stat 

PercentMaxed 
Percent 
Maxed 

Average 
percent of the 
t ime that al l  
connect ions 
are in  use 

3.5.5 and 
above 

High Stat 

PrepStmtCacheDiscardCount 
Statement 
Cache discard 
count  

Total number 
of statements 
discarded by 
the LRU 
algori thm of 
the statement 
cache. 

4.0 and 
above 

Low Long 

ManagedConnect ionCount 
Number 
Managed 
Connect ions 

Number of 
Managed 
Connect ion 
objects in  use.  

5.0 Low Long 

Connect ionHandleCount  
Number 
Connect ions 

Current 
number of 
connect ion 
objects in  use 

5.0 Low Long 

JDBCTime 
JDBC 
Operat ion 
Timer 

Amount of 
t ime in 
mil l iseconds 
spent 
execut ing in  

5.0 Medium Long 
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the JDBC 
driver. 

 
Concurrent 
Waiters 

    

Parameters 

The fol lowing parameters are val id for th is counter category: 

JDBC Connection Pools (Versions 3 and 4) 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , enter values manually, or enter wi ldcard patterns. 

Data Source 

 Name of data source. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

JDBC Connection Pools (Version 5)   

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Provider 

Name of data source provider to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 
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Data Source 

Name of data source to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long ,  Stat , or Bounded Range Stat ist ic. 

Interval 

Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.    

 

WebSphere DCS Stack Counters  

The counters discovered for the WebSphere DCS Stack category are determined by the level of metrics you 
set in  WebSphere. The WebSphere DCS Stack data counters may include the fol lowing counters: 

Coun ter Nam e 
(6.0 and 
greater) 

Coun ter Nam e 
 (5.0 or earl i er) 

Descript i on   
WebSphere 

Version   
Level  of  
M et ri cs 

Data Poin t  Type  

Number of 
message buffer 
real locat ions 

 

Number of 
message buffer 
real locat ions due 
to inadequate 
buffer size. If th is 
number is larger 
than 20 percent 
of the number of 
sent messages, 
you may want to 
contact IBM 
Support. 

6.0 and 
above 

Medium Long 

Outgoing 
message size 

 

M in imal, 
maximal, and 
average size (in  
bytes) of the 
messages that 
were sent 
through the DCS 
stack. 

6.0 and 
above 

High (AverageStat ist ic) 

Number of sent 
messages 

 

Number of 
messages sent 
through the DCS 
stack. 

6.0 and 
above 

High Long 
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Incoming 
message size 

 

M in imal, 
maximal and 
average size (in  
bytes) of the 
messages that 
were received by 
the DCS stack. 

6.0 and 
above 

High (AverageStat ist ic) 

Number of 
received 
messages 

 

Number of 
messages 
received by the 
DCS stack. 

6.0 and 
above 

High Long 

Amount of t ime 
needed for the 
synchronizat ion 
procedure to 
complete 

 

Amount of t ime 
needed to 
guarantee that 
al l  view 
members are 
synchronized. 

6.0 and 
above 

High Stat 

Number of 
messages 
retransmitted 
by local 
member during 
the view change 

 

Number of 
messages that 
were 
retransmitted 
during the view 
change to ensure 
synchronizat ion 
with other 
members. 

6.0 and 
above 

High 
(AverageStat ist ic) 

 

Number of 
t imes that the 
synchronizat ion 
procedure 
t imed out 

 

Number of t imes 
that the 
synchronizat ion 
procedure t imed 
out. 

6.0 and 
above 

Medium Long 

Number of 
t imes that a 
h igh severi ty 
congest ion 
event for 
outgoing 
messages was 
raised 

 

Number of t imes 
that a h igh 
severi ty 
congest ion event 
for outgoing 
messages was 
raised. 

6.0 and 
above 

Medium Long 

Coalesce Time  

Measures the 
amount of t ime 
i t  actual ly takes 
to coalesce a 
view. 

6.0 and 
above 

Medium 
Stat 
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Join View 
Change Time 

 

Measures the 
t ime to do a 
merge view 
change. The DCS 
stack is blocked 
during th is t ime. 

6.0 and 
above 

High 
Stat 

 

Remove View 
Change Time 

 

Measures the 
t ime to do a spl i t  
view change. 
DCS stack is 
blocked during 
th is t ime.  

6.0 and 
above 

High Stat 

Number of 
suspicions 

 

Measures the 
number of t imes 
that the local 
member 
suspected other 
members. 

6.0 and 
above 

High Long 

Number of view 
changes 

 

Number of t imes 
that th is member 
underwent view 
changes. 

6.0 and 
above 

Medium Long  

View group size  

Measures the size 
of the group the 
local member 
belongs to. 

6.0 and 
above 

Medium (AverageStat ist ic) 

Parameters 

The fol lowing parameters are val id for th is counter category: 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more servers for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Instance Name 

Instance name to monitor. Select the Instance name that you want to monitor from the l ist  of 
avai lable instances. The default  value is the first  instance in the l ist .   

You can specify one or more instances for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 
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Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long. 

Interval 

Recommended minimum is 5 minutes. 

 

WebSphere High Availabil ity Manager Counters 

The counters discovered for the WebSphere High Avai labi l i ty Manager category are determined by the level 
of metrics you set in  WebSphere. The WebSphere High Avai labi l i ty Manager data counters may include the 
fol lowing counters: 

Coun ter Nam e (6.0 
and greater) 

Coun ter Nam e 
 (5.0 or earl i er)  

Descript i on   
WebSphere 

Version   

Level  
of  
M et ri cs 

Data 
Poin t  
Type  

Number of local 
groups 

 
Total number of local 
groups. 

6.0 and 
above 

High Load 

Group state rebui ld 
t ime 

 

Time taken in 
mil l iseconds to 
rebui ld the global 
group state. During 
the rebui ld t ime, no 
fai l-over can happen. 
If th is t ime is too 
h igh and is 
unacceptable for the 
desired avai labi l i ty, 
you may want to 
increase the number 
of coordinators. For 
proper operat ion of 
th is counter, you 
must host the act ive 
coordinator in  an 
appl icat ion server 
other than the 
deployment 
manager. 

6.0 and 
above 

High Stat 

Number of bul let in-
board subjects 

 
Total number of 
subjects managed. 

6.0 and 
above 

High Load 

Number of bul let in-
board subscript ions 

 
Total number of 
bul let in-board 
subscript ions. 

6.0 and 
above 

High Load 
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Bullet in-board 
rebui ld t ime 

 

Time taken in 
mil l iseconds to 
rebui ld the global 
state of the bul let in-
board. During th is 
t ime no messages 
wil l  be received by 
the subscribers. If 
th is t ime is too h igh, 
and is unacceptable, 
you may want to 
increase the number 
of coordinators. For 
proper operat ion of 
th is counter, you 
must host the act ive 
coordinator in  an 
appl icat ion server 
other than the 
deployment 
manager. 

6.0 and 
above 

High Stat 

Number of local 
bul let in-board 
subjects 

 

Total number of 
subjects being posted 
to local ly. The 
number includes the 
proxy post ings (i f 
any) done by the 
core group bridge 
service on behalf of 
servers belonging to 
different WebSphere 
cel ls.  

6.0 and 
above 

High Load 

Number of local 
bul let in-board 
subscript ions 

 

Total number of local 
subject subscript ions. 
The number includes 
the proxy 
subscript ions (i f any) 
done by the core 
group bridge service 
on behalf of servers 
belonging to 
different WebSphere 
cel ls. 

6.0 and 
above 

High Stat 

Parameters 

The fol lowing parameters are val id for th is counter category: 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 
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You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more servers for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Instance Name 

Instance name to monitor. Select the Instance name that you want to monitor from the l ist  of 
avai lable instances. The default  value is the first  instance in the l ist .   

You can specify one or more instances for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long. 

Interval 

Recommended minimum is 5 minutes. 

 

WebSphere J2C Connection Pool Module Counters 

The counters discovered for the J2C Connect ion Pool category are determined by the level of metrics you 
set in  WebSphere. The J2C Connect ion Pool data counters may include the fol lowing counters: 

Coun ter Nam e (6.0 and 
greater) 

Coun ter 
Nam e  (5.0 
or earl i er) 

Descript i on   
WebSphere 

Version   
Level  of  
M et ri cs 

Data 
Poin t  
Type  

ManagedConnect ionCount 
Number 
managed 
connect ions 

Number of Managed 
Connect ion objects in  
use.  

5.0 and 
above 

Low Long 

Connect ionHandleCount  
Number 
connect ions 

Current number of 
connect ion objects in  
use. 

5.0 and 
above 

Low Long 

CreateCount 

Number 
managed 
connect ions 
created 

Total number of 
connect ions created. 

5.0 and 
above 

Low Long 

CloseCount 

Number 
managed 
connect ions 
destroyed 

Total number of 
connect ions 
destroyed. 

5.0 and 
above 

Low Long 
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AllocateCount 

Number 
managed 
connect ions 
al located 

Total number of 
connect ions 
al located. 

5.0 and 
above 

Low Long 

FreedCount 

Number 
managed 
connect ions 
freed 

Total number of 
connect ions freed. 

5.0 and 
above 

Low Long 

FaultCount faults 
Number of faults, 
such as t imeouts, in  
the connect ion pool. 

5.0 and 
above 

Low Long 

FreePoolSize 
free pool 
size 

Number of free 
connect ions in  the 
pool. 

5.0 and 
above 

High Stat 

PoolSize pool size Pool size. 
5.0 and 
above 

High Stat 

Wait ingThreadCount 
concurrent 
waiters 

Average number of 
threads concurrent ly 
wait ing for a 
connect ion. 

5.0 and 
above 

High Load 

PercentUsed 
Percent 
used 

Average percent of 
the pool that is in  
use. 

5.0 and 
above 

High Load 

PercentMaxed 
Percent 
maxed 

Average percent of 
the t ime that al l  
connect ions are in  
use. 

5.0 and 
above 

High Load 

WaitTime 
Average 
wait  t ime 

Average wait ing t ime 
in mil l iseconds unt i l  a 
connect ion is granted. 

5.0 and 
above 

Medium Long 

UseTime 
Average use 
t ime 

Average t ime in 
mil l iseconds that 
connect ions are in  
use. 

5.0 and 
above 

Medium Long 

Parameters 

The fol lowing parameters are val id for th is counter category: 

J2C Connection Pools  (WebSphere Version 5) 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 
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You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Instance Name 

Instance name to monitor. Select the instance name that you want to monitor from the l ist  of 
avai lable instances. The default  value is the first  instance in the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long,  Load, or Stat. 

Interval 

Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.  

 

WebSphere Java Virtual Machine (JVM) Runtime Module Counters 

The counters discovered for the Java Virtual Machine (JVM) category are determined by the level of metrics 
you set in  WebSphere. The JVM data counters may include the fol lowing counters: 

Coun ter Nam e (6.0 
and greater) 

Coun ter 
Nam e 

 (5.0 or 
earl i er) 

Descript i on   
WebSphere 

Version   

Level  
of  
M et ri cs 

Data 
Poin t  
Type  

FreeMemory 
Free 
memory 

Free memory in  JVM run t ime. 
3.5.5 and 
above 

Low Long 

UsedMemory 
Used 
memory 

Used memory in  JVM run t ime. 
3.5.5 and 
above 

Low Long 

HeapSize 
Total 
memory 

Total memory in  JVM run t ime. 
3.5.5 and 
above 

High Long 

UpTime Up t ime 
The amount of t ime the JVM is 
running. 

5.0 and 
above 

Low Long 

GCCount 
Number 
garbage 
col lect ion 

Number of garbage col lect ion 
cal ls. This counter is not 
avai lable unless -

4.0 and 
above 

Max Long 
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cal ls XrunpmiJvmpiProfiler is set 
when start ing the JVM. 

GCIntervalTime 

Average 
t ime 
between 
garbage 
col lect ion 

Average garbage col lect ion in  
seconds between two garbage 
col lect ion. This counter is not 
avai lable unless -
XrunpmiJvmpiProfiler is set 
when start ing the JVM. 

4.0 and 
above 

Max Long 

GCTime 

Average 
garbage 
col lect ion 
durat ion 

Average durat ion of a garbage 
col lect ion. This counter is not 
avai lable unless -
XrunpmiJvmpiProfiler is set 
when start ing the JVM. 

4.0 and 
above 

Max Long 

WaitsForLockCount 
num 
waits for 
a lock 

Number of t imes that a thread 
waits for a lock.This counter is 
not avai lable unless -
XrunpmiJvmpiProfiler is set 
when start ing the JVM. 

4.0 and 
above 

Max Long 

WaitForLockTime 
avg t ime 
wait ing 
for lock 

Average t ime that a thread 
waits for a lock. This counter is 
not avai lable unless -
XrunpmiJvmpiProfiler is set 
when start ing the JVM. 

4.0 and 
above 

Max Long 

ObjectAl locateCount 
Number 
of objects 
al located 

Number of objects al located in  
heap. This counter is not 
avai lable unless -
XrunpmiJvmpiProfiler is set 
when start ing the JVM. 

4.0 and 
above 

Max Long 

ObjectMovedCount 

 
     

 
Number 
of objects 
found 

Number of objects in  heap. 
This counter is not avai lable 
unless -
XrunpmiJvmpiProfiler is set 
when start ing the JVM. 

4.0 and 
above 

Max Long 

ObjectFreedCount 
Number 
of objects 
freed  

Number of objects freed in 
heap. This counter is not 
avai lable unless -
XrunpmiJvmpiProfiler is set 
when start ing the JVM. 

4.0 and 
above 

Max Long 

ThreadStartedCount  

Number of threads started. This 
counter is not avai lable unless 
the -XrunpmiJvmpiProfi ler 
opt ion is set when start ing the 
JVM. 

4.0 and 
above 
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ThreadEndedCount  

Number of fai led threads. This 
counter is not avai lable unless 
the -XrunpmiJvmpiProfi ler 
opt ion is set when start ing the 
JVM. 

4.0 and 
above 

  

Parameters 

The fol lowing parameters are val id for th is counter category: 

JVM Runtime (WebSphere All Versions) 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long. 

Interval 

Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.    

 

WebSphere Object Pool Counters  

The counters discovered for the WebSphere Object Pool category are determined by the level of metrics 
you set in  WebSphere. The WebSphere Object Pool data counters may include the fol lowing counters: 

Coun ter Nam e (6.0 
and greater) 

Coun ter Nam e 
 (5.0 or earl i er)  

Descript i on   
WebSphere 

Version   

Level  
of  
M et ri cs 

Data 
Poin t  
Type  

ObjectsCreatedCoun  
Total number of 
objects created.  

5.0 and 
above 

High Long 
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ObjectsAllocatedCount  
Number of objects 
requested from the 
pool. 

5.0 and 
above 

High Long 

ObjectsReturnedCount   
Number of objects 
returned to the 
pool. 

5.0 and 
above 

High Long 

IdleObjectsSize  
Average number of 
idle object instances 
in  the pool. 

5.0 and 
above 

High Load 

Parameters 

The fol lowing parameters are val id for th is counter category: 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more servers for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Instance Name 

Instance name to monitor. Select the Instance name that you want to monitor from the l ist  of 
avai lable instances. The default  value is the first  instance in the l ist .   

You can specify one or more instances for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long. 

Interval 

Recommended minimum is 5 minutes. 

 

WebSphere ORB Perf Module Counters 

The counters discovered for the Object Request Broker (ORB) category are determined by the level of 
metrics you set in  WebSphere. The ORB data counters may include the fol lowing counters: 
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Coun ter Nam e (6.0 and 
greater) 

Coun ter Nam e  (5.0 
or earl i er) 

Descript i on   
WebSphere 

Version   
Level  of  
M et ri cs 

Data 
Poin t  
Type  

LookupTime referenceLookupTime 

The t ime (in  
mil l iseconds) 
to look up an 
object 
reference 
before method 
dispatch can 
be carried out. 

5.0 and 
above 

Medium Long 

RequestCount numRequest 

The total 
number of 
requests sent 
to the ORB. 

5.0 and 
above 

Low Long 

ConcurrentRequestCount concurrentRequests 

The number 
of requests 
that are 
concurrent ly 
processed by 
the ORB. 

5.0 and 
above 

High Load 

ProcessingTime processingTime 

The t ime (in  
mil l iseconds) 
i t  takes a 
registered 
portable 
in terceptor to 
run. 

5.0 and 
above 

Medium Long 

Parameters 

The fol lowing parameters are val id for th is counter category: 

Object Request Broker (WebSphere Version 5)   

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Instance Name 
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Instance name to monitor. Select the instance name that you want to monitor from the l ist  of 
avai lable instances. The default  value is the first  instance in the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long or Load. 

Interval 

Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.  

 

WebSphere Scheduler Module Counters  

The counters discovered for the WebSphere Scheduler category are determined by the level of metrics you 
set in  WebSphere. The WebSphere Scheduler data counters may include the fol lowing counters: 

Coun ter Nam e (6.0 
and greater) 

Coun ter Nam e 
 (5.0 or earl i er)  

Descript i on   
WebSphere 

Version   

Level  
of  
M et ri cs 

Data 
Poin t  
Type  

TaskFailureCount  
Number of tasks that 
fai led to run. 

5.0 and 
above 

High Long 

TaskFin ishCount  
Number of tasks that 
ran successful ly. 

5.0 and 
above 

High Long 

Pol lCount  
Number of pol l  
cycles completed for 
al l  daemon threads. 

5.0 and 
above 

High Long 

TaskFin ishRate  
Number of tasks run 
per second. 

5.0 and 
above 

High Load 

TaskColl isionRate  

Number of col l isions 
encountered per 
second between 
competing pol l  
daemons. 

5.0 and 
above 

High Load 

Pol lQueryDurat ion  

Start  t ime in 
mil l iseconds for each 
pol l  daemon thread's 
database pol l  query. 

5.0 and 
above 

High Load 
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RunDurat ion  
Time in mil l iseconds 
taken to run a task.. 

5.0 and 
above 

High Load 

TaskExpirat ionRate  
Number of tasks in  a 
pol l  query. 

5.0 and 
above 

High Load 

TaskDelayDurat ion  
Period of t ime in 
seconds that the task 
is delayed. 

5.0 and 
above 

High Load 

Pol lDurat ion  
Number of seconds 
between pol l  cycles. 

5.0 and 
above 

High Load 

TaskRunRate  

Number of tasks run 
by each pol l  daemon 
thread. (Mult iply th is 
by the number of 
pol l  daemon threads 
to get the tasks run 
per effect ive pol l  
cycle.) 

5.0 and 
above 

High Load 

Parameters 

The fol lowing parameters are val id for th is counter category: 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more servers for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Instance Name 

Instance name to monitor. Select the instance name that you want to monitor from the l ist  of 
avai lable instances. The default  value is the first  instance in the l ist .   

You can specify one or more instances for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Primary Data Point 
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The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long. 

Interval 

Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.  

 

WebSphere Servlet Sessions Module Counters 

The counters discovered for the Servlet Sessions category are determined by the level of metrics you set  in  
WebSphere. The Servlet Sessions data counters may include the fol lowing counters: 

Coun ter Nam e (6.0 and 
greater) 

Coun ter Nam e  
(5.0 or earl i er) 

Descript i on   
WebSphere 

Version   
Level  of  
M et ri cs 

Data 
Poin t  
Type  

CreateCount createdSessions 
Number of sessions 
created. 

3.5.5 and 
above 

Low Long 

Inval idateCount inval idatedSessions 
Number of sessions 
inval idated. 

3.5.5 and 
above 

Low Long 

LifeTime sessionLifeTime 
Average session 
l i fet ime. 

3.5.5 and 
above 

Medium  Long 

Act iveCount act iveSessions 

Number of 
concurrent ly act ive 
sessions. A session is 
act ive i f WebSphere 
is current ly 
processing a request 
that uses that 
session.  

3.5.5 and 
above 

High Load 

LiveCount l iveSession 
Number of sessions 
that are current ly 
cached in memory.  

5.0 and 
above 

High Load 

NoRoomForNewSessionCo
unt 

NoRoomForNewSes
sion 

Appl ies only to 
session in  memory 
with 
Al lowOverflow=false
. The number of 
t imes that a request 
for a new session 
cannot be handled 
because i t  would 
exceed the 
maximum session 
count. 

5.0  Low Long 

CacheDiscardCount cacheDiscards Number of session 
objects that have 

5.0  Low Long 
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been forced out of 
the cache. (An LRU 
algori thm removes 
old entries to make 
room for new 
sessions and cache 
misses). Appl icable 
only for persistent 
sessions. 

ExternalReadTime externalReadTime 

Time (in  
mil l iseconds) taken 
in reading the 
session data from 
persistent store. For 
mult i-row sessions, 
the metrics are for 
the attribute; for 
single-row sessions, 
the metrics are for 
the whole session. 
Appl icable only for 
persistent sessions. 
When using a JMS 
persistent store, you 
have the choice of 
whether to serial ize 
the data being 
repl icated. If you 
choose not to 
serial ize the data, the 
counter is not 
avai lable.  

5.0 4 Medium Long 

ExternalReadSize externalReadSize 

Size of session data 
read from persistent 
store. Appl icable 
only for (serial ized) 
persistent sessions; 
similar to 
externalReadTime 
above.  

5.0  Medium  Long 

ExternalWriteTime externalWriteTime 

Time (mil l iseconds) 
taken to wri te the 
session data from 
the persistent store. 
Appl icable only for 
(serial ized) persistent 
sessions. Similar to 
externalReadTime 
described above.  

5.0  Medium  Long 

ExternalWriteSize externalWriteSize Size of session data 
writ ten to persistent 

5.0  Medium  Long 
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store. Appl icable 
only for (serial ized) 
persistent sessions. 
Similar to 
externalReadTime 
described above.  

Affin i tyBreakCount affin i tyBreaks 

The number of 
requests received for 
sessions that were 
last accessed from 
another Web 
appl icat ion. This can 
indicate fai lover 
processing or a 
corrupt plug-in 
configurat ion. 

5.0  Low Long 

SessionObjectSize 
serial izableSessObjS
ize 

The size in  bytes of 
(the attributes that 
can be serial ized) in-
memory sessions. 
Only count session 
objects that contain 
at least one attribute 
object that can be 
serial ized. Note that 
a session may 
contain some 
attributes that can 
be serial ized and 
some that are not. 
The size in  bytes is at 
a session level.  

5.0  Max Long 

TimeSinceLastAct ivated 
t imeSinceLastAct iv
ated 

The t ime difference 
in mil l iseconds 
between previous 
and current access 
t ime stamps. Does 
not include session 
t ime out.  

5.0  Medium Long 

TimeoutInval idat ionCoun
t 

inval idatedViaTime
out 

The number of 
requests for a session 
that no 
CountStat ist ic exists, 
presumably because 
the session t imed 
out. 

5.0  Low Long 

Act ivateNonExistSessionC
ount 

attemptToActivate
Not ExistentSession 

Number of requests 
for a session that no 
longer exists, 
presumably because 

5.0  Low Long 
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the session t imed 
out. Use th is counter 
to help determine i f 
the t imeout is too 
short . 

Parameters 

The fol lowing parameters are val id for th is counter category: 

Servlet Sessions (WebSphere Versions 3 and 4) 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Servlet Sessions  (WebSphere Version 5)   

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Application 

Name of appl icat ion to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

War File 

Name of war fi le to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 
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Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long or Load. 

Interval 

Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.  

 

WebSphere System Module Counters 

The counters discovered for the System category are determined by the level of metrics you set in  
WebSphere. The System data counters may include the fol lowing counters: 

Coun ter Nam e (6.0 and 
greater) 

Coun ter Nam e 
 (5.0 or earl i er) 

Descript i on   
WebSphere 

Version   
Level  of  
M et ri cs 

Data 
Poin t  
Type  

CPUUsageSinceLastMeasurement percentCpuUsage 

Average system 
CPU ut i l izat ion 
taken over the 
t ime interval 
since the last 
reading. Because 
the first  cal l  is 
required to 
perform 
in it ial izat ion, an 
inval id value 
such as 0 is 
returned. Al l  
subsequent cal ls 
return the 
expected value. 
On SMP 
machines, the 
value returned is 
the ut i l izat ion 
averaged over al l  
CPUs. 

5.0 Low Long 

FreeMemory freeMemory 

The amount of 
real free memory 
avai lable on the 
system. Real 
memory that is 
not al located is 
only a lower 
bound on 
avai lable real 
memory, since 
many operat ing 

5.0 Low Long 
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systems take 
some of the 
otherwise 
unal located 
memory and use 
i t  for addit ional 
I/O buffering. 
The exact 
amount of buffer 
memory that can 
be freed up is 
dependent on 
both the 
platform and the 
appl icat ion(s) 
running on i t . 

CPUUsageSinceServerStarted avgCpuUti l izat ion 

The average 
percentCpuUsage 
that is busy after 
the server is 
started. 

5.0 Medium Long 

Parameters 

The fol lowing parameters are val id for th is counter category: 

System Performance (WebSphere Version 5)   

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long. 

Interval 

Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.  
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WebSphere Thread Pool Module Counters   

The counters discovered for the Thread Pool category are determined by the level of metrics you set in  
WebSphere. The Thread Pool data counters may include the fol lowing counters: 

Coun ter 
Nam e (6.0 

and greater) 

Coun ter 
Nam e  (5.0 
or earl i er) 

Descript i on   
WebSphere 

Version   

Level  
of  
M et ri cs 

Data 
Poin t  
Type  

CreateCount 
Thread 
creates 

Total number of threads created. 
3.5.5 and 
above 

Low Long 

DestroyCount 
Thread 
destroys 

Total number of threads destroyed. 
3.5.5 and 
above 

Low Long 

Act iveCount 
Act ive 
threads 

Number of concurrent ly act ive 
threads. 

3.5.5 and 
above 

High Load 

PoolSize Pool size Average number of threads in  pool. 
3.5.5 and 
above 

High Load 

PercentMaxed 
Percent 
maxed 

Average percent of the t ime that al l  
threads are in  use. 

3.5.5 and 
above 

High Load 

Parameters 

The fol lowing parameters are val id for th is counter category: 

Thread Pools (WebSphere All Versions) 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Pool 

Name of thread pool to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long or Load. 

Interval 
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Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.  
   

WebSphere Transaction Module Counters 

The counters discovered for the Transact ion category are determined by the level of metrics you set in  
WebSphere. The Transact ion data counters may include the fol lowing counters: 

Coun ter Nam e (6.0 and 
greater) 

Coun ter Nam e 
 (5.0 or earl i er) 

Descript i on   
WebSphere 

Version   
Level  of  
M et ri cs 

Data 
Poin t  
Type  

GlobalBegunCount 
Number global 
t ransact ions 
begun 

Total number of 
global 
t ransact ions 
begun on server. 

4.0 and 
above 

Low Long 

GlobalInvolvedCount 
Number global 
t ransact ions 
involved 

Total number of 
global 
t ransact ions 
involved on server 
(for example, 
begun and 
imported). 

4.0 and 
above 

Low Long 

LocalBegunCount 
Number local 
t ransact ions 
begun 

Total number of 
local t ransact ions 
begun on server. 

4.0 and 
above 

Low Long 

Act iveCount 
Act ive global 
t ransact ions 

Number of 
concurrent ly 
act ive global 
t ransact ions. 

3.5.5 and 
above 

Low Load 

LocalAct iveCount 
Act ive local 
t ransact ions 

Number of 
concurrent ly 
act ive local 
t ransact ions. 

4.0 and 
above 

Low Load 

GlobalTranTime 
Global 
t ransact ions 
durat ion 

Average durat ion 
of global 
t ransact ions. 

3.5.5 and 
above 

Medium Stat 

LocalTranTime 
Local t ransact ion 
durat ion 

Average durat ion 
of local 
t ransact ions. 

4.0 and 
above 

Medium Stat 

GlobalBeforeComplet ionTime 
Local t ransact ions 
before_complet ion 
t ime 

Average durat ion 
of 
before_complet ion 
for local 
t ransact ions. 

4.0 and 
above 

Medium Stat 
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GlobalCommitTime 
Global t ransact ion 
commit t ime 

Average durat ion 
of commit for 
global 
t ransact ions. 

4.0 and 
above 

Medium Stat 

GlobalPrepareTime 
Global t ransact ion 
prepare t ime 

Average durat ion 
of prepare for 
global 
t ransact ions. 

4.0 and 
above 

Medium Stat 

LocalBeforeComplet ionTime 
Local t ransact ion 
before_complet ion 
t ime 

Average durat ion 
of 
before_complet ion 
for local 
t ransact ions. 

4.0 and 
above 

Medium Stat 

LocalCommitTime 
Local t ransact ion 
commit t ime 

Average durat ion 
of commit for 
local t ransact ions. 

4.0 and 
above 

Medium Stat 

CommittedCount 
Number global 
t ransact ions 
committed 

Total number of 
global 
t ransact ions 
committed. 

3.5.5 and 
above 

Low Long 

RolledbackCount 
Number of global 
t ransact ions rol led 
back 

Total number of 
global 
t ransact ions rol led 
back. 

3.5.5 and 
above 

Low Long 

Optimizat ionCount 
Number global 
t ransact ions 
opt imized 

Number of global 
t ransact ions 
converted to 
single phase for 
opt im izat ion. 

4.0 and 
above 

Low Long 

LocalCommittedCount 
Number of local 
t ransact ions 
committed 

Number of local 
t ransact ions 
committed. 

4.0 and 
above 

Low Long 

LocalRolledbackCount 
Number of local 
t ransact ions rol led 
back 

Number of local 
t ransact ions rol led 
back. 

4.0 and 
above 

Low Long 

GlobalTimeoutCount 
Number of global 
t ransact ions t imed 
out 

Number of global 
t ransact ions t imed 
out. 

4.0 and 
above 

Low Long 

LocalTimeoutCount 
Number of local 
t ransact ions t imed 
out 

Number of local 
t ransact ions t imed 
out. 

4.0 and 
above 

Low Long 

Parameters 

The fol lowing parameters are val id for th is counter category: 
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Transactions (All Versions) 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long, Load, or Stat. 

Interval 

Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.  
   
   

WebSphere W eb App Module Counters 

The counters discovered for the Web Applicat ion category are determined by the level of metrics you set in  
WebSphere. The Web Applicat ion data counters may include the fol lowing counters: 

Coun ter Nam e (6.0 
and greater) 

Coun ter Nam e 
 (5.0 or earl i er) 

Descript i on   
WebSphere 

Version   
Level  of  
M et ri cs  

Data 
Poin t  
Type  

LoadedServletCount numLoadedServlets 
Number of servlets 
that were loaded. 

3.5.5 and 
above 

Low Long 

ReloadCount numReloads 
Number of servlets 
that were reloaded. 

3.5.5 and 
above 

Low Load 

RequestCount totalRequests 
Total number of 
requests a servlet 
processed. 

3.5.5 and 
above 

Low Long 

ConcurrentRequests concurrentRequests 
Number of requests 
that are concurrent ly 
processed. 

3.5.5 and 
above 

High Stat 

ServiceTime responseTime 
Response t ime, in  
mil l iseconds, of a 
servlet request. 

3.5.5 and 
above 

Medium Long 
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ErrorCount numErrors 
Total number of 
errors in  a servlet or 
Java Server Page (JSP). 

3.5.5 and 
above 

Low Long 

Parameters 

The fol lowing parameters are val id for th is counter category: 

Web Applications (Versions 3 and 4) 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Application 

Name of appl icat ion to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Servlet 

Name of servlet to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Web Applications (Version 5) 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Application 
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Name of appl icat ion to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

War File 

Name of war fi le to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Servlet 

Name of servlet to monitor. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long, Load, or Stat. 

Interval 

Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.  
   

WebSphere W eb Services Module Counters  

The counters discovered for the WebSphere Web Service category are determined by the level of metrics 
you set in  WebSphere. The WebSphere Web Service data counters may include the fol lowing counters: 

Coun ter Nam e (6.0 and 
greater) 

Coun ter Nam e 
 (5.0 or earl i er)  

Descript i on   
WebSphere 

Version   
Level  of  
M et ri cs 

Data 
Poin t  
Type  

LoadedWebServiceCount  
Number of loaded 
Web services. 

5.02 and 
above 

Low Long 

ReceivedRequestCount  
Number of 
requests the service 
received. 

5.02 and 
above 

Low Long 

DispatchedRequestCount  
Number of 
requests the service 
dispatched.  

5.02 and 
above 

Low Long 

ProcessedRequestCount  

Number of 
requests the service 
successful ly 
processed. 

5.02 and 
above 

Low Stat 
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ResponseTime  

Average response 
t ime, in  
mil l iseconds, for a 
successful request. 

5.02 and 
above 

High Stat 

RequestResponseTime  

Average response 
t ime, in  
mil l iseconds, to 
prepare a request 
for dispatch. 

5.02 and 
above 

Medium Stat 

DispatchResponseTime  

Average response 
t ime, in  
mil l iseconds, to 
dispatch a request. 

5.02 and 
above 

Medium Stat 

ReplyResponseTime  

Average response 
t ime, in  
mil l iseconds, to 
prepare a reply 
after dispatch. 

5.02 and 
above 

Medium Stat 

PayloadSize  

Average payload 
size in  bytes of a 
received request or 
reply. 

5.02 and 
above 

Medium Stat 

RequestPayloadSize  
Average payload 
size in  bytes of a 
request. 

5.02 and 
above 

Medium Stat 

ReplyPayloadSize  
Average payload 
size in  bytes of a 
reply. 

5.02 and 
above 

Medium Stat 

Parameters 

The fol lowing parameters are val id for th is counter category: 

Node Name 

Node or machine name to monitor. Select the node that you want to monitor from the l ist  of 
avai lable nodes. The default  value is the first  node in the l ist  of avai lable nodes. 

You can specify one or more names for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Server Name 

Applicat ion server to monitor.  Select the server name that you want to mon itor from the l ist  of 
avai lable servers. The default  value is the first  appl icat ion server in  the l ist .   
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You can specify one or more servers for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Instance Name 

Instance name to monitor. Select the instance name that you want to monitor from the l ist  of 
avai lable instances. The default  value is the first  instance in the l ist .   

You can specify one or more instances for monitoring. In  any combinat ion, select values from the 
discovered l ist , or enter values manually. 

Primary Data Point 

The datapoint type and the parameters specified in  the task determine your datapoint.  See WebSphere 
IDPs (Intel l igent Data Points):  Long. 

Interval 

Recommended minimum is 5 minutes. 

Information presented in the table on this page is:  
Reprinted Courtesy of  Internat ional Business Machines Corporat ion copyright (2005) (c) Internat ional Business Machines 
Corporation.  

 

WebSphere MQ Counters 

WebSphere MQ Remote Extended Counters  

The fol lowing extended WebSphere MQ remote counters are provided in QALoad. These counters extend 
the monitoring of your WebSphere MQ system: 

Channel Events 

Channel Status 

Error Log Entries 

Percent Queue Depth 

Performance Events 

Queue Depth 

Queue Manager Connect ions 

Queue Manager Events 

Queue Manager Stat ist ics 

Queue Manager Up/Down 

Queue Stat ist ics 

 

 

WebSphere MQ Channel Events  

This counter reports the number of channel events for the current in terval. 

Parameters 

Queue Manager 

Queue manager you are monitoring. 

Event Name 

Specify the name(s) of the event(s) you want to monitor.  Al l  events on the queue are monitored 
unless event name(s) are selected. 

Even t  Nam e Descript i on  
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Channel Act ivated This condit ion is detected when a channel that has been 
wait ing to become act ive,and for which a Channel Not 
Act ivated event has been generated, is now able to become 
act ive, because an act ive slot has been released by another 
channel. 

Channel Auto-
Defin i t ion Error 

Automatic channel defin i t ion fai led. 

Channel Auto-
Defin i t ion OK 

Automatic channel defin i t ion succeeded. 

Channel 
Conversion Error 

This condit ion is detected when a channel is unable to carry out 
data conversion. 

Channel Not 
Act ivated 

The channel is unable to establ ish the connect ion because the 
l im it  on the number of act ive channels has been reached. 

Channel Started An instance of a channel has been successful ly establ ished 

Channel Stopped The channel was stopped. 

Channel Stopped 
By User 

The channel has been stopped by the operator. 

 

Primary Data Point 

The primary data point is the number of channel events for the specified queue for the current interval. 

Intelligent Data Point 

The intel l igent data point displays the number of channel events, descript ion of individual events 
(event name, date &  t ime that the message was put on the event queue, name of the queue manager 
that put the message, queue associated with the event, and reason code). 

Channel events are reported by channels as a result  of condit ions detected during their operat ion. 
 For example, when a channel instance is stopped.  Channel events are generated: 

!  By a command to start or stop a channel 

!  When a channel instance starts or stops 

!  When a channel receives a conversion error warning when getting a message. 

!  When an attempt is made to create a channel automatically; the event is generated whether the attempt 
succeeds or fails. 

Interval 

Recommended minimum is 5 minutes. 

 

WebSphere MQ Channel Status 

This counter reports the running state of a channel.  This counter cannot be used for cl ient-connect ion 
channels. 

Parameters 
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Queue Manager 

Queue manager you are monitoring. 

Channel 

Channel you are monitoring. 

Primary Data Point 

The primary data point is the running state of a channel. 

!  "1" if the channel is active. 

!  "0" if the channel is not active. 

!  "-1" if an error occurred. 

Intelligent Data Point 

The intel l igent data point l ists the queue manager, channel name, and status, or i f an error occurred. 

Interval 

Recommended minimum is 5 minutes. 

 

WebSphere MQ Error Log Entries 

This counter reports the number of errors in  the MQ error log fi le for the current in terval.  It  uses standard 
Java fi le processing API funct ions to gather the in formation.  

Note: This counter does not appear in the discovery data if the MQ instance was configured as remote in 
the agent manager.  

Parameters 

Error Number 

Specify Al l  Errors, a single error number, or an error number range to monitor. 

Error Num ber Range  Descript i on  

AMQ3500-AMQ3999  WebSphere MQ for Windows 
messages. 

AMQ4000-AMQ4999  WebSphere MQ for Windows NT 
User Interface messages. 

AMQ5000-AMQ5999  Instal lable services messages. 

AMQ6000-AMQ6999 Common services messages. 

AMQ7000-AMQ7999 WebSphere MQ product messages. 

AMQ8000-AMQ8999  WebSphere MQ administrat ion 
messages. 

AMQ9000-AMQ9999  Remote messages. 
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Primary Data Point 

The primary data point is the number of errors in  the error log fi le for the current in terval. 

Intelligent Data Point 

There are three alternat ives for what is returned for the in tel l igent data point. It  depends on what 
you selected for the Error Number parameter. 

The data point detai l  l ists each error and the number of t imes i t  occurred with in the in terval. 

One error chosen : 

!  Number of errors in interval that match the error number.  

!  Each error range and count for the range. 

!  Total errors during the interval. 

Error range chosen : 

!  Number of errors in interval that are within chosen range.  

!  Top 10 errors in range. 

!  Error range and count for the range. 

!  Total errors during the interval. 

Al l  errors chosen : 

!  Number of errors in interval. 

!  Top 10 errors. 

!  Error and count. 

!  Error range and count for the range. 

!  Total errors during the interval. 

Interval 

Recommended minimum is 5 minutes. 

 

WebSphere MQ Percent Queue Depth 

This counter reports the current queue depth as a percentage of the defined maximum. 

Parameters 

Queue Manager 

Queue manager you are monitoring. 

Queue 

Name of the queue you are monitoring. 

Primary Data Point 

The primary data point is the current queue depth as a percentage of the defined maximum. 

Intelligent Data Point 

The intel l igent data point l ists the queue manager, queue, current queue depth, and percent queue 
depth. 
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Interval 

Recommended minimum is 5 minutes. 

 

WebSphere MQ Performance Events 

This counter reports the number of performance events for the current in terval. 

Parameters 

Queue Manager 

Queue manager you are monitoring. 

Performance Event Queue 

Name of the performance event queue that you are monitoring. The default  value is 
SYSTEM.ADMIN.PERFM.EVENT. 

Event Name 

Specify the name(s) of the event(s) you want to monitor.  Al l  events on the queue are monitored 
unless event name(s) are selected. 

Even t  Nam e  Descript i on  

Queue Depth High Queue depth h igh l im it  reached or exceeded. 

Queue Depth Low Queue depth low l im it  reached or exceeded. 

Queue Ful l  Queue already contains maximum number of 
messages. 

Queue Service Interval 
High 

No successful gets or puts have been detected 
with in an in terval greater than the l im it  
specified in  the Q Service Interval at tribute. 

Queue Service Interval 
OK 

A successful get has been detected with in an 
in terval less than or equal  to the l im it  specified 
in  the Q Service Interval at tribute. 

 

Primary Data Point 

The primary data point is the number of performance events for the specified queue during the current 
interval. 

Intelligent Data Point 

The intel l igent data point displays the number of performance events, descript ion of individual 
events (performance event type, event name, date &  t ime that the message was put on the event 
queue, name of the queue manager that put the message, queue associated wi th the event, t ime 
since reset, h igh queue depth, message enqueue count, message dequeue count and reason code). 

Performance events are not i ficat ions that a threshold condit ion has been reached by a resource. The 
condit ions can affect the performance of appl icat ions that use a specified queue. Performance event 
types are:  
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!  Queue Depth High 

!  Queue Depth Low 

!  Queue Full 

!  Queue Service Interval High 

!  Queue Service Interval OK 

Performance event stat ist ics are reset when a performance event occurs or a queue manager stops 
and restarts. 

Interval 

Recommended minimum is 5 minutes. 

 

WebSphere MQ Queue Depth 

This counter monitors the current depth of the specified queue. 

Parameters 

Queue Manager 

Queue manager you are monitoring. 

Queue 

Name of the queue you are monitoring. 

Primary Data Point 

The primary data point is the number of messages on queue. 

Intelligent Data Point 

The intel l igent data point l ists the queue manager, queue, and queue depth. 

Interval 

Recommended minimum is 5 minutes. 

WebSphere MQ Queue Manager Connections 

This counter reports the current number of connect ions to a queue manager. 

Parameters 

Queue Manager 

Queue manager you are monitoring. 

Primary Data Point 

The primary data point is the posit ive in teger represent ing the number of connect ions or "-1" i f an 
error occurred. 

Intelligent Data Point 

The intel l igent data point l ists the queue manager, the number of act ive connect ions, and the 
connect ion names. If an error occurred, then i t  displays the error number and descript ion. 
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Interval 

Recommended minimum is 5 minutes. 

WebSphere MQ Queue Manager Events 

This counter reports the number of queue manager events for the current in terval. 

Parameters 

Queue Manager 

Queue manager you are monitoring. 

Queue Manager Event Queue 

Name of the queue manager event queue you are monitoring. The default  value is 
SYSTEM.ADMIN.QMGR.EVENT. 

Event Name  

Specify the name(s) of the event(s) to monitor.  Al l  events on the queue are monitored unless event 
name(s) are selected. 

Even t  Nam e Descript i on  

Alias Base Queue Type 
Error  

The Base Q Name in the al ias queue defin i t ion resolves to a queue 
that is not a local queue, or local defin i t ion of a remote queue. 

Default  Transmission 
Queue Type Error 

Either a local defin i t ion of the remote queue was specified, or a 
queue-manager al ias was being resolved, but in  either case the 
XmitQName attribute in  the local defin i t ion is blank. 

Default  Transmission 
Queue Usage Error  

The queue defined by the DefXmitQNamequeue-manager attribute 
does not have a Usage attribute of MQUS_TRANSMISSION. 

Get Inhibited  Gets inhibited for the queue. 

Not Authorized  The user is not authorized for access. 

Put Inhibited Put cal ls inh ibited for the queue. 

Queue Manager Act ive Queue manager created. 

Queue Manager Not 
Act ive 

Queue manager unavai lable. 

Queue Type Error  Queue type not val id. 

Remote Queue Name 
Error  

Remote queue name not val id. 

Transmission Queue 
Type Error  

Transmission queue not local. 

Transmission Queue 
Usage Error  

Transmission queue with wrong usage. 

Unknown Alias Base The BaseQName in the al ias queue attributes is not recognized as a 
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Queue queue name. 

Unknown Default  
Transmission Queue  

The XmitQName attribute in  the local defin i t ion is blank. 

Unknown Object 
Name 

The Object Name in the object descriptor is not recognized for the 
specified object type. 

Unknown Remote 
Queue Manager  

An error occurred with the queue-name resolut ion. 

Unknown 
Transmission Queue 

The XmitQName attribute of the defin i t ion is not blank and not 
the name of a local ly-defined queue. 

Primary Data Point 

The primary data point is the number of queue manager events for the curren t in terval. 

Intelligent Data Point 

The intel l igent data point displays the number of queue manager events, descript ion of individual 
events (queue manager event type, event name, date &  t ime that the message was put on the event 
queue, name of the queue manager that put the message, and reason code). 

Queue manager events are events that are related to the defin i t ions of resources with in queue 
managers.  For example, an appl icat ion attempts to put a message to a queue that does not exist . 
 Queue manager event types are:  authori ty, inh ibit, local, remote, and start /stop. 

Even t  Type Reason  Code 

Authori ty Events !  Not Authorized (type 1) 

!  Not Authorized (type 2) 

!  Not Authorized (type 3) 

!  Not Authorized (type 4) 

Inh ibit  Events !  Get Inhibited 

!  Put Inhibited  

Local Events !  Alias Base Queue Type Error 

!  Unknown Alias Base Queue 

!  Unknown Object Name 

Remote Events !  Default Transmission Queue Type Error 

!  Default Transmission Queue Usage Error 

!  Queue Type Error 

!  Remote Queue Name Error 

!  Transmission Queue Type Error 

!  Transmission Queue Usage Error 

!  Unknown Default Transmission Queue 

!  Unknown Remote Queue Manager 

!  Unknown Transmission Queue 

Start  and Stop 
Events 

!  Queue Manager Active 

!  Queue Manager Not Active 
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Interval 

Recommended minimum is 5 minutes. 

 

WebSphere MQ Queue Manager Statistics 

This counter reports stat ist ics describing a queue manager.  

Parameters 

Queue Manager 

Queue manager you are monitoring. 

Statistic 

Specify the stat ist ic to  use as the primary data point.: 

Authori ty Even ts Reports the on/off value of Authori ty events. Authori ty events indicate 
that an authorizat ion violat ion has been detected. 

Autom at i c 
Channel  
Def in i t i on  Even ts  

Reports the on/off value of Automatic Channel Defin i t ion events. 
 Automatic channel defin i t ion events indicate whether an automatic 
defin i t ion of a channel fai ls or succeeds. 

Inh ibi t  Even ts Reports the on/off value of Inhibit  events.  Inhibit  events indicate that 
an MQPUT or MQGET operat ion has been attempted against a queue, 
where the queue is inh ibited for puts or gets respect ively. 

Local  Even ts Reports the on/off value of Local events.  Local events indicate that an 
appl icat ion (or the queue manager) has not been able to access a local 
queue, or other local object. 

Perform an ce 
Even ts 

Reports the on/off value of Performance events.  Performance events are 
not i ficat ions that a threshold condit ion has been reached by a resource. 

Rem ote Even ts Reports the on/off value of Remote events.  Remote events indicate that 
an appl icat ion (or the queue manager) cannot access a (remote) queue 
on another queue manager. 

Start  Stop Even ts Reports the on/off value of these events.  Start  and stop events indicate 
that a queue manager has been started or has been requested to stop or 
quiesce. 

Primary Data Point 

The primary data point is the one of the following statistics as specified by the Statistics parameter: 

!  Authority Events 

!  Automatic Channel Definition Events 

!  Inhibit Events 

!  Local Events 

!  Performance Events 

!  Authority Events 

!  Automatic Channel Definition Events 
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Intelligent Data Point 

The intel l igent data point l ists the queue manager and queue manager stat ist ics.  This counter 
reports the current state of the stat ist ics, i t  does not report  the stat ist ics values as they progress 
through t ime.  For dynamic in formation, monitor with the Queue Manager Event counter.  As 
appropriate, any of the fol lowing in formation may be included: 

Data Descript i on  

Authori ty Events = <integer> Variable that stores the on/off value of these events. Authori ty 
events indicate that an authorizat ion violat ion has been detected. 

Automatic Channel 
Defin i t ion Events = <integer>  

Variable that stores the on/off value of these events.  Automatic 
channel defin i t ion events indicate whether an automatic 
defin i t ion of a channel fai ls or succeeds. 

Inhibit  Events = <integer>  Variable that stores the on/off value of these events.  Inhibit  events 
indicate that an MQPUT or MQGET operat ion has been attempted 
against a queue, where the queue is inh ibited for puts or gets 
respect ively. 

Local Events = <integer>  Variable that stores the on/off value of these events.  Local events 
indicate that an appl icat ion (or the queue manager) has not been 
able to access a local queue, or other local object. 

Performance Events = 
<integer>  

Variable that stores the on/off value of these events.  Performance 
events are not i ficat ions that a threshold condit ion has been 
reached by a resource. 

Remote Events = <integer>  Variable that stores the on/off value of these events.  Remote 
events indicate that an appl icat ion (or the queue manager) cannot 
access a (remote) queue on another queue manager. 

Start  Stop Events = <integer>  Variable that stores the on/off value of these events.  Start  and stop 
events indicate that a queue manager has been started or has been 
requested to stop or quiesce. 

Cluster Workload Data = 
<wstring>   

Cluster workload exit  data. 

Command Level = <integer>   Level of system control commands supported by the queue 
manager. 

Interval 

Recommended minimum is 5 minutes. 

 

WebSphere MQ Queue Manager Up/Down 

This counter monitors the running state of a queue manager. 

Parameters 

Queue Manager 

Queue manager you are monitoring. 
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Primary Data Point 

The primary data point is the running state of queue manager. 

!  "1" if the queue manager is running. 

!  "0" if the queue manager is not running. 

!  "-1" if an error occurred. 

Intelligent Data Point 

The intel l igent data point l ists the queue manager and whether the queue manager is up, down, or 
an error occurred. 

Interval 

Recommended minimum is 5 minutes. 

 

WebSphere MQ Queue Statistics 

This counter reports stat ist ics describing a queue. 

Parameters 

Queue Manager 

Queue manager you are monitoring. 

Queue 

Name of the queue you are monitoring. 

Statistic 

Specify the stat ist ic to use as the primary data point.  

Curren t  Depth  Reports the current number of messages on queue. 

Queue Depth  High  
Even t  

Reports the on/off value of these events.  Queue depth h igh events 
indicate that the queue depth has increased to a predefined threshold. 

Queue Depth  Low  
Even t  

Reports the on/off value of these events. Queue depth low events 
indicate that the queue depth has decreased to a predefined threshold. 

Queue Depth  M ax  
Even t  

Reports the on/off value of these events. Queue depth max events 
indicate that the queue has reached i ts maximum depth, that is, the 
queue is ful l . 

Queue Servi ce 
In terval  Even t   

Reports the on/off value of these events. Queue service in terval events 
are related to whether messages are processed with in a user-specified 
t ime interval. 

Primary Data Point 

The primary data point is the one of the following statistics as specified by the Statistics parameter: 

!  Current Depth 

!  Queue Depth High Event 

!  Queue Depth Low Event 
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!  Queue Depth Max Event 

!  Queue Service Interval Event  

Intelligent Data Point 

The intel l igent data point l ists the queue manager, queue, and queue stat ist ics. This counter reports the 
current state of the stat ist ics, i t  does not report  the stat ist ics values as they progress through t ime.  For 
dynamic in formation, use the Queue Manger Events counter.  As appropriate, any of the fol lowing 
in formation may be included: 

 

Data Descript i on  

Inh ibit  Get = <integer> 
  

Indicates whether get operat ions are al lowed on the queue. 

Inhibit  Put = <integer>   Indicates whether put operat ions are al lowed on the queue. 

Current Queue Depth = 
<integer>  

Current number of messages on the queue. 

Maximum Queue 
Depth = <integer>  

Maximum number of messages al lowed  on the queue. 

Queue Depth High 
Event = <integer>  

Variable that stores the on/off value of these events.  Queue depth 
h igh events indicate that the queue depth has increased to a 
predefined threshold. 

Queue Depth High 
Limit  = <integer>  

Value that  t riggers an event i f i t  is reached. 

Queue Depth Low 
Event = <integer> 

Variable that stores the on/off value of these events. Queue depth 
low events indicate that the queue depth has decreased to a 
predefined threshold. 

Queue Depth Low Limit  
= <integer>  

Value  that triggers an event i f i t  is reached. 

Queue Depth Max 
Event = <integer>  

Variable that stores the on/off value of these events. Queue depth 
max events indicate that the queue has reached i ts maximum depth, 
that is, the queue is ful l . 

Queue Service Interval 
Event = <integer>  

Variable that stores the on/off value of these events. Queue service 
in terval events are related to whether messages are processed with in 
a user-specified t ime interval. 

Queue Service Interval 
= <integer>  

Queue service in terval t ime. 

Trigger Data = 
<wstring>   

Free-format data that is wri t ten in to a trigger message. 

Trigger Depth = 
<integer> 

Number of messages that have to be on the queue before a trigger 
message is wri t ten. 

Trigger Control = Controls whether or not trigger messages are writ ten to an in i t iat ion 
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<integer>   queue. 

Interval 

Recommended minimum is 5 minutes. 

 

WMI Counters 

WMI Remote Extended Counters 

The fol lowing extended WMI (Windows M anagement Instrument) remote counters are provided in 
QALoad. To display and use the extended counters in  task configurat ion, you must configure user access 
with the MMC (M icrosoft  Management Console) and configure the WMI agent using the ServerVantage 
Agent Console (Reconfigure Agent). These procedures are described in the topic Configuring WMI  in  the 
ServerVantage Agent Configurat ion onl ine help. Once configurat ion is complete, and you select WMI 
col lector as your Server Type during task configurat ion on the Select Counters page, ServerVantage 
discovers the Windows registry counters and the extended counters for each WMI-configured server.      

 These counters extend the monitoring of your WM I system: 

WMI WQL 

 
WMI Top Ten Counters: 

!  CPU Utilization % - Top Ten 

!  Memory Utilization % - Top Ten 

!  I/O Utilization % - Top Ten 

 

 

WMI Top Ten Counters 

!  Top Ten CPU  

!  Top Ten Memory  

!  Top Ten I/O 

CPU Utilization % - Top Ten 

The CPU Uti l izat ion % - Top Ten counter provides data for the Load Characterizat ion Report.  It  returns a 
numeric value for each of the top ten processes that ut i l ize the most machine CPU or al l  processes for 
which CPU ut i l izat ion is greater than 0.01% at a part icular moment of t ime. 

This counter does not generate events. 

Parameter  

The Process parameter is not modifiable. Its  value  is an  * (asterisk) which monitors al l  processes.. 

DataPoints 

The datapoints are viewable (see above counter descript ion).  

Memory Utilization % - Top Ten 

The Memory Uti l izat ion % - Top Ten provides data for Load Characterizat ion Report.  It  returns a numeric 
value for each of the top ten processes that ut i l ize the most machine Memory or al l  processes for which 
Memory ut i l izat ion is greater than 0.01% at a part icular moment of t ime. 

This counter does not generate events. 
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Parameter  

The Process parameter is not modifiable. Its  value  is an  * (asterisk) which monitors al l  processes.. 

DataPoints 

The datapoints are viewable (see above counter descript ion).  

I/O Utilization % - Top Ten 

The /O Uti l izat ion % - Top Ten provides data for Load Characterizat ion Report. It  returns a numeric value 
for each of the top ten processes that ut i l ize the most machine I/O or al l  processes for which I/O ut i l izat ion 
is greater than 0.01% at a part icular moment of t ime. 

This counter does not generate events. 

Parameter  

The Process parameter is not modifiable. Its  value  is an  * (asterisk) which monitors al l  processes.. 

DataPoints 

The datapoints are viewable (see above counter descript ion).  

 

WMI WQL  

The WMI WQL (Windows Query Language) counter monitors the object (s) specified by the WQL 
statement. Users may select predefined WQL templates.  

Parameters 

WQL Statement 

Enter a val id WQL ( WMI Query Language) statement. 

Data Point 

Primary Data Point 

The primary data point returns 0 i f the WMI system executed query is successful. If the query fai ls, the 
graph displays DATA_NOT_FOUND as the data point. If you cl ick on the data point, the actual error is 
provided in the error descript ion.  

Intelligent Data Point 

The intel l igent data point (IDP) is the response from the query. 

Interval 

Recommended minimum interval 5 minutes. 

. 

About  M on i toring Tem plates 

Using Monitoring Templates 

Monitoring templates are designed to faci l i tate the configurat ion process. A monitoring template is a 
predefined group of counters not associated with a specific machine. You can create a new template for a 
monitoring task, or you can use one of QALoad's pre-defined templates. 
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 When you create a custom template, QALoad's New Monitoring Template wizard guides you through the 
process of defin ing the type of template you want to create, configuring the monitor propert ies, and 
adding the counters and instances of counters to the template. 

 When you use one of QALoad's predefined templates, you select a stored template with the counters you 
want to monitor. The templates have counters grouped by funct ional i ty, such as Network Traffic, Response 
Time, or System Health. Where appropriate, the templates include the specif ic instances to monitor for 
each counter. 

You can add or edit  counters in  either custom or pre-defined templates. When you open a template to edit  
for the first  t ime, Edit  Monitoring Template wizard guides you through the process of discovering and 
adding new counters to a template. When you've just completed the counter discovery process for a 
template, either by creat ing a new template or by opening a template for edit ing, you can select counters 
from those already avai lable in  memory by using the cached discovery.  

Custom Templates  

You can create templates of the monitoring tasks that you develop so that al l  of the counters and instances 
for the task are saved. You can create new tasks and incorporate the template you created. Templates are 
saved as .xml fi les in  the Templates directory. 

You can create a template when you define a monitoring task, or you can use the New Monitor Template 
wizard to create and store a template for future use. Custom templates can be modified using either new 
discovery data or cached discovery data. 

 

Pre-defined Templates 

About Pre-defined Templates  

QALoad provides pre-defined templates for each monitor type. Each template includes the counters most 
commonly used for part icular task with in each monitor type.  

QALoad provides the templates form the fol lowing monitor types: 

!  SAP 

!  Server Analysis Agent 

!  SNMP 

!  WebLogic 

!  WebSphere 

!  WebSphere MQ 

!  Windows Registry 

!  WMI 

Note: You cannot modify pre-defined templates. 
 

SAP Templates 

QALoad provides the fol lowing pre-defined SAP templates: 

QALoad-SAP R3 Remote Avai labi l i ty 

QALoad-SAP R3 Remote Performance 

QALoad-SAP R3 Remote System Errors 
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QALoad-SAP R3 Remote Availability 

This template monitors the avai labi l i ty of an SAP R/3 Instance. The SAP R/3 Avai labi l i ty template returns 
cri t ical in formation about  the avai labi l i ty of your SAP instal lat ion. One metric used to determine the 
avai labi l i ty of an SAP R/3 Instance is the status of the SAP col lector. 

The default  event act ion assigned to th is template issues an alarm if ei ther the specified R/3 Instance or the 
col lector goes down. The default  instance is the first  SAP Instance configured for monitoring during 
instal lat ion. 

The SAP R/3 Avai labi l i ty template uses the fol lowing SAP R/3 extended counters: 

Coun ters Descript i on  

Active Servers Returns the number of act ive SAP appl icat ion servers for 
a given instance. It  detects when a remote server is 
unavai lable. 

Rule:  IF  'SAP R/3 Remote Extended.Act ive Servers(SAP 
Instance: "**", Server Count: "10")' = 0 . 

QALoad-SAP R3 Remote Performance 

This template monitors the performance of your SAP R/3 Instance. 

The default  event act ion for th is template raises an event i f the number of alerts of cri t ical status is greater 
than 0, or i f the buffer h it rat io fal ls below 95%. 

Al l  the counters associated with th is template require the instance number of your SAP instal lat ion. By 
default , th is template uses the first  instance configured for monitoring during ServerVantage instal lat ion. If 
you use the task configurat ion wizard to change the instance that the template monitors, you must also 
change the instance specified in  the rule accordingly. 

The SAP R/3 Performance template uses the fol lowing SAP R/3 extended counters: 

Coun ters Descript i on  

Buffer Stat ist ic Returns different buffer stat ist ics for selected buffer name. This 
counter was chosen because buffering data is a key to the 
performance of SAP. 

Rule: IF  'SAP R/3 Remote Extended.Buffer Stat ist ic(SAP Instance: 
"**", Buffer Name: "TTAB", Stat ist ic Name: "Hit  rate SAP 
buffer(%%)")' < 95. 

 Itemized Spool Queue Return number of entries in  the spool queue that match the 
specified cri teria. 

Rule: IF   'SAP R/3 Remote Extended.Spool Queue(SAP Instance: 
"**", Request Status: "Processing")' > 10. 

Memory Usage Returns current memory usage.  

Rule: IF   'SAP R/3 Remote Extended.Memory Usage(SAP Instance: 
"**", Count: "10", Metrics: "MB")' > 10000. 

Page/Roll  Area Returns Used Paging Area % stat ist ic. This counter was chosen 
because rol l  memory is cri t ical for work processes and page 
memory is cri t ical for in ternal data processing. 
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 Work Processes Counter for monitoring SAP R/3 work processes. Returns number 
of stopped work processes.  

Rule: IF 'SAP R/3 Remote Extended.Work Processes(SAP Instance: 
"**", Process Type: "BGDDIAENQSPOUP2UPD", Process State: 
"Stopped")' > 2. 

 

QALoad-SAP R3 Remote System Errors 

This template monitors the errors and cri t ical si tuat ions that occur on a SAP R/3 system. Rules and 
thresholds are preset to appropriate values for most si tes. 

The default  sampling in terval for th is template is 5 minutes. 

The SAP R/3 Performance template uses the fol lowing SAP R/3 Remote extended counters: 

Coun ters Descript i on  

Alerts Counter for monitoring R/3 alerts. Returns number of alerts 
according to the specified cri teria. This counter checks al l  alerts 
with error (red) status.  

Rule: IF 'SAP R/3 Remote Extended.Alerts(SAP Instance: "**", 
Monitor Set: "SAP CCMS Admin Workplace", Moni tor: 
"Database", Severi ty: "Error - Red", Pattern: "*", Show Alert  Text: 
"No")' > 0. 

Itemized Spool Queue Return number of entries in  the spool queue that match the 
specified cri teria. 

Spool Queue Return number of entries in  the spool queue that match the 
specified cri teria. This counter checks al l  spool entries with 
“ Problem ”  status.  

Rule: IF 'SAP R/3 Remote Extended.Spool Queue(SAP Instance: 
"**", Request Status: "Problem")' > 0. 

Work Processes Counter for monitoring SAP R/3 work processes. Returns number 
of work processes according to the specified cri teria. This counter 
checks stopped work processes.  

Rule: IF 'SAP R/3 Remote Extended.Work Processes(SAP Instance: 
"**", Process Type: "BGDDIAENQSPOUP2UPD", Process State: 
"Stopped")' > 0. 

SNMP Templates 

QALoad provides the fol lowing pre-defined SNMP templates: 

QALoad-HP Performance 
QALoad-Linux Performance 
QALoad-SUN Performance 

QALoad-HP Performance 

This template includes the fol lowing counters and categories: 
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Category Coun ters Descript i on  

HP System  CpuIdle% CpuSys% is the percentage of idle processor 
t ime. 

 CpuSys% CpuSys% is the percentage of non-idle 
processor t ime that is spent in  system mode. 

  CpuUser% CpuUser% is the percentage of non-idle 
processor t ime that is spent in  user mode. 

 FreeMemory KBytes FreeMemory KBytes is the amount of idle 
memory. 

 FreeSwap KBytes FreeSwap is the amount of free swap space on 
the system. 

 MaxUserMem KBytes MaxUserMem is the amount of maximum user 
memory on the system. 

 Users Users is the number of users logged on to the 
machine. 

t cp  tcpInSegs/sec tcpInSegs/sec is the rate at  which segments are 
received, including those received in error. 

 tcpOutSegs/sec tcpOutSegs/sec is the rate at which segments 
are sent, including those on current 
connect ions but excluding those contain ing 
only retransmitted octets. 

 udp udpInDatagrams/sec udpInDatagrams/sec is the rate of UDP 
datagrams being del ivered to UDP users. 

 udpOutDatagrams/sec udpOutDatagrams/sec is the rate at which UDP 
datagrams are sent. 

 

QALoad-Linux Performance 

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

Linux  System  CpuIdle% CpuSys% is the percentage of idle processor 
t ime. 

 CpuSys% CpuSys% is the percentage of non-idle processor 
t ime that is spent in  system mode. 

  CpuUser% CpuUser% is the percentage of non-idle 
processor t ime that is spent in  user mode. 

 In terrupts/sec Interrupts/sec is the rate of system interrupts. 
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  PagesIn KBytes/sec PagesIn KBytes/sec is the rate of pages read in 
from disk. 

  PagesOut KBytes/sec PagesOut KBytes/sec is the rate of pages writ ten 
to disk. 

 SwapIn KBytes/sec SwapIn KBytes/sec is the rate at which pages are 
being swapped in. 

 SwapOut KBytes/sec SwapOut KBytes/sec is the rate at which pages 
are being swapped out. 

t cp  tcpInSegs/sec tcpInSegs/sec is the rate at  which segments are 
received, including those received in error. 

 tcpOutSegs/sec tcpOutSegs/sec is the rate at which segments are 
sent, including those on current connect ions 
but excluding those contain ing only 
retransmitted octets. 

 udp udpInDatagrams/sec udpInDatagrams/sec is the rate of UDP 
datagrams being del ivered to UDP users. 

 udpOutDatagrams/sec udpOutDatagrams/sec is the rate at which UDP 
datagrams are sent. 

 

QALoad-SUN Performance 

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

Sun  System  CpuIdle% CpuSys% is the percentage of idle processor 
t ime. 

 CpuSys% CpuSys% is the percentage of non-idle processor 
t ime that is spent in  system mode. 

  CpuUser% CpuUser% is the percentage of non-idle 
processor t ime that is spent in  user mode. 

 In terrupts/sec Interrupts/sec is the rate of system interrupts. 

  PagesIn KBytes/sec PagesIn KBytes/sec is the rate of pages read in 
from disk. 

  PagesOut KBytes/sec PagesOut KBytes/sec is the rate of pages writ ten 
to disk. 

 SwapIn KBytes/sec SwapIn KBytes/sec is the rate at which pages are 
being swapped in. 

 SwapOut KBytes/sec SwapOut KBytes/sec is the rate at which pages 
are being swapped out. 
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t cp  tcpInSegs/sec tcpInSegs/sec is the rate at  which segments are 
received, including those received in error. 

 tcpOutSegs/sec tcpOutSegs/sec is the rate at which segments are 
sent, including those on current connect ions 
but excluding those contain ing only 
retransmitted octets. 

 udp udpInDatagrams/sec udpInDatagrams/sec is the rate of UDP 
datagrams being del ivered to UDP users. 

 udpOutDatagrams/sec udpOutDatagrams/sec is the rate at which UDP 
datagrams are sent. 

 

WebLogic Templates 

QALoad provides the fol lowing pre-defined WebLogic templates: 

QALoad-WebLogic Avai labi l i ty 

QALoad-WebLogic EJB Performance 

QALoad-WebLogic JDBC Performance 

QALoad-WebLogic JMS Performance 

QALoad-WebLogic Performance 

QALoad-WebLogic Server Securi ty 

QALoad-WebLogic Servlet  Performance 

QALoad-WebLogic Availability 

This template monitors the avai labi l i ty of a WebLogic server. The WebLogic Avai labi l i ty template returns 
cri t ical in formation about  the avai labi l i ty of your WebLogic instal lat ion.  

The default  sampling in terval for th is template is 5 minutes. 

The WebLogic Avai labi l i ty template uses the fol lowing WebLogic extended counters: 

Category Coun ters Descript i on  

ExecuteQueueRun t im e ExecuteQueueRuntime_PendingRequestOldestTime Returns the t ime 
that the longest 
wait ing request 
was placed in 
the queue.  

Rule: The 
Applicat ion 
Server is not in  
running mode i f 
th is counter 
value is > 50. 

ServerRun t im e ServerRuntime_StateVal Returns current 
state of the 
server.  This 
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counter provides 
a more detai led 
state than 
avai lable or not.  

Rule: The 
Applicat ion 
Server is not in  
running mode i f 
th is counter 
value is <> 2. 

ServerSecuri tyRun t im e ServerSecuri tyRuntime_LockedUsersCurrentCount Returns the 
number of 
current ly locked 
users on th is 
server.  

Rule: There are a 
h igh number of 
users locked out 
i f th is counter 
value is  > 5. 

 

QALoad-WebLogic EJB Performance 

This template monitors the EJB performance of a WebLogic server. The WebLogic EJB Performance 
template returns cri t ical in formation about the performance of your WebLogic instal lat ion.  

The default  sampling in terval for th is template is 5 minutes. 

The WebLogic EJB Performance template uses the fol lowing WebLogic extended counters: 

Category Coun ters Descript i on  

EJBCacheRun t im e EJBCacheRuntime_Activat ionCount Returns the total number of 
t imes the EJB was act ivated. 

Rule: There is inefficient cache 
access i f the number of 
act ivat ions is > 20. 

 EJBCacheRuntime_CacheAccessCount Returns the total number of 
attempts to access a bean from 
the cache.  

 EJBCacheRuntime_CachedBeansCurrentCount Returns the total number of 
beans from th is EJB Home 
current ly in  the EJB cache.  

 EJBCacheRuntime_CacheHitCount Returns the total number of 
t imes an attempt to access a 
bean from the cache 
succeeded. The cacheHitCount 
value subtract ing the cache 
miss count from the cache 
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access count. 

 EJBCacheRuntime_Passivat ionCount Returns the total number of 
beans from th is EJB Home that 
have been passivated.  

Rule: There is inefficient cache 
access i f the number of 
passivat ions is > 20. 

EJBLock ingRun t im e EJBLockingRuntime_LockEntriesCurrentCount Returns the number of 
current ly locked users on th is 
server. 

 EJBLockingRuntime_TimeoutTotalCount Returns the current number 
Threads that have t imed out 
wait ing for a lock on a bean.  

 EJBLockingRuntime_WaiterTotalCount Returns the number of objects 
wait ing on the lock. 

Rule: There are a lot  of objects 
wait ing i f the in terval value of 
th is counter is > 10. 

EJBPoolRun t im e EJBPoolRuntime_BeansInUseCurrentCount Returns the number of bean 
instances current ly being used 
from the free pool.  

 EJBPoolRuntime_IdleBeansCount Returns the total number of 
avai lable bean instances in  the 
free pool.  

 EJBPoolRuntime_TimeoutTotalCount Returns the total number of 
Threads that have t imed out 
wait ing for an avai lable bean 
instance from the free pool.  

Rule: There are a lot  of objects 
t im ing out i f the in terval value 
of th is counter is  > 20. 

 EJBPoolRuntime_WaiterTotalCount Returns the total number of 
Threads current ly wait ing for 
an avai lable bean instance 
from the free pool.  

Rule: There are a lot  of objects 
wait ing i f the in terval value of 
th is counter is > 10. 

EJBTransact ionRun t im e EJBTransact ionRuntime_Transact ionsCommittedT
otalCount 

Returns the total number of 
t ransact ions that have been 
committed for th is EJB.  

Rule: There is h igh transact ion 
overhead i f the in terval value 
of th is counter is > 20. 
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 EJBTransact ionRuntime_Transact ionsRolledBackT
otalCount 

Returns the total number of 
t ransact ions that have been 
rol led back for th is EJB.  

Rule: There is h igh transact ion 
overhead i f the in terval value 
of th is counter is > 20. 

 EJBTransact ionRuntime_Transact ionsTimedOutTo
talCount 

Returns the total number of 
t ransact ions that have t imed 
out for th is EJB.  

Rule: There is h igh transact ion 
overhead i f the in terval value 
of th is counter is > 20. 

 M essageDriven EJBRun t i
m e 

MessageDrivenEJBRuntime_JMSConnect ionAlive Returns a boolean of the status 
of the connect ion. This 
counter displays the state of a 
JMS connect ion.  

Rule: The JMS Connect ion is 
down i f th is counter value is = 
0. 

 

QALoad-WebLogic JDBC Performance 

This template monitors the JDBC performance of a WebLogic server. The WebLogic JDBC Performance 
template returns cri t ical in formation about the performance of your WebLogic instal lat ion.  

The default  sampling in terval for th is template is 5 minutes. 

The WebLogic JDBC Performance template uses the fol lowing WebLogic extended counters: 

Category Coun ters Descript i on  

JDBC Connect ion  Pool  
Run t im e 

ActiveConnect ionsCurrentCount Returns the current number of act ive 
connect ions. 

 Act iveConnect ionsHighCount Returns the h ighest number of act ive 
current connect ions. The count starts 
at zero each t ime the 
JDBCConnect ionPoolRuntimeMBean 
is instant iated. 

 Connect ionDelayTime Returns the number of mil l iseconds i t  
takes to get a physical connect ion 
from the database. It  is calculated as 
summary t ime to connect  divided by 
summary number of connect ions. 

 Connect ionsTotalCount Returns the total number of JDBC 
connect ions in  th is 
DBCConnect ionPoolRunt imeMBean 
since the pool was instant iated. 
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 Fai luresToReconnectCount Returns the number of attempts to 
refresh a connect ion to a database 
that fai led. Fai lure may be due to the 
database being unavai lable or a 
broken connect ion to the database. 

Rule: There are a h igh number of 
connect ion reconnect fai lures when 
th is counter value is > 1. 

 LeakedConnect ionCount  Returns the number of connect ions 
that were checked out from the 
connect ion pool but were not 
returned to the pool by cal l ing close 
(). 

Rule: There is a lot  of connect ion 
pool leakage i f th is counter value is  > 
5. 

 PoolState Current state of the connect ion pool. 
Returns True i f the pool is enabled, 
False i f the pool is disabled. 

  PrepStmtCacheMissCount Returns a count  of the cases when 
the cache does not have a cached 
statement to sat isfy a request. 

 Wait ingForConnect ionHighCount The h igh water mark of waiters for a 
connect ion in  th is 
JDBCConnect ionPoolRuntimeMBean. 
The count starts at zero each t ime the 
JDBCConnect ionPoolRuntimeMBean 
is instant iated.  

 WaitSecondsHighCount Returns the h ighest number of 
seconds a connect ion wai ted. 

Rule: There is a long wait  for the 
connect ion pool i f th is counter value 
is  > 120. 

 

QALoad-WebLogic JMS Performance 

This template monitors the JMS performance of a WebLogic server. The WebLogic JMS Performance 
template returns cri t ical in formation about the performance of your WebLogic instal lat ion.  

The default  sampling in terval for th is template is 5 minutes. 

The WebLogic JMS Performance template uses the fol lowing WebLogic extended counters: 

Category Coun ters Descript i on  

JM SConnect ionRun t im e SessionsCurrentCount Returns the current number of 
sessions for th is connect ion. 
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 SessionsTotalCount Returns the number of sessions 
on th is connect ion since the last 
reset. 

JM SRun t im e Connect ionsCurrentCount Returns the current number of 
connect ions to th is WebLogic 
Server. 

  Connect ionsTotalCount Returns the total number of 
connect ions made to th is 
WebLogic Server since the last 
reset. 

JM SServerRun t im e MessagesPendingCount Returns the current number of 
messages pending 
(unacknowledged or 
uncommitted) stored on th is 
JMS server. Pending messages 
are over and above the current 
number of messages. 

Rule: There are a large number 
of pending messages i f th is 
counter value is > 50. 

 MessagesReceivedCount Returns the number of messages 
received on th is dest inat ion 
since the last reset. 

 JM SSessionRun t im e ConsumersCurrentCount Returns the current number of 
consumers for th is session. 

 MessagesPendingCount Returns the number of messages 
pending (uncommitted and 
unacknowledged) for th is 
session.   

Rule: There are a large number 
of pending JMS Session 
messages i f th is counter value is 
> 50. 

 MessagesReceivedCount Returns the number of messages 
received on th is dest inat ion 
since the last reset. 

  MessagesSentCount Returns the number of bytes 
sent by th is session since the 
last reset. 

 

QALoad-WebLogic Performance 

This template monitors the performance of a WebLogic server. The WebLogic Performance template 
returns cri t ical in formation about the performance of your WebLogic instal lat ion.  
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The default  sampling in terval for th is template is 5 minutes. 

The WebLogic Performance template uses the fol lowing WebLogic extended counters: 

Category Coun ters Descript i on  

ConnectorServi ceRun t im e Connect ionPoolCurrentCount Returns the number of 
current ly deployed 
connect ion pools. 

ExecuteQueueRun t im e ExecuteThreadCurrentIdleCount Returns the number of idle 
threads assigned to the 
queue. 

 PendingRequestCurrentCount Returns the number of 
wait ing requests in  the 
queue. 

Rule: There are a large 
number of pending requests 
i f th is counter value is > 50. 

 ServicedRequestTotalCount Returns the number of 
requests that have been 
processed by th is queue. 

JM SRun t im e Connect ionsCurrentCount Returns the current number 
of connect ions to th is 
WebLogic Server.  

Rule: There are a large 
number of JMS connect ions 
i f th is counter value is > 20. 

 JTARun t im e ActiveTransact ionsTotalCount Returns the number of act ive 
transact ions on the server. 

 SecondsAct iveTotalCount  Returns the total number of 
seconds for al l  committed 
transact ions. 

 Transact ionRolledBackResourceTotalCount Returns the number of 
t ransact ions that were rol led 
back due to a resource error. 

 Transact ionTotalCount Returns the total number of 
t ransact ions processed. This 
total includes al l  committed, 
rol led back and heurist ic 
transact ion complet ions. 

JVM Runt im e  HeapFreeCurrent Returns the current amount 
of free memory (in  bytes) in  
the JVM heap. 

 Tim eServiceRun t im e ExceptionCount Returns the total number of 
except ions thrown while 
execut ing scheduled triggers. 
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Rule: There are a large 
number of except ions i f the 
in terval value of th is counter 
is > 20. 

 Execut ionsPerM inute Returns the average number 
of t riggers executed per 
minute.  

 

QALoad-WebLogic Server Security 

This template monitors the securi ty of a WebLogic server. The WebLogic Server Securi ty template returns 
cri t ical in formation about  the securi ty status of your WebLogic instal lat ion.  

The default  sampling in terval for th is template is 5 minutes. 

The WebLogic Server Securi ty template uses the fol lowing WebLogic extended counters: 

Category Coun ters Descript i on  

ServerSecuri tyRun t im e Inval idLoginAttemptsTotalCount Returns the cumulat ive number of 
inval id login attempts made on th is 
server.  

Rule: Mult iple inval id login 
attempts have occurred when the 
in terval value of th is counter is > 5.  

 LockedUsersCurrentCount Returns the number of current ly 
locked users on th is server.  

Rule: There are mult iple locked 
users i f th is counter value is > 5. 

 LoginAttemptsWhileLockedTotalCount Returns the cumulat ive number of 
inval id login attempts made on th is 
server whi le the user was locked. 

 UnlockedUsersTotalCount Returns the number t imes users 
have been unlocked on th is server. 

 

QALoad-WebLogic Servlet Performance 

This template monitors the performance of your WebLogic servlet.  The WebLogic Servlet Performance 
template returns cri t ical in formation about the servlet performance of your WebLogic instal lat ion. 

The default  sampling in terval for th is template is 5 minutes. 

The WebLogic Servlet Performance template uses the fol lowing WebLogic extended counters: 

Category Coun ters Descript i on  

ServletRun t im e Execut ionTimeAverage Returns the average t ime al l  invocat ions of the 
servlet that has executed since the task was 
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created.  

Rule: The servlet is averaging h igh execut ion 
t imes i f th is counter value average is > 10. 

 Execut ionTimeHigh Returns the amount of t ime the single longest 
invocat ion of the servlet that has executed 
since the task was created. 

 Execut ionTimeTotal Returns the total amount of t ime al l  
invocat ions of the servlet that has executed 
since the task was created. 

 In ternalServlet whether th is is an Internal Servlet or not 

 Invocat ionTotalCount Returns the total number of t imes the servlet 
has been invoked. Gets the 
invocat ionTotalCount attribute of the 
ServletRuntimeMBean object. 

  ReloadTotalCount Returns the total number of t imes the servlet is 
reloaded. Gets the reloadTotalCount attribute 
of the ServletRuntimeMBean object. 

 

WebSphere Templates 

WebSphere Templates 

QALoad provides the fol lowing pre-defined WebSphere templates: 

QALoad-WebSphere 5.0 JDBC Performance 

QALoad WebSphere 5.0 Performance 

QALoad-WebSphere 5.0 Web Applicat ion Performance 

QALoad-WebSphere 5.0 JDBC Performance 

This template monitors the performance of a WebSphere JDBC server. The WebSphere JDBC Performance 
template returns cri t ical in formation about the JDBC performance of your WebSphere instal lat ion.  

The default  sampling in terval for th is template is 5 minutes. 

The WebSphere JDBC Performance template uses the fol lowing WebSphere extended counters: 

Category Coun ters Descript i on  

JDBC 
Connect io
n  Pool  
M odule 

connect ionPoolModule.avgWait
Time 

Average wait ing t ime in mil l iseconds unt i l  a 
connect ion is granted. 

  connect ionPoolModule.concur
rentWaiters 

WebSphere extended counter for monitoring 
connect ionPoolModule.concurrentWaiters 

 connect ionPoolModule.faults Average wait ing t ime in mil l iseconds unt i l  a 
connect ion is granted. 
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 connect ionPoolModule.percent
Maxed 

Average percent of the t ime that al l  connect ions are 
in  use.  

Rule: IF   'WebSphere 
connect ionPoolModule.connect ionPoolM odule.perc
entMaxed(Node: "**", Server: "**", Data Source: "al l")' 
> 25. 

 connect ionPoolModule.percent
Used 

Average percent of the pool that is in  use. 

 

QALoad-WebSphere 5.0 Web Application Performance 

This template monitors the performance of a WebSphere 5.0 Web Applicat ion server. The WebSphere 5.0 
Web Applicat ion Performance template returns cri t ical in formation about the Web Applicat ion 
performance of your WebSphere instal lat ion.  

The default  sampling in terval for th is template is 5 minutes. 

The WebSphere 5.0 Web Applicat ion Performance template uses the fol lowing WebSphere extended 
counters: 

Category Coun ters Descript i on  

WebSphere 
servletSessionsM odule 

servletSessionsModule.act ivateNonExistSessions Number of requests for a 
session that no longer exists, 
presumably because the 
session t imed out. This 
counter may indicate a h igh 
number of t imeout 
condit ions. 

 servletSessionsModule.act iveSessions The number of concurren t ly 
act ive sessions. A session is 
act ive i f WebSphere is 
current ly processing a 
request, which uses that 
session. This counter may 
indicate h igh act ivi ty.  

 servletSessionsModule.cacheDiscards Number of session objects 
that have been forced out of 
the cache. This counter may 
indicate a need for more 
memory in  the cache.  

 servletSessionsModule.inval idatedSessions Number of sessions 
inval idated. This counter 
may indicate a h igh number 
of inval idated sessions. 

 servletSessionsModule.inval idatedViaTimeout Number of requests for a 
session that no 
CountStat ist ic exists, 
presumably because the 
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session t imed out. This 
counter may indicate a h igh 
number of t imeout 
condit ions. 

WebSphere 
w ebAppM odule 

webAppModule.servlets.concurrentRequests Number of requests that are 
concurrent ly processed. This 
counter may indicate h igh 
act ivi ty for an appl icat ion . 

 webAppModule.servlets.numErrors Total number of errors in  a 
servlet or Java Server Page 
(JSP). This counter may 
indicate a h igh number of 
error incidents. 

 webAppModule.servlets.responseTime Response t ime, in  
mil l iseconds, of a servlet 
request. This counter may 
indicate a slow response 
t ime of a request. 

 

QALoad WebSphere 5.0 Performance 

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

WebSphere 
jvm Run t im eM odul
e 

jvmRuntimeModule.freeMemory WebSphere extended counter for 
monitoring 
jvmRuntimeModule.freeMemory 

 jvmRuntimeModule.usedMemory WebSphere extended counter for 
monitoring 
jvmRuntimeModule.usedMemory 

WebSphere 
orbPerfM odule 

orbPerfModule.concurren tRequests WebSphere extended counter for 
monitoring 
orbPerfModule.concurren tRequests 

 orbPerfModule.in terceptors.processingTime WebSphere extended counter for 
monitoring 
orbPerfModule.in terceptors.processingTime

 orbPerfModule.referenceLookupTime WebSphere extended counter for 
monitoring 
orbPerfModule.referenceLookupTime 

WebSphere 
system M odule 

systemModule.avgCpuUti l izat ion WebSphere extended counter for 
monitoring 
systemModule.avgCpuUti l izat ion 

 systemModule.freeMemory WebSphere extended counter for 
monitoring systemModule.freeMemory 
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WebSphere 
th readPoolM odule 

hreadPoolModule.act iveThreads WebSphere extended counter for 
monitoring 
threadPoolM odule.act iveThreads 

 

WebSphere MQ Templates 

WebSphere MQ Templates 

QALoad provides the fol lowing pre-defined WebSphere MQ templates: 

QALoad-WebSphere MQ Avai labi l i ty 

QALoad-WebSphere MQ Performance 

QALoad-WebSphere MQ Availability 

This template monitors the avai labi l i ty of a WebSphere MQ server. The WebSphere MQ Avai labi l i ty 
template returns cri t ical in formation about the avai labi l i ty of your WebSphere MQ instal lat ion.  

The default  sampling in terval for th is template is 5 minutes. 

The WebSphere MQ Avai labi l i ty template uses the fol lowing WebSphere MQ extended counters: 

Coun ters Descript i on  

Channel Events Return the number of channel events for the curren t 
in terval. 

Queue Manager Events Reports the number of queue manager events for the 
current in terval. 

Queue Manager 
Up/Down 

Monitors the running state of a queue manager. 

 

QALoad-WebSphere MQ Performance 

This template monitors the performance of a WebSphere MQ server. The WebSphere MQ Performance 
template returns cri t ical in formation about the performance of your WebSphere MQ instal lat ion.  

The default  sampling in terval for th is template is 5 minutes. 

The WebSphere MQ Performance template uses the fol lowing WebSphere MQ extended counters: 

Coun ters Descript i on  

Performance Events This counter reports the number of 
performance events for the current 
in terval. 

 

WMI Templates 

QALoad provides the fol lowing pre-defined WMI templates: 

QALoad-Act ive Monitoring Avai labi l i ty  
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QALoad-Citrix IMA Networking  

QALoad-Citrix Metaframe All   

QALoad-Citrix MetaFrame IMA  

QALoad-Citrix MetaFrame Zone  

QALoad-Cold Fusion  

QALoad-Generic Appl icat ion Avai labi l i ty and Performance  

QALoad-MS IIS Avai labi l i ty  

QALoad-MS IIS Performance  

QALoad-Active Monitoring Availability  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

M em ory Available M Bytes  

Processor % Processor Time  

System  System Up Time  

 

QALoad-Citrix IMA Networking  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

Ci t r i x  IM A Netw ork ing Bytes Received/sec  

 Bytes Sent/sec  

 Network Connect ions  

 Netw ork  In terface Bytes Total/sec  

 

QALoad-Citrix Metaframe All  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

Ci t r i x  M etaFram e XP Applicat ion Enumerat ions/sec  

 Applicat ion Resolut ion Time 
(ms) 

 

 Applicat ion Resolut ions/sec  
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 Data Store Connect ion Fai lure  

 DataStore bytes read/sec  

 DataStore bytes writ ten/sec  

 DataStore reads/sec  

 DataStore writes/sec  

 Dynamic Store bytes read/sec  

 DynamicStore bytes 
writ ten/sec 

 

 DynamicStore reads/sec  

 DynamicStore writes/sec  

 Fil tered Appl icat ion 
Enumerat ions/sec 

 

 LocalHostCache bytes 
read/sec 

 

 LocalHostCache bytes 
writ ten/sec 

 

 LocalHostCache reads/sec  

 LocalHostCache writes/sec  

 Zone Elect ions  

 Zone Elect ions Won  

M em ory Page Reads/sec  

PhysicalDisk  % Disk Time  

Processor % Processor Time  

 

QALoad-Citrix MetaFrame IMA  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

Ci t r i x  M etaFram e 
XP 

Applicat ion Enumerat ions/sec  
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 Applicat ion Resolut ion Time (ms)  

  Appl icat ion Resolut ions/sec  

 Data Store Connect ion Fai lure  

 DataStore bytes read/sec  

 DataStore bytes writ ten/sec  

 DataStore reads/sec  

 DataStore writes/sec  

 Fil tered Appl icat ion 
Enumerat ions/sec 

 

 LocalHostCache bytes read/sec  

 LocalHostCache bytes wri t ten/sec  

 LocalHostCache reads/sec  

 LocalHostCache writes/sec  

Term inal  Servi ces Active Sessions  

 Total Sessions  

 

QALoad-Citrix MetaFrame Zone  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

Ci t r i x  M etaFram e 
XP 

Dynamic Store bytes read/sec  

 DynamicStore bytes 
writ ten/sec 

 

 DynamicStore reads/sec  

 DynamicStore writes/sec  

 LocalHostCache bytes read/sec  

 LocalHostCache bytes 
writ ten/sec 
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 LocalHostCache reads/sec  

  Zone Elect ions  

  Zone Elect ions Won  

Netw ork  In terface  Bytes Total/sec  

 Current Bandwidth  

Term inal  Servi ces Active Sessions  

 Total Sessions  

 

 

QALoad-Cold Fusion 

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

ColdFusion  M X 
Server 

 Avg DB Time (msec)  

 Avg Queue Time (msec)  

 Avg Req Time (msec)  

 Bytes In /  Sec  

 Bytes Out /  Sec  

 DB Hits /  Sec  

 Page Hits /  Sec  

 Queued Requests  

 Running Requests  

 Timed Out Requests  

M em ory % Committed Bytes In Use  

 Available Bytes  

 Page Faults/sec  

Process % Processor Time  
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QALoad-Generic Application Availability and Performance  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

Process % Processor Time  

System  System Up Time  

 

QALoad-MS IIS Availability  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

System  System Up Time  

Web Servi ce Current Anonymous 
Users 

 

 Current Connect ions  

 Logon Attempts/sec  

 NonAnonymous 
Users/sec 

 

 Not Found Errors/sec  

 Total Delete Requests  

 Total Fi les Sent  

 Total Get Requests  

 Total NonAnonymous 
Users 

 

 Total Not Found Errors  

 

QALoad-MS IIS Performance  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

In ternet  
In form at ion  

Current Blocked Async I/O 
Requests 
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Services Global  

 Total Blocked Async I/O 
Requests 

 

 Total Rejected Async I/O 
Requests 

 

 URI Cache Flushes  

 URI Cache Hits  

 URI Cache Hits %  

 URI Cache M isses  

PhysicalDisk  % Disk Time  

Process % Processor Time  

Redi rector  Current Commands  

 Network Errors/sec  

Server Work Item Shortages  

Server Work  
Queues 

Queue Length  

 Web Servi ce Not Found Errors/sec  

 

Windows Registry Templates 

Windows Registry Templates  

QALoad provides the fol lowing pre-defined Windows Registry templates: 

QALoad-Act ive Monitoring Avai labi l i ty 

QALoad-Citrix IMA Networking  

QALoad-Citrix Metaframe al l   

QALoad-Citrix Metaframe IMA  

QALoad-Citrix Metaframe Zone  

QALoad-Cold Fusion 

QALoad-Generic Appl icat ion Avai labi l i ty and Performance  

QALoad-MS IIS Avai labi l i ty  

QALoad-MS IIS Performance  

QALoad-Server Health  

QALoad-Windows Avai labi l i ty  
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QALoad-Windows Performance  

QALoad-Active Monitoring Availability 

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

M em ory Available M Bytes This counter monitors the Act ive 
Monitoring cl ient si te and not i fies 
you when i t  is low on resources, 
where Processor t ime is > 95% for 
more than 3 in tervals. The parameter 
for th is counter is Instance.  The 
default  is   _Total. 

Processor % Processor Time Raise an event when Act ive 
Monitoring cl ient si te is low on 
memory resources, where Avai lable 
Memory is at or below 1M B for more 
than 3 in tervals. 

System  System Up Time This counter tests the network 
connect ion between two machines 
and monitors the communicat ion 
status of the machine that receives 
communicat ion. 

 

QALoad-Citrix IMA Networking  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

Ci t r i x  IM A 
Netw ork ing 

Bytes 
Received/sec(“ _Total” ) 

This counter monitors the 
total bytes received per 
second. 

 Bytes 
Sent/sec(“ _Total” ) 

This counter monitors  the 
total bytes sent per second. 

 Network Connect ions This counter monitors the 
network connect ions. 

 Netw ork  In terface Bytes Total/sec This counter monitors the 
network connect ion total 
bytes/sec. 

 

QALoad-Citrix Metaframe all  

This template includes the fol lowing counters and categories: 
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Category Coun ters Descript i on  

Ci t r i x  M etaFram e XP Applicat ion Enumerat ions/sec This counter monitors 
appl icat ion enumerat ions /  
sec. 

 Appl icat ion Resolut ion Time 
(ms) 

This counter monitors 
appl icat ion resolut ion 
t ime. 

 Applicat ion Resolut ions/sec This counter monitors 
appl icat ion resolut ions. 

 Data Store Connect ion Fai lure This counter monitors 
datastore connect ion fai lure. 

 DataStore bytes read/sec This counter monitors 
datastore bytes reads per 
second. 

 DataStore bytes writ ten/sec This counter monitors 
datastore bytes  wri t ten per 
second. 

 DataStore reads/sec This counter monitors 
datastore reads per second. 

 DataStore writes/sec This counter monitors 
datastore writes per second. 

 Dynamic Store bytes read/sec This counter monitors 
DynamicStore bytes read per 
second. 

 DynamicStore bytes 
writ ten/sec 

This counter monitors 
DynamicStore bytes writ ten 
per second. 

 DynamicStore reads/sec This counter monitors 
DynamicStore reads per 
second. 

 DynamicStore writes/sec This counter monitors 
DynamicStore writes per 
second. 

 Fil tered Appl icat ion 
Enumerat ions/sec 

This counter monitors 
Fi l tered Appl icat ion 
Enumerat ions per second. 

 LocalHostCache bytes read/sec This counter monitors 
 LoadHostCache bytes read 
per second. 

 LocalHostCache bytes 
writ ten/sec 

This counter monitors 
 LoadHostCache bytes 
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writ ten per second. 

 LocalHostCache reads/sec This counter monitors 
 LoadHostCache reads per 
second. 

 LocalHostCache writes/sec This counter monitors 
 LoadHostCache writes per 
second. 

 Zone Elect ions This counter monitors zone 
elect ions. 

 Zone Elect ions Won This counter monitors zone 
elect ions won. 

M em ory Page Reads/sec This counter monitors page 
reads per second. 

PhysicalDisk  % Disk Time This counter monitors % 
disk t ime. 

Processor % Processor Time This counter monitors % 
processor t ime. 

 

QALoad-Citrix Metaframe IMA  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

Ci t r i x  M etaFram e 
XP 

Applicat ion Enumerat ions/sec This counter monitors the 
appl icat ion enumerat ion per 
second. 

 Applicat ion Resolut ion Time (ms) This counter monitors the 
appl icat ion resolut ion t ime. 

  Appl icat ion Resolut ions/sec This counter monitors the 
appl icat ion resolut ion. 

 Data Store Connect ion Fai lure This counter monitors the 
datastore connect ion fai lure. 

 DataStore bytes read/sec This counter monitors the 
datastore bytes read per second. 

 DataStore bytes writ ten/sec This counter monitors the 
datastore bytes writ ten per second. 

 DataStore reads/sec This counter monitors the 
datastore reads per second. 

 DataStore writes/sec This counter monitors the 
datastore writes per second. 
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 Fil tered Appl icat ion 
Enumerat ions/sec 

This counter monitors fi l tered 
appl icat ion enumerat ions per 
second. 

 LocalHostCache bytes read/sec This counter monitors 
LoadHostCache bytes read per 
second. 

 LocalHostCache bytes wri t ten/sec This counter monitors 
LoadHostCache bytes writ ten per 
second. 

 LocalHostCache reads/sec This counter monitors 
LoadHostCache reads per second. 

 LocalHostCache writes/sec This counter monitors 
LoadHostCache writes per second. 

Term inal  Servi ces Active Sessions This counter monitors act ive 
sessions. 

 Total Sessions This counter monitors total 
sessions. 

 

QALoad-Citrix Metaframe Zone  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

Ci t r i x  M etaFram e 
XP 

Dynamic Store bytes read/sec This counter monitors the dynamic 
store bytes read /  sec. 

 DynamicStore bytes 
writ ten/sec 

This counter monitors the dynamic 
store bytes writ ten /  sec. 

 DynamicStore reads/sec This counter monitors the dynamic 
store reads /  sec. 

 DynamicStore writes/sec This counter monitors the dynamic 
store writes /  sec. 

 LocalHostCache bytes read/sec This counter monitors the 
LocalHostCache bytes read /  sec. 

 LocalHostCache bytes 
writ ten/sec 

This counter monitors the 
LocalHostCache bytes wri t ten /  sec. 

 LocalHostCache reads/sec This counter monitors the 
LocalHostCache reads /  sec. 

  Zone Elect ions This counter monitors the zone 
elect ions. 
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  Zone Elect ions Won This counter monitors the zone 
elect ions won. 

Netw ork  In terface  Bytes Total/sec This counter monitors network 
connect ion total bytes. 

 Current Bandwidth This counter monitors network 
connect ion current bandwidth. 

Term inal  Servi ces Active Sessions This counter monitors act ive sessions.

 Total Sessions This counter monitors total sessions. 

 

QALoad-Cold Fusion 

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

ColdFusion  M X 
Server 

 Avg DB Time (msec)  

 Avg Queue Time (msec)  

 Avg Req Time (msec)  

 Bytes In /  Sec  

 Bytes Out /  Sec  

 DB Hits /  Sec  

 Page Hits /  Sec  

 Queued Requests  

 Running Requests  

 Timed Out Requests  

M em ory % Committed Bytes In 
Use 

 

 Available Bytes  

 Page Faults/sec  

Process % Processor Time  

 

QALoad-Generic Application Availability and Performance  
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This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

Process % Processor Time This counter returns the 
percentage of elapsed t ime 
that al l  threads of a process 
use the processor to execute 
instruct ions. This process 
could include code executed to 
handle certain hardware 
in terrupts or trap condit ions. 

System  System Up Time This counter monitors cri t ical 
tasks by veri fying the existence 
of processes. You can monitor 
single or mult iple tasks 
running on the system by 
select ing the Processes tab 
from the task manager and 
then select ing processes that 
you want to monitor. You can 
also monitor only certain 
instances of a task by 
specifying a Process ID to 
monitor. If you do not specify 
a Process ID, th is counter 
monitors al l  instances of the 
task. 

QALoad-MS IIS Availability  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

System  System Up Time  

Web Servi ce Current Anonymous 
Users 

 

 Current Connect ions  

 Logon Attempts/sec  

 NonAnonymous Users/sec  

 Not Found Errors/sec  

 Total Delete Requests  

 Total Fi les Sent  

 Total Get Requests  
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 Total NonAnonymous 
Users 

 

 Total Not Found Errors  

 

QALoad-MS IIS Performance  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

In ternet  
In form at ion  
Servi ces Global  

Current Blocked Async 
I/O Requests 

 

 Total Blocked Async I/O 
Requests 

 

 Total Rejected Async 
I/O Requests 

 

 URI Cache Flushes  

 URI Cache Hits  

 URI Cache Hits %  

 URI Cache M isses  

PhysicalDisk  % Disk Time  

Process % Processor Time  

Redi rector  Current Commands  

 Network Errors/sec  

Server Work Item Shortages  

Server Work  Queues Queue Length  

 Web Servi ce Not Found Errors/sec  

 

QALoad-Server Health  

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

M em ory % Committed Bytes In  
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Use 

 Pages/sec  

PhysicalDisk  % Disk Time  

 Avg. Disk Queue Length  

Processor  % Processor Time  

System  Processor Queue Length  

 

QALoad-Windows Availability  

This template monitors the avai labi l i ty of the Windows operat ing system, focusing on: 

Logons 

Securi ty 

Up t ime 

The default  sampling in terval for th is template is 5 minutes. 

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

Server Errors Access Permissions 

 Errors Granted Access  

Errors Logon 

Errors System 

Logon Total 

The M icrosoft  Windows 
Avai labi l i ty template uses these 
Server registry counters to 
monitor errors due to logon 
problems. 

To enable these counters, you 
must configure your Windows 
system to audit  logon and 
logoff events. You can do th is 
by configuring the Audit  Pol icy 
in  the User Manager for 
Domains program. 

 Server Sessions 

Sessions Errored Out 

Sessions Forced Off 

Sessions Logged Off 

Sessions Timed Out 

The M icrosoft  Windows 
Avai labi l i ty template uses these 
Server registry counters to 
monitor how well  users’ 
sessions are running. 

If there is a large number of 
session errors, i t  is usual ly due 
to systems reboot ing often or 
network errors. 

System  System Up Time This counter returns the 
number of seconds that a 
system was avai lable for use. If 
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th is number cont inues to reset 
to zero, i t  means that the 
system is reboot ing often. For a 
report  that l ists the number of 
t imes that the system has 
rebooted over a period of t ime, 
see the M icrosoft  Windows 
Avai labi l i ty Report topic. 

 

QALoad-Windows Performance  

This template monitors the performance of the M icrosoft  Windows system, focusing on: 

CPU 

Disk I/O 

Disk space 

Memory 

Network 

The default  sampling in terval for th is template is 5 minutes. 

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

LogicalDisk  % Disk Time This counter monitors the 
percentage of elapsed t ime that 
the disk services read and write 
requests, including the t ime 
that the disk driver waits in  the 
disk queue. If th is value is 
consistent ly near 100%, the disk 
is in  very heavy use. You can 
determine which processes are 
making the majori ty of the disk 
requests by monitoring them 
individual ly. 

 % Free Space This counter monitors low free-
space situat ions. 

  Avg. Disk Queue Length This counter indicates the 
number of pending I/O service 
requests. If the returned value is 
greater than 2, there is a disk 
problem. On a mult i-disk 
subsystem, such as a striped set 
or striped with pari ty, you can 
perform a calculat ion to 
determine the presence of a disk 
problem. The basic formula is 
(Disk Queue Length) - (Number 
of Physical Disk Drives in  the 
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mult i-disk configurat ion). 

For example, i f you have a 
striped set with 3 disk drives 
and a queue length of 5, then 
you get an acceptable value of 2 
(5 - 3 = 2). 

 M em ory Available Bytes If the value returned by th is 
counter fal ls under 10 MB, 
virtual memory is running low. 
To resolve th is, close some 
appl icat ions or increase the 
memory sett ings. If th is counter 
is consistent ly low after an 
appl icat ion is running, i t  
usual ly indicates a system 
memory leak. 

As the value returned by th is 
counter decreases, the value 
returned by the Committed 
Bytes counter increases. This 
indicates that a process is 
al locat ing memory from the 
virtual address space but might 
not be using i t . Because the 
virtual address space is a l im ited 
resource, use these counters to 
check for appl icat ions that 
al locate memory but do not use 
i t . To resolve th is, add more 
physical memory. When an 
appl icat ion fin ishes processing, 
note the last value. If th is 
counter does not return to the 
original value, the appl icat ion 
has a memory leak or a h idden 
process that has not properly 
terminated. 

The acceptable range for 
committed bytes should be less 
than the physical RAM. The 
default  value is 64 MB. 

 Cache Faults/sec If the value returned by th is 
counter is less than the value 
returned by the Page faults/sec 
counter, the system is paging 
too much for a normal system. 
To resolve th is, add more 
physical memory. 

 Committed Bytes This counter returns the 
amount of virtual memory (in  
bytes) that was committed, as 
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opposed to memory that has 
was reserved. 

 Page Faults/sec If the value returned by th is 
counter is greater than 5, the 
system is paging too much. Add 
more physical memory. A 
consistent value of 10 or later 
needs immediate attent ion. 

 Page Reads/sec  

 Pages/sec If th is counter returns a h igh 
peak value, the system is 
experiencing a lot  of paging 
act ivi ty. A h igh value also 
indicates that your system does 
not contain enough physical 
memory to handle the demands 
placed on i t  by the appl icat ion. 
To resolve th is, add more 
physical memory. To calculate 
the % disk t ime used for paging, 
use the fol lowing calculat ion: 

(% Disk Time used for paging) = 
(Memory, Pages/sec) * (Average 
Disk Transfer/sec) * 100 

 Transit ion Faults/sec  

Paging Fi l e  % Usage Peak This counter returns the 
maximum use of your page fi le. 
If the value the counter returns 
consistent ly reaches 90%, the 
virtual address space is too 
small . You should increase the 
size of your paging fi le. When 
the value returned by the 
counter exceeds 75%, a 
significant system performance 
degradat ion becomes 
not iceable. 

PhysicalDisk  % Disk Time  

 Avg. Disk Queue Length  

 Avg. Disk sec/Transfer  

 Disk Reads/sec  

 Disk Writes/sec  

Processor % Interrupt Time This counter monitors the 
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percentage of t ime that the 
processor spent receiving and 
servicing hardware in terrupts 
during the sample in terval. 

 % Processor Time On single processor systems, i f 
the value returned by th is 
counter is consistent ly h igher 
than 90%, the CPU probably 
has a bott leneck. You should 
examine each process in  the 
system to determine which one 
is using more of the processor 
than i t  should. The process with 
the h ighest peak is general ly the 
performance bott leneck. 

 % User Time This counter monitors non-idle 
processor t ime spent in  User 
mode as a percentage of the 
sample in terval. 

Redi rector Network Errors/sec This counter indicates how 
many serious network errors 
have occurred. These errors are 
general ly logged in the system 
event log, so you can check 
there for more in formation. If 
an error occurs, take immediate 
act ion to resolve the problem. 

Server Bytes Received/sec  

 Bytes Total/sec  

 Bytes Transmitted/sec  

 Errors Logon This counter determines i f an 
unauthorized user is trying to 
access your system. 

  Work Item Shortages This counter monitors the 
number of t imes that a work 
i tem was not al located. You 
might need to increase the 
In itWorkItems and 
MaxWorkItems parameters for 
the LanMan Server i f th is 
number cont inues to increase. 

System  Context Switches/sec If the value returned by th is 
counter value is h igh, assign a 
h igher priori ty to the use of 
cri t ical sect ions or semaphores 
by the program. This achieves a 
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higher throughput and reduces 
task switch ing. 

 Processor Queue Length  

 

M an aging Coun ters 

Adding Counters to a Task Using New Discovery Data 

You can add counters to a monitoring task by generat ing the counter data avai lable for the task and 
select ing the counters and instances to add to the task. 

To count ers and inst ances t o a m oni t or ing t ask : 

1. Click Tools>Monitoring>Add counter>Use new discovery data. The Edit Monitoring Machine Wizard appears. 

2. Follow the instructions for using the wizard to discover and add counters to your monitoring task. 

 

Adding Counters to a Task Using Cached Discovery Data 

You can add counters to a monitoring task using cached discovery data. 

Select  t he count er  t o add or  m odi f y: 

1. Select Monitoring>Add counter>Use cached discovery data. This Add/Edit Counters dialog box appears. 

2. From the Available Items pane, select the Template tab or the Counter tab. 

3. Select a template or a counter to monitor in the task for this machine and monitor type, and click Add. The items you 
select display in the Selected Items pane. Click Add All to add all the items on the selected tab to the Selected 
Items pane.  

4. To remove an item, select the item in the Selected Items pane and click Remove. The items is returned to the 
Available Items pane.  

Note: When you select a template, and some of the counters it contains are not present on the machine 
you are defining, you receive a message with a list of the counters that will not be added to the task.. 

5. Repeat this process until you select all the templates and counters you want to monitor in this task.  

6. Click Next. The Choose Instances dialog box displays. 

Choose t he inst ances of  t he count er  t o m oni t or : 

When you cl ick Next in  the previous dialog box, the Choose Instan ces dialog box appears. 

1. Review the counters you selected. When a red dot appears next to a counter, you must select an instance of the 
counter.  

2. Double-click the counter group to display the counters. 

3. Select a counter and click Edit. The Select instance for counter dialog box appears. 

4. In the Available Instance pane, select an instance and click Add. 

5. Repeat until you select all instances of the counter that you want to apply to the task. 

6. Click Save. You return to the Choose Instances dialog box.  

7. Repeat this process for each designated counter.  
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8. Click Next. The Summary dialog box displays. 

Save t he t ask : 

When you cl ick Next in  the previous dialog box, the Sum m ary  dialog box appears. 

1. On the Summary dialog box, review the monitors and counters you have selected for the template. Click Back to 
return to a dialog box and make changes to the information. 

2. Click Finish to add the counters. 

 

Removing a M onitor or a Counter from a Monitoring Task  

Remove a monitor or a counter from a monitoring task, by fol lowing th is procedure. 

To rem ove a count er  f r om  a m oni t or ing  t ask : 

1. On the Monitoring Options tab, select the monitor, counter, or counter family to delete. 

2. Click Tools>Monitoring>>Remove monitor/Remove counter.  

3. When the verification dialog box displays, click OK. 

Note: You cannot remove the last monitor on a machine, the last counter in the family, or the last family of 
counters in the task. 

 

M an aging M on i toring Tem plates 

Creat ing a New Template 

To access t he New  Moni t or ing Tem plat e w izard : 

Click Tools>M on i toring>M an age m on i toring tem plates>New  m on i toring tem plate. The New 
Monitoring Template wizard appears. Cl ick Next  to start  the procedure. 

Use the fol lowing steps in  the New  M on i toring Tem plate wizard to create a new monitoring template: 

1. Enter the template properties 

2. Configure the monitor 

3. Counter discovery 

4. Choose the counters 

5. Choose the instances 

6. Review, save, and create the template 

 

Using an Existing Template  

Use the fol lowing steps to apply a previously created or pre-defined template. 

To apply an exist ing  t em plat e: 

1. Select Tools>Monitoring>Manage Monitoring Templates>Use existing template. The Select a Monitor Template 
File dialog box displays. 
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2. Double-click a template type, then select a template and click Open. The template is applied to the monitoring task. 

Edit ing Instances for Templates  

To edi t  inst ances in  a t em plat e: 

1. On the Monitoring Options tab, select the template to edit. 

2. Click Tools>Monitoring>Manage monitoring templates>Edit instances. The Edit Template Instances Wizard 
appears. 

To choose t he inst ances of  t he count er  t o m oni t or : 

Review the counters you selected. When a red dot appears next to a counter, you must select an instance 
for the counter.  

1. Double-click the counter group to display the counters. 

2. Select an instance for a counter and click Edit. The Select instance for counter dialog box appears. 

3. To add an instance: In the Available Instance pane, select an instance and click Add. 

4. To remove an instance: In the Selected instances pane, select an instance and click Remove. 

5. Repeat until you select all instances of the counter that you want to apply to the task. 

6. Click Save. You return to the Choose Instances dialog box.  

7. Repeat this process for each designated counter.  

8. Click Next. The Summary dialog box displays. 

To save t he t em plat e: 

1. On the Summary dialog box, review the monitors and counters you have selected for the template. Click Back to 
return to a dialog box and make changes to the information. 

2. Click Back to return to the previous step and edit the instances. 

3. Click Finish to create the template. 

 

Modifying Template Counters for Custom Templates 

When you need to add or edit  counters in  a template that you created, you can use the cached counter 
discovery data to modify the template. 

Note: You cannot modify the counters in pre-defined templates. 

Select  t he count er  t o add or  m odi f y: 

1. Select Monitoring>Manage monitoring templates>Add/Edit counter>Use cached discovery data. The Edit 
Template Counters wizard appears with the Add/Edit/Remove Template Counters dialog box displayed. 

2. From the Available Items pane, select the Template tab or the Counter tab. 

3. Select a template or a counter to monitor for this machine and monitor type, and click Add. The items you select 
display in the Selected Items pane. Click Add All to add all the items on the selected tab to the Selected Items 
pane.  

4. To remove an item, select the item in the Selected Items pane and click Remove. The items is returned to the 
Available Items pane.  
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Note: When you select a template, and some of the counters it contains are not present on the machine 
you are defining, you receive a message with a list of the counters that will not be added. 

5. Repeat this process until you select all the templates and counters you want to monitor.  

6. Click Next. The Choose Instances dialog box displays. 

Choose t he inst ances of  t he count er  t o m oni t or : 

1. Review the counters you selected. When a red dot appears next to a counter, you must select an instance of the 
counter.  

2. Double-click the counter group to display the counters. 

3. Select a counter and click Edit. The Select instance for counter dialog box appears. 

4. In the Available Instance pane, select an instance and click Add. 

5. Repeat until you select all instances of the counter that you want to apply. 

6. Click Save. You return to the Choose Instances dialog box.  

7. Repeat this process for each designated counter.  

8. Click Next. The Summary dialog box displays. 

Save t he t em plat e: 

1. On the Summary dialog box, review the monitors and counters you have selected for the template. Click Back to 
return to a dialog box and make changes to the information. 

2. Click Finish to create the template. 

 

Removing a Counter from a Template  

Remove a counter from a template by fol lowing th is procedure. 

To rem ove a count er  f r om  a t em plat e: 

1. On the Monitoring Options tab, select the counter or counter family to delete. 

2. Click Tools>Monitoring>Manage monitoring templates>Remove counter.  

3. When the verification dialog box displays, click OK. 

Note: You cannot remove the last counter in a family. 

Creating and Editing Monitoring Tasks 

Creat ing a New  M on i tori ng Task   

To access t he New  Moni t or ing Task  w izard: 

Click Tools>M on i toring>New  m on i toring task . The New Monitoring Task Wizard appears. Cl ick Next  to 
start  the procedure. 

Use the fol lowing steps in  the New Monitoring Task Wizard to create a new monitoring task: 

1. Define the monitor 

2. Configure the monitor 

3. Discover the counters 
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4. Choose the counters for the monitoring task 

5. Choose the instances of the counter to monitor 

6. Review the monitor definition 

7. Save and create the monitoring task  

 

Using an  Ex ist i ng M on i toring Task   

To select  an exist ing m oni t or ing t ask : 

1. Click Tools>Monitoring>Use existing task. The Choose an Existing Task dialog box appears. 

2. Select a task and click OK. The task displays in Conductor's Monitoring Options tab. 

Adding a M on i toring M ach ine  

To access t he New  Moni t or ing Task  w izard: 

Click Tools>M on i toring>Add m on i tor . The Add Monitoring Machine wizard appears. Cl ick Next  to start  
the procedure. 

Use the fol lowing steps in  the Add M on i toring M ach ine wizard to add a monitoring machine to the task: 

1. Enter properties of the monitoring machine 

2. Configure the monitor 

3. Discover the counters 

4. Choose the counters for the monitoring task 

5. Choose the instances of the counter to monitor 

6. Review the monitor definition 

7. Save and create the monitoring task  

Note: See Setting Up Integration with ServerVantage for the procedure used for this monitor type. 

Edi t i ng a M on i toring M ach ine  

To access t he Edi t  Moni t or ing Machine w izard : 

Click Tools>M on i toring>Edi t  m on i tor . The Edit  Monitoring Machine wizard appears. Cl ick Next  to start  
the procedure. 

Use the fol lowing steps in  the Edi t  M on i toring M ach ine wizard to change the propert ies of a monitoring 
machine: 

1. Enter properties of the monitoring machine  

2. Configure Monitor Dialog 

3. Discover the Counters 

4. Choose Counters  

5. Choose Instances  

6. Review Monitor Definition 

7. Summary  
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Note: See Setting Up Integration with ServerVantage for the procedure used for this monitor type. 

 

Edi t i ng Instances  

Use the fol lowing procedure to edit  instances i f the counters you are monitoring. 

To access t he Edi t  Inst ances d ialog boxes: 

1. On the Monitoring Options tab, select the machine, the counter, or the instance to edit. 

2. Click Tools>Monitoring>Edit instances. The Edit Instances dialog boxes display. 

To edi t  t he inst ances of  a count er : 

1. In the Choose Instances dialog box, double-click the counter group in the left-hand pane to display the counters. 

2. Select a counter and click Edit. The Select instance for counter dialog box appears. 

Note: When a counter can not be edited, the Edit button is unavailable. 

3. Perform the necessary edits. You can do the following: 

 In the Available Instances pane, select an instance and click Add. The instance is added to the Selected 
Instances pane. Repeat until you select all instances of the counter that you want to apply to the task. 

 In the Selected Instances pane, select an instance and click Remove. The instance is removed from the 
Selected Instances pane and added to the Available Instances pane.  

4. Click Save. The Choose Instances dialog box displays again.  

5. Repeat this process for each counter you want to edit.  

6. Click Next. The Review Monitor Definition dialog box displays. 

Review  t he m oni t or  def in i t ion: 

1. Review the information for the monitoring machine you defined. 

2. Select one of the following: 

!  Set up another monitor for this task - returns to the Define Monitor dialog box so you can add another 
monitor to the monitoring task. 

!  Continue without adding any more monitors - continues in this dialog box. 

3. (Optional) Click Save as Template to create a template for this monitoring task.  

4. (Optional) Select a monitor in the Monitors pane and click Remove Monitor to delete a monitor from the task. 

5. (Optional) Type a new value in the Sample Interval field. This is the frequency, in seconds, at which QALoad 
requests data from ServerVantage during runtime data collection. 

6. Click Next. The Summary dialog box displays. 

Save t he t ask : 

1. Review the monitors and counters you have selected for the task. Click Back to return to a dialog box and make 
changes to the information. 

2. In the Monitoring task name field, type a name for the monitoring task.  

3. In the Description field, type a description for the task. 
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4. Select a monitor in the Monitors pane, and click View Monitor Details. The Properties of dialog box displays with 
detailed information about the monitor configuration and the counters you selected. 

5. Click Finish to create the monitoring task. 

 

Server Analysis Agent 

Server Analysis Agents 

Server Analysis agents use enhanced ServerVantage technology to provide server ut i l izat ion data without a 
complete ServerVantage deployment. Server Analysis agents, provided on the QACenter Performance 
Edit ion CD, are quickly and easi ly instal led on the servers that you wish to monitor during a load test . 
Server Analysis agents provide you with valuable server ut i l izat ion metrics — cal led counters — on Web 
servers, appl icat ion servers, and database servers being exercised by your load test to help you to pinpoint 
performance bott lenecks when load test ing. 

Unl ike a ful l  ServerVantage instal lat ion, you can start , stop, and configure Server Analysis Agents right 
from the famil iar in terface of the QALoad Conductor. 

Server ut i l izat ion data from the agents and response t ime information from QALoad is al l  automatical ly 
downloaded and correlated through the use of Act iveAnalysis, and is avai lable for post-test analysis 
through QALoad Analyze. 

Server Analysis agents are set up when you create a monitoring task. For detai ls about using Server Analysis 
agents in  a load test, see Creat ing a New M onitoring Task. 

 

Server Analysis Agent Templates 

QALoad-Window s Perform ance 

This template monitors the performance of the M icrosoft  Windows system, focusing on: 

!  CPU 

!  Disk I/O 

!  Disk space 

!  Memory 

!  Network 

The default  sampling in terval for th is template is 5 minutes. 

This template includes the fol lowing counters and categories: 

Category Coun ters Descript i on  

LogicalDisk  % Disk Time  

M em ory  Avai lable Bytes  

 Cache Faults/sec  

 Committed Bytes  

 Page Faults/sec  

Paging Fi l e  % Usage Peak  
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Processor  % Processor Time  

  % User Time  

 In terrupts/sec  

Server Bytes Total/sec  

 

ServerVantage 

Server Monitoring with ServerVantage 

If you are current ly a l icensed user of Compuware's ServerVantage, you can integrate data from your 
exist ing ServerVantage deployment direct ly in to a QALoad t im ing fi le.  

For th is method to be successful, the fol lowing condit ions must be met: 

!  ServerVantage must be installed and configured correctly on your system. For more information about installing or 
configuring ServerVantage refer to its product documentation. 

!  ServerVantage must be scheduled to monitor the specified performance counters at a time that coincides with a 
running QALoad test 

!  QALoad must be able to access the appropriate Agent stations to collect resource utilization data at the end of the 
load test. 

ServerVan tage 

ServerVantage (formerly EcoTOOLS) monitors the avai labi l i ty and performance of appl icat ions, databases 
and servers, al lowing users to central ly manage events across al l  appl icat ion components— Web servers, 
fi rewalls, appl icat ion servers, fi le systems, databases, middleware, and operat ing systems. ServerVantage 
simultaneously monitors these components, analyzes both h istorical and real-t ime events, and correlates 
monitored in formation for problem detect ion. 

This in tegrat ion uses standard Netbios ports. Netbios ports 137-139 and 145 should be kept open when 
performing th is type of act ivi ty. In tegrat ion with ServerVantage is configured from the QALoad Conductor. 
Performance counters col lected during a load test are included in the test 's t im ing fi le and can be sorted 
and displayed in QALoad Analyze in  much the same way as QALoad t im ing data. For more in formation  
about instal l ing or configuring ServerVantage refer to i ts product documentat ion.  

 

Setting up Integration with ServerVantage 

To set  up in t egrat ion w i t h ServerVant age: 

1. On the Conductor Test Information Screen, click the Monitoring Options tab. 

2. Click the Set up monitoring link, then select Set up a new monitoring task. 

3. In the Define Monitor dialog box, click the arrow in the Monitor Type box and select ServerVantage. 

4. In the Control Server Database Host field, type the hostname of the Database server machine. 

5. Click Next. The Configure Monitor dialog box displays. 

6. In the Username field, type a valid Windows admin login user name for the Database server machine. 

7. In the Password field, type the password that corresponds to the user name above, if necessary. 
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8. Select the Override Default Database check box to provide the ServerVantage database name. When this option is 
not selected, QALoad uses the default ServerVantage database name. If you provided a different name during the 
installation of ServerVantage, select this option and type the name in the Database Name field. 

9. In the Vantage Agent Configuration area, type the ServerVantage Agent name, and click Add to add it to your load 
test. 

10. Click Next to proceed to the next step. 

 

Applicat ionVantage 

Overview of ApplicationVantage 

QALoad integrates with Appl icat ionVantage to help you analyze network performance during a load test. 
Appl icat ionVantage provides granular thread detai ls that al low network managers to ident i fy poorly 
performing appl icat ions. QALoad also provides test data that you can open in Appl icat ionVantage. 

Before QALoad can col lect network data during a load test, the fol lowing must be true: 

!  The ApplicationVantage Agent is installed on the same machine as the QALoad Conductor. You can install either the 
ApplicationVantage Agent or the ApplicationVantage Remote Agent. 

!  You have specified on which NIC to capture from the Machine Assignment tab in Conductor. How? 

At test t ime when a transact ion is started, the Player configured to capture Appl icat ionVantage data starts 
an Appl icat ionVantage trace. The trace stops when the transact ion completes. When a Player is running a 
script  that is set to run in  Appl icat ionVantage mode, every transact ion generates a new trace fi le. At the 
end of the test, these fi les are packaged into the test 's t im ing fi le. 

Hint : For information about ApplicationVantage, refer to the documentation you received with your purchase 
of this tool. 

 

Configuring a test to use ApplicationVantage 

In tegrat ion with Appl icat ionVantage enables you to study network problems in detai l . You can set up one 
or more Appl icat ionVantage (AV) Player machines for the load test. These AV Player machines run a 
QALoad script  on a periodic basis whi le the AV Agent captures the network traffic that the script  produces. 
The result ing AV trace fi les (*.opx) are sent back to the Conductor with the regular QALoad t im ing fi le for 
analysis after the test is complete. 

To enable Appl icat ionVantage, you must be running Appl icat ionVantage 9.5 or greater. You must select 
the Appl icat ionVantage opt ion, and then set the Network Interface Card (NIC) ServiceName used by the 
machine on which the data is captured. 

Enabling ApplicationVantage  

You can enable or disable the Appl icat ionVantage for each load test on a script . To enable 
Appl icat ionVantage, you must select the opt ion, and then set the Network In terface Card (NIC) 
ServiceName. 

To enable Appl icat ionVant age: 

1. Click Conductor's Screen Assignment tab. 

2. Click in the Script column to enable the Browse (...) button. Then, click Browse. The Select Script dialog box 
displays. 

3. Click the ApplicationVantage Mode box at the bottom of the dialog box.. 

4. Click OK. 
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5. Set the NIC ServiceName. 

Setting up Network Interface Card ServiceName 

To use the Appl icat ionVantage Agent to col lect data for Appl icat ionVantage, i t  is necessary to specify 
which Network Interface Card (NIC) to capture on. This is the network in formation for the workstat ion 
where your Appl icat ionVantage Remote Agent is instal led.  

To set  up NIC ServiceNam e:  

1. With the session ID you want to use for your test open, click on the Conductor's Machine Assignment tab. 

2. Click the Manage Player Machines button for the Conductor to query your test network for installed Player Agents. 
You also can select Tools>Manage Player Machines. The Manage Player Machines and Groups dialog box 
displays with names of available Player machines. 

3. In the All Player Machines and Groups area, double-click the Player machine that will be running the virtual user to 
be captured. The Edit Player Machine dialog box displays. 

4. Click the Application Vantage Settings tab.  

5. From the drop-down list in the NIC ServiceName field, select the NIC that is used by the machine.  

6. Click Apply, then click OK. 

 

Troubleshoot ing 

Conductor pre-test  checks 

Before a test begins, the Conductor completes the fol lowing pre-test checks of the parameter fi les and 
Players. If any of these checks fai l , the Conductor displays an error message. 

!  Are there enough Players configured to support the number of users specified in the session ID file? 

!  Does the number of users specified in the session ID file exceed the maximum number of users defined by your 
authorization key? 

!  Can the specified compiled script files be accessed? 

!  Are all Players communicating with the Conductor? (The Conductor sends a request message to all the Players to 
verify that they are up and running.)  

 

Execut ing SSL scripts that  use client  cert ificates 

If you are execut ing SSL scripts that use cl ient cert i ficates, you must manually copy the cl ient cert i ficates in  
use to the Player machine(s) execut ing the script(s). 

Manually copy the cl ient cert i ficates from the \Program Files\Compuware\QALoad\Certificates 
directory to the same default  directory on the Player machine. 

Note: On the Unix player platform, you must create the Certificates sub-directory in the QALoad 
directory. The directory name is case sensitive. 

Heartbeat  message failure on a virtual user 

When a Player machine crashes or experiences a loss of communicat ion, the heartbeat message that the 
Conductor sends out (i f enabled) fai ls. This si tuat ion is indicated in  the runt ime Conductor through a 
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message on each virtual user that is affected. When the heartbeat message fai ls for a virtual user, the Status 
column of the Detai ls view of a script  displays the fol lowing message: "The Player running th is user fai led 
to respond to a heartbeat message." 

The opt ion for enabl ing a heartbeat message is located on the Player  tab of the Opt ions dialog box in  the 
Conductor. 

 

Timing file is too big 

Depending on the length of the load test and the amount of data that was col lected, t im ing fi les can grow 
to excessively large sizes that become difficult  to handle. To prevent t im ing fi les from becoming too large, 
try modifying the fol lowing sett ings: 

!  Disable automatic middleware checkpoint t im ings in  the Conductor 

!  Use the Conductor's t im ing data th inning opt ions 

Both of these sett ings are located on the Timing Options dialog box, which can be accessed from the Script 
Assignment tab of the Conductor. 

 

Tips for running QALoad tests on UNIX systems 

To successful ly run large QALoad tests on UNIX systems, you may need to make adjustments to your 
sett ings as described below: 

General (AIX, Solaris, and RedHat Linux) 

When you attempt to run  a large number of virtual users on UNIX platforms, the virtual users do not 
always synch. If virtual users do not synch, try increasing the Virtual User Startup Delay. By default , 
QALoad Conductor sets the VU Startup Delay to 1 mil l isecond. This default  is not h igh enough for UNIX 
platforms. If the UNIX Player receives a value less than 15 mil l iseconds, the delay wil l  be 15 mil l iseconds 
or more.  

To increase t he delay: 

1. In the QALoad Conductor, click Tools>Options. 

2. Click the Player tab. 

3. In the VU Startup Delay field, type the number of milliseconds to delay virtual user startup. 

  

Solaris 

The default  fi le descriptor l im it  on Solaris has a "soft" l im it  of 64, and a "hard" l im it  of 1024 (Solaris 2.6). 
Per the Solaris 2 FAQ (refer to http:/ /www.wins.uva.n l/pub/solaris/solaris2.html), the fi le descriptor l im it  is 
described in the getrl im it() manual page as: "One more than the maximum value that the system may 
assign to a newly created descriptor. This l im it  constrains the number of fi le descriptors that a process may 
create." 

To increase th is l im it , system administrators can modify the /etc/system fi le and reboot the system. For 
example: 

* set hard limit on file descriptors 

set rlim_fd_max - 4096 
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*set soft limit on file descriptors 

set rlim_fd_cur = 1024 
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